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Welcome

Thank you for purchasing the Canon BJC-55 Color Bubble Jet™ Printer.

This User’s Manual provides complete explanations of the features and functions of the
printer. To maximize the life of your printer, it's a good idea to familiarize yourself fully with
all of its functions.

This User’s Manual uses the following symbols to indicate important information. Always
observe the instructions indicated by these symbols.

A\ Caution Cautions alert you to ways to avoid injury to yourself, damage to the
printer, or the loss of valuable data.

Note b Notes provide advice, tips, and suggestions that are intended to help you
work more efficiently with the printer.

» This arrow and blue text indicate a link to where you can find more
information about the current subject.

This manual uses the following symbols depending on the computer system you are using.
Always observe the instructions indicated by these symbols.

Windows ) |ndicates information for Windows® 98, Windows CE, and Windows 2000
users only.

Macintosh )  Indicates information for Macintosh® users (OS 8.1 or later).
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How to Use This Manual

To view this User’s Manual, please use Acrobat Reader 4.0, which is included on your
CD-ROM.

gl Use this button when you wish to ] Use this button to display the
enlarge the screen you are viewing. 4 previous page of the User’s
Select this button in the tool bar, and Manual.
then click within the screen of the
User's Manual. b Use this button to display the

next page of the User’s
Manual.
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This column displays a table of contents for the User's Manual.

Click the desired item to jump to the topic.

Click the + (or ») symbol when you wish to see detailed headings for each chapter.
Click the — (or ¥) symbol when you wish to return to the original (condensed) display.
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Copyright

This manual is copyrighted by Canon Computer Systems, Inc. (CCSI) with all rights
reserved. Under the copyright laws, this manual may not be reproduced in any form, in
whole or part, without the prior written consent of CCSI.

© 2000 Canon Computer Systems, Inc.

Disclaimer

Canon Computer Systems, Inc. has reviewed this manual thoroughly in order to make it an
easy to use guide for your Canon BJC-55 Series Color Bubble Jet Printer. All statements,
technical information, and recommendations in this guide and in any guides or related
documents are believed reliable, but the accuracy and completeness thereof are not
guaranteed or warranted, and they are not intended to be, nor should they be understood to
be, representations or warranties concerning the products described.

Your printer and the software media included with your printer have been sold to you
subject to the limited warranties set forth in the warranty card and license agreement
enclosed with the respective products. All software is licensed AS IS, as described in the
license agreement enclosed with the software media. Further, CCSI reserves the right to
make changes in the specifications of the products described in this guide at any time
without notice and without obligation to notify any person of such changes.

Introduction



Trademarks

Canon, BCI, BJ, BJC and Bubble Jet are trademarks, and SelectExchange is a service
mark of Canon Inc. Print Planet is a service mark of Canon Computer Systems, Inc.

Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and
other countries.

All other product and brand names are trademarks or service marks of their respective
owners.

it

As an ENERGY STAR® Partner, Canon U.S.A., Inc. has determined that this product meets
the ENERGY STAR® guidelines for energy efficiency.

ENERGY STAR® COMPLIANT
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FCC Regulations

Color Bubble Jet Printer, Model K10196

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

* Consult the dealer or an experienced radio/TV technician for help.

Introduction



FCC Regulations

Use of shielded cable is required to comply with Class B limits in Subpart B of Part 15 of
FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in
the manual. If such changes or modifications should be made, you could be required to
stop operation of the equipment.

Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus as set out in the interference-causing equipment standard entitled “Digital
Apparatus,” ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux
appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur:
“Appareils Numériques,” NMB-003 édictée par I'lndustrie et Sciences Canada.
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Safety Precautions

Please read the safety warnings provided in this manual to ensure that you use the printer
safely. Do not attempt to use the printer in any way not described in this manual as this
could result in unforeseen printer faults or cause a fire or electric shock.

Printer Location

Power Outlet and Power Cord
Cleaning the Printer

BJ Cartridges

General Warnings

Battery Pack

Transporting the Printer
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B Printer Location

Safety Precautions

The electrical contacts inside the printer become hot during normal
operation. To avoid causing a fire or dangerous electrical shock,
never store volatile substances such as alcohol or thinner near the
printer.

To avoid damage to the printer or possible personal injury, place
the printer on a flat, stable surface that is safe from sudden shocks
or strong vibrations to ensure that it will not fall.

To avoid damage to the printer that could result in a fire or
electrical shock, place it in a location that is protected from dust,
direct sunlight, high temperature, and high humidity. Use the
printer in an environment where temperature and humidity are
within the ranges of 41 to 95°F (5 to 35°C) and 10 to 90% RH
(with no condensation).
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Safety Precautions

B Power Outlet and Power Cord
The socket-outlet shall be installed near the equipment and shall be easily accessible.

To avoid personal injury from an electrical shock, never handle the
power cord or plug when your hands are wet.

To avoid causing a fire or serious electrical shock, make sure that
the power plug is securely and completely inserted into the power
outlet.

To avoid causing a fire or serious electrical shock, never use any
type of power adapter other than the universal AC adapter
provided with the printer.

To avoid a fire or serious electrical shock caused by a short circuit,
avoid damaging the AC adapter cord or the power cord. Do not
attempt to modify the cords in any way. Do not apply force to the
cords by pulling on them nor place a heavy object on the cords.

Introduction 15



Safety Precautions

To avoid a fire or serious electrical shock, do not knot the power
cord or wrap it around itself.

To avoid damaging the power plug, which could cause a short
circuit and cause a fire or electrical shock, do not pull on the power
cord to unplug the cord from the power outlet. Grip the plug to
remove it from the power outlet.

To avoid minor burns or minor injury from moving parts, press the
POWER button to turn off the printer then unplug the power cord

from the power outlet and allow the electrical contacts inside the

printer to cool before cleaning the printer.

To avoid a fire or electrical shock, always keep the area around the
power outlet free of obstacles so you can reach the power plug
quickly to unplug it in an emergency.
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Safety Precautions

B Cleaning the Printer

Use only a damp, clean cloth to clean the surfaces of the printer.
The electrical contacts inside the printer become hot during normal
operation. To avoid a fire or serious electrical shock, do not use
alcohol, benzene, thinner, or any other type of volatile liquid
cleaner to clean the printer.

A\ Caution

Store the BJ cartridges and BJ tanks out of the reach of small
children. If a child accidentally ingests ink from a BJ cartridge or
BJ tank, contact a physician immediately.

To avoid staining clothing or your work area with spilled ink, do not
violently shake or drop a BJ cartridge.
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Safety Precautions

B General Warnings

There are high voltage points inside the printer. To avoid a fire or
electrical shock, do not attempt to disassemble the printer or
attempt repairs.

A\ Caution

To avoid a fire or electrical shock, do not use volatile sprays around
the printer.

The electrical contacts of the BJ cartridge become extremely hot
during normal operation. To avoid minor burns, do not touch the
electrical contacts after removing the BJ cartridge from the printer.

To avoid minor injury from moving parts inside the printer, do not
open the cover and insert your fingers into the printer while the
D printer is printing.
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Battery Pack

&2

Safety Precautions

To avoid damage to the printer from objects falling into it, resulting
in a fire or electrical shock, do not place any object such as a
stapler or liquid container on top of the printer.

If any object falls into the printer and damages it while it is printing,
press the POWER button to turn it off and unplug the power cord
from the power outlet. To avoid a fire or electrical shock, stop using
the printer and call the Canon Customer Care Center.

B Getting Help From Canon

To avoid a fire or serious electrical shock, if the printer emits smoke
or a strange odor, immediately press the POWER button to turn
the printer off then unplug the power cord from the power outlet.
Stop using the printer and call the Canon Customer Care Center.

® Getting Help From Canon

Use only the Canon LB-50 Li-lon Battery provided with this printer.
Using any other battery could cause the printer to overheat and
cause smoke.
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Safety Precautions

Do not heat the battery nor attempt to incinerate it. Do not use or
store the battery near an open flame or other high heat source,
such as a stove or space heater.

To avoid short circuiting the battery, do not touch the electrical

contacts of the battery with a tool or other metal object. Always
keep items such as necklaces, hairpins, paper clips, and pins,

away from the electrical contacts when handling or storing the

battery.

To avoid short circuiting the battery, do not attempt to disassemble
the battery, strike the battery with a tool or heavy object, or attempt
to repair the battery.

Do not place the battery in a microwave oven or stove, or subject
the battery to high pressure. The battery could explode.

Introduction
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Safety Precautions

Do not attempt to connect the battery to an external power source,
such as a home power outlet or a cigarette lighter receptacle in an
automobile.

Do not attempt to use the battery in any other computer or device.

If liquid from the battery comes into contact with your eye, wash it

in cold running water and contact a physician for medical treatment
immediately to prevent injury or impaired vision.

If the battery leaks, or emits smoke or noxious odors, move it
immediately to a cooler location.
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Safety Precautions

At any time if you notice that the battery is leaking or emitting
smoke or noxious odors, or if the battery case is warped or broken,
remove the battery from the printer immediately and discontinue
use of the battery.

B Transporting the Printer

Turn the printer off and make sure the POWER light is off. To
ensure that the printer remains off while travelling, slide the Power
Lock switch forward to the LOCK position.

Securely close the front and top covers.

Handle the printer carefully. Avoid dropping the printer or
subjecting it to shocks or strong vibration, and do not place
a heavy object on top of the printer.
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Safety Precautions

Do not carry the printer in a briefcase or handbag with loose, small
metal objects (such as fasteners or jewelry). Loose objects could
enter the paper output slot and damage the printer or cause a
malfunction.

Use the printer in a clean location that is free of dust and smoke.
Do not leave the printer unattended on top of a table or desk.
Always keep the top cover closed, and when the printer is not in
use, store it in a drawer or other safe location to prevent foreign
objects from entering the printer.

To avoid damaging delicate cable connectors and connection
points on the printer, always disconnect the USB interface cable
and the AC adapter power cable before you move or transport the
printer.

After you reach your travel destination, always use or store the
printer on a flat surface. Do not store or attempt to use the printer
with it standing on end or positioned at an odd angle. Do not
attempt to hold it in your hand while it is printing.

Introduction 23



Options and Supplies

The following options and consumables are available for use with this printer. To get more
information, visit our web site at www.ccsi.canon.com.

Options

Item

Comments

ASF-50 Auto Sheet Feeder

Easily attaches to front of printer and allows you to
stack paper for printing

IS-12 Color Image Scanner Cartridge

Color scanner option

SB-10 Ink Cartridge Storage Box

Additional storage box for extra BJ cartridges (one
provided with printer)

LB-50 Li-lon Battery

Additional battery pack for the printer (one provided
with printer)

Consumables

Item

Comments

BC-10 Black BJ Cartridge

Monochrome printing

BCI-10 Black BJ Tank

Black ink for BC-10 Black BJ Cartridge

BC-11e Color BJ Cartridge

Color printing

BCI-11 Color BJ Tank

Color ink for BC-11e Color BJ Cartridge

BCI-11 Black BJ Tank

Black ink for BC-11e Color BJ Cartridge

BC-12e Photo BJ Cartridge

Photographic printing

BCI-12 Photo Color BJ Tank

Color ink for the BC-12e Photo BJ Cartridge

BCI-12 Photo Black BJ Tank

Black ink for the BC-12e Photo BJ Cartridge
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Options and Supplies

Paper and special print media

Media

Back Print Film

Brilliant White Paper

Bubble Jet Paper

Glossy Photo Cards

Glossy Photo Paper

High Gloss Film

High Resolution Paper

Transparencies

Envelopes
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Getting Ready to Print

Printer Parts and Their Functions

Turning the Printer On and Off

Using a USB Connection

Setting Up and Using a Wireless Connection
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Printer Parts and Their Functions

This section describes important parts of the printer and how they function.
B Front View

Top Cover
Open to install
or change the
BJ cartridge.

Operation Panel

Operation Panel
» P Power Lock Switch

In LOCK position
prevents you from
accidentally turning
on the printer during
transport.

Paper Feed Slot
Insert sheets for
printing here.

Battery Pack
Must be installed in

Power Connector
printer at all times.

Provides the
connection point for

Front Cover Paper Guide the universal AC

Open to install the Adjusts to the ~ adapter plug.
battery pack or size of the paper
feed paper. or special media

you are feeding.
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Printer Parts and Their Functions

B Back View

USB Interface
Connector

Paper Output Slot
Printed sheet exits
here.

IrDA Interface Port

Provides a wireless connection between
the printer and a computer equipped
with an IrDA interface.
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Printer Parts and Their Functions

B Operation Panel

CARTRIDGE Button POWER Light

Press to move the Indicates whether or not the printer is on.

cartridge holder to the On Lights green when the printer is standing by and ready for
center in order to switch normal operation.

BJ cartridges or to

Off Printer power is turned off.

replace BJ tanks and to Flashing Printer is warming up after power on, or performing a

return the cartridge
holder to the home

maintenance procedure, such as cleaning the print head,
changing a BJ cartridge, or printing a Nozzle Check Pattern.

position when you are

finished.

POWER Button
Press to turn the
printer on and off.
s Turning the
Printer On
and Off

Note p

RESUME Button

Press to cancel an error or warning.

When no error exists, press once to feed a
sheet of paper. If paper is partially fed into
the printer, the sheet will be ejected.
Press and hold down until the printer beeps
twice then release to start print head

/ cleaning.
CHARGE/ERROR Light = Cleaning the Print Head
Lights or flashes orange when an error
occurs.

= CHARGE/ERROR light is orange

* If you will not be using the printer for a long period of time, turn off the
printer; then remove the AC adapter power cord from the power outlet.

* Always press the POWER button to turn the printer off before you
remove the AC adapter power cord from the power outlet. If the power
cord is unplugged before the printer is turned off with the POWER
button, the BJ cartridge will not return to the home position and may dry
out which could cause the BJ cartridge to become unusable.

Getting Ready to Print
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Printer Parts and Their Functions

B POWER and CHARGE/ERROR Lights
The POWER light flashes in the following situations:

During print head cleaning. When the POWER light stops flashing, print head
cleaning is complete and the printer is ready for operation.

When the last page of a print job does not print.

While you are performing routine print head maintenance such as replacing
a BJ tank, replacing a BJ Cartridge, changing the BJ cartridge, or replacing
the BJ cartridge with the I1S-12 Color Image Scanner Cartridge.

During printing of the Nozzle Check Pattern.

CHARGE/ERROR light

When the printer is off and the AC adapter is connected to the printer and plugged into the
power outlet, the CHARGE/ERROR light is green and stays on while the battery pack in the
printer is charging. When the battery pack is fully charged, this light will go off.

When the printer is on, the CHARGE/ERROR light flashes orange when an error occurs.
Remove the cause of the error then press RESUME to resume normal operation.

The first time you turn on the printer, the empty cartridge holder will move to the center of
the printer. The CHARGE/ERROR lights orange and the printer beeps three times to
remind you to install a BJ cartridge.
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Turning the Printer On and Off

1 Press the POWER button to turn the printer on and off.
L ]

CEN©) \O{@D cuses

POWER Button

2 When you turn off the printer, the BJ cartridge holder moves to the home
position on the left side of the printer and caps itself (which protects the
print head from drying out). Do not turn off or unplug the printer while it is
printing.

3 The printer has a Power Lock switch that allows you to lock the power
switch. When the Power Lock switch is set to the LOCK position (toward the
front of the printer), you cannot turn the printer on and off. This prevents
you from accidentally turning on the printer while transporting it. Before
traveling with the printer, make sure the Power Lock switch is set to the
LOCK (front) position. Otherwise, leave the Power Lock switch in the back
position so you can use the POWER button to turn the printer on and off.
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Turning the Printer On and Off

4 The printer has an energy saving Auto Power Off feature that powers off the
printer automatically if it is idle for 30 minutes. Use the Windows or

Macintosh printer driver to turn this feature off or to change the idle time
interval.
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Using a USB Connection

The connector for the USB interface cable is on the side of the printer.

Front of printer

USB interface connector

You can disconnect the USB interface cable from the computer or printer while the
printer is on. However, to avoid problems with the printer, do not disconnect the USB

interface cable in the following situations:
* During installation of the printer driver.

* While the Windows or Macintosh Operating System is starting up after turning
the computer on.

* During a print job.
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Using a USB Connection

Wait at least five seconds before disconnecting the USB interface cable.

If you must disconnect the USB interface cable, wait at least five seconds after turning off
the computer and printer. Removing the cable immediately after turning on the computer or
printer could cause problems with the printer.

If you have more than one printer connected via USB, use an externally connected
USB hub.

Disconnect printer or hub first

If you must disconnect the USB interface cable with the computer’s power on, always
disconnect the USB interface cable from the printer or USB hub before you disconnect it
from the computer.
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Setting Up and Using a Wireless Connection

If you have a computer with an infrared port for wireless data transmission, you can set
up a cordless connection with the printer using the IrDA method to effect infrared data
transmission.

Before you can set up an infrared connection with the printer, you must perform several
settings on the computer. Make sure that you read the section below before you set up the
connection.

B \What You Need for Infrared Data Transmission

In order to use infrared data transmission, you need the Windows 98 or Windows 2000 plug
and play Microsoft infrared driver Version 3.0. The following items are required in order to
set up wireless data transmission between the printer and computer via the infrared ports
on the printer and your computer.

Computer IBM PC/AT or a compatible computer

CPU Intel® Pentium® or faster

IrDA IrDA 1.1 or later

Baud rate Max. 4 Mbps

(transmission speed)

Infrared transmission Built-in infrared port on the computer, or an infrared

device transmission adapter connected to the parallel or serial
port.

Operating system Windows 98 or Windows 2000

Getting Ready to Print
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Setting Up and Using a Wireless Connection

B Confirming That the Infrared Transmission Driver Has Been Installed

1

2

Click Start, select Settings, and click Control Panel to open the Control
Panel Window.

Look at the Control Panel window and confirm that the Infrared Monitor icon
is displayed.

If the Infrared Monitor icon is displayed, the required infrared transmission
driver is already installed.

If the Infrared Monitor icon is not displayed, refer to your Windows
documentation for instructions on installing the infrared driver.
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Setting Up and Using a Wireless Connection

B Using Infrared Data Transmission
The printer IrDA interface is on the side of the printer.

Front of printer

Back of printer

IrDA interface

Locate the IrDA interface on your computer. Position the printer so the IrDA interface ports
are facing one another.

Note P The IrDA interface ports must face one another and be approximately level,
within a range of about 15 degrees left or right, approximately 15 degrees
up or down and not more than 31.49 inches (80 cm) apart.
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Setting Up and Using a Wireless Connection

The distance between the computer and printer may be different for some units; for details,
refer to your computer documentation.

*...approx. 15 degrees

The following conditions may reduce the reception range of the IrDA interface.
* If another IrDA device is attached.

* |f another infrared device, like a set of wireless headphones or a remote
controller, for example, is broadcasting in the same area.

* |f the IrDA port is exposed to sunlight, fluorescent light, or any other strong light
source.

 If the IrDA port is not clean. Clean it with a soft, dry cloth if the port is smudged
or dirty.

To use IrDA successfully, make sure the computer is set up for IrDA operation:

¢ Make sure the infrared driver Microsoft IR Comm Driver Ver. 3.0 has been
installed.
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Setting Up and Using a Wireless Connection

If you are using Windows 98, make sure a COM port has been selected for IrDA
with the Printer Wizard. Allocation of a port for an IrDA wireless interface may
depend on the computer you are using. Usually COM4 can be selected as an
external serial (COM) port. For details about your system configuration, refer to
your computer manual.

If you are using Windows 2000, select IR as the destination printer port. For
details about how to do this, refer to your computer documentation.

Make sure the BJC-55 is selected as the default printer within the BJC-55 printer
driver.

Only the Microsoft IR Comm Driver Ver. 3.0 can be used as the IrDA driver for
the BJC-55 Series. Other IrDA drivers cannot be used.

The IrDA interface cannot detect the printer status or reset the printer. If
communication between the printer and computer is interrupted, the print job is
stopped and the printer is initialized. (The data in the printer is cleared and the
paper is ejected.)
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Paper Handling

Paper and Other Print Media
Loading Paper in the Printer
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Paper and Other Print Media

Note Pp

Always read any special instructions that come with the print media.

Always handle paper and special print media by the edges, and avoid touching
the print surfaces of the sheets. If the print surface is soiled or scratched, the
print quality will deteriorate.

Always store unused paper and special print media in its original package. Do
not bend the media. Store the package flat, in a cool location that is not exposed
to high temperatures, high humidity, or direct sunlight.

Do not use media that is excessively curled, creased, or in any other way
defective. If the media is curled, you may be able to remove the curl by bending
the media in the opposite direction before loading it in the printer.

== A
0.2in.
To straighten curled media, Hold the edges of the Make sure that
bend it through an arc of stack diagonally and envelopes are not
0.2 in. (5 mm) in the bend gently. curled more than
direction opposite the curl 0.2 in. (5 mm).

until it is straight.

After printing, do not allow any moisture to contact the printed surface.

Paper Handling
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Paper and Other Print Media

B Media You Can Use With This Printer
You can use any of the media listed in the table below.

Before you execute a print job, open the printer driver and select settings for Paper Size,
Media Type, and Paper Feed that match the media loaded in the printer.

® Printing With Windows 98 or Windows CE
® Printing With Windows 2000
® Printing With Macintosh

Printer Driver Settings
Media Print Side
Page Size Media Type

Plain Paper Indicated on package | Letter, Legal, A4, B5, A5 | Plain Paper
Back Print Film Matte side Letter, A4 Back Print Film
Brilliant White Paper Either side Letter, Legal Plain Paper
Bubble Jet Paper Either side Letter, Legal Plain Paper
Glossy Photo Cards Glossy side Letter, A4 Glossy Photo Cards
Glossy Photo Paper Glossy side Letter, A4 Glossy Photo Paper
High Gloss Film Film side Letter, A4 High Gloss Film
High Resolution Paper | Whiter side Letter, A4 High Resolution Paper
Transparencies Either side Letter, A4 Transparency
Envelopes:
US Com. No. 10 Smooth side #10 Env. Envelope
European DL Smooth side DL Env. Envelope
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B Printing Area
Print within the area marked by the darkest shading in the illustration below.

0.12in./
3.0 mm(*1)

0.28in./
7.0 mm(*2)

— — — L

0.13in./ 0.13in./ !
3.4 mm(*3) 3.4 mm(*4)

B Specifications—Printing Area

Paper and Other Print Media

Printing in this area is possible but not
recommended. Printing may degrade in this
area due to variations in the precision of
paper feed, and printing may run over the
bottom edge of the sheet.

Recommended print area for optimum
results.

*1 Glossy Photo Cards: 1.10 in./28.0 mm
*2 Glossy Photo Cards: 1.0 in./26.0 mm
*3 Letter, Legal: 0.25 in./6.4 mm

Glossy Photo Cards: 0.16 in./4.0 mm
*4 Letter, Legal: 0.25 in./6.3 mm

Glossy Photo Cards: 0.20 in./5.0 mm
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B Plain Paper

Paper and Other Print Media

e Use Canon Bubble Jet Paper or any plain copier paper that meets the
requirements listed below. You cannot use continuous feed paper with this

printer.
Plain Paper Specifications

Paper Size Letter 8.5X 11 in.
Legal 8.5 X 14 in.
A4 210 X 297 mm
B5 182 X 257 mm
A5 148 X 210 mm

Weight 17 to 28 Ib. (64 to 105 g/m?)

* Paper must be fed one sheet at a time (unless you install the optional auto

sheet feeder).

* Remove each sheet as it is ejected from the printer.

Paper Handling
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Paper and Other Print Media

B Back Print Film

Canon’s Back Print Film is recommended for use with this printer. Before you
use this media, read the instructions provided with the package.

When you select Back Print Film for the Media Type, the document image is
reversed or “mirrored” when it is printed so it will display correctly when placed
on a backlight device.

Do not attempt to print on back print film in a location where humidity is high.
Always print on the non-reflecting, rough side of back print film.

Set a sheet of back print film in the printer, with the print side facing up.
Always feed back print film manually, one sheet at a time.

Do not stack the sheets after printing. Allow at least 15 minutes for the ink on
printed sheets to dry, and do not touch the printed surfaces.

B Glossy Photo Cards

Canon’s Glossy Photo Cards are ideal for printing photographic images. This is a
special sized sheet made of the same stock as Glossy Photo Paper.

The cards have borders slightly larger than the print area. Separate the borders
from the cards at the perforations only after printing has been completed. You
can print 4 x 6 inch borderless photos.

Before you use this media, read the instructions provided with the package.

Allow about two minutes for ink to dry on Glossy Photo Cards.
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Paper and Other Print Media

B Glossy Photo Paper

Canon’s Glossy Photo Paper is recommended for use with this printer. This high
quality glossy-coated, heavy weight paper produces vibrant, lifelike color
images. With this paper, you can print photographic quality images.

Before you use this media, read the instructions provided with the package.
Print only on the glossy (whiter) surface of each sheet.

To prevent fading from long exposure to direct sunlight, cover each printed sheet
with a sheet of plain paper and store it in a dark location.

Allow about two minutes for ink to dry on Glossy Photo Paper.
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Paper and Other Print Media

B High Gloss Film

Canon’s High Gloss Film is recommended for use with this printer. Before you
use this media, read the instructions provided with the package.

Do not use High Gloss Film in conditions of high humidity.
Print only on the film surface of each sheet.
Feed High Gloss Film one sheet at a time.

Do not allow printed sheets to stack. Handle printed sheets carefully until the ink
has completely dried. Drying requires 10 to 20 minutes.

To store the printed sheets after they have dried, while avoiding touching the
printed surface, cover the printed surface of each sheet with one sheet of plain
paper.

B High Resolution Paper

Canon’s High Resolution Paper is recommended for use with this printer. This
medium is extra smooth for sharp text, brilliant graphics, and professional quality
images. It is ideal for printing photographs or business documents that include
color charts and graphs.

Print only on the coated (whiter) side of each sheet.

Store unused High Resolution Paper in its original package. Store it flat, in a cool
location that is not subject to high temperature or high humidity and protected
from direct sunlight.

To prevent fading from long exposure to direct sunlight, cover each printed sheet
with a sheet of plain paper and store it in a dark location.

Paper Handling
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Paper and Other Print Media

B Transparencies

Canon’s Transparencies are recommended for use with this printer. Before you
use this media, read the instructions provided with the package.

Do not use transparencies intended for use with a photocopier or laser printer.
Do not attempt to print on transparencies in a location where humidity is high.
You can print on either side of transparencies.

Do not stack transparencies after printing. Allow at least 15 minutes for the ink
on printed transparencies to dry, and do not touch the printed surfaces.

To prevent printed transparencies from sticking together, cover the printed
surface of each sheet with one sheet of plain paper. Cover each transparency
with a sheet of plain paper, even before storing them in a plastic folder.
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Paper and Other Print Media

B Envelopes

Use only US Commercial #10 or European DL envelopes with this printer.

Before loading an envelope in the printer, crease the edges if they are not
perfectly square, and bend the envelope opposite to the direction of the curl if
it is curled.

Press down the flaps.

I

If an envelope does not feed smoothly, use a pen
or other flat object to crease the leading edge of
the envelope.

To prevent feed problems, do not use self-
sealing envelopes.

Do not attempt to feed an envelope that has been heavily embossed or treated
with any type of special coating or coloring.
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Loading Paper in the Printer

Paper and other media must be loaded one sheet at a time.

1 Open the front cover and slide the paper guide completely to the right to
match the media you are loading.

Front cover

Mark for paper size

Paper guide

Paper Handling
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Loading Paper in the Printer

2 Insert the sheet aligning the left edge with the tab on the left side of the
front cover. Adjust the paper guide to the right side of the sheet.

Tab
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Loading Paper in the Printer

Hold the sheet until it automatically feeds into the printer.

Set up the print job with the printer driver and start the print job.

You can change paper size, paper type, and other important settings in the
printer driver.

B Printing With Windows 98 or Windows CE
B Printing With Windows 2000
B Printing With Macintosh
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Maintaining the Printer

Using the Battery Pack

Printing a Nozzle Check Pattern
Cleaning the Print Head

Using the Low-Ink Alert

Maintaining BJ Cartridges and BJ Tanks
Replacing BJ Tanks

Changing or Replacing a BJ Cartridge
Cleaning the Printer

Transporting the Printer
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Using the Battery Pack

Install and use only a Canon LB-50 Li-lon Battery in this printer. You must install the battery
pack and leave it installed in the printer even if you intend to use the printer only with the
AC adapter. If the battery pack is not installed, the printer CHARGE/ERROR light will be
orange and the printer will beep six times.

B Recharging the Battery Pack

When the power in the battery pack runs low, the CHARGE/ERROR light flashes orange
and the printer beeps four times. When the power in the battery pack is depleted, the
CHARGE/ERROR lights orange and the printer beeps twice (one long and one short beep).

A\ Caution

1

Do not attempt to recharge the battery pack with anything other than the
Universal AC Adapter AD-360U supplied with the printer.

For best results, charge the battery pack at room temperature 50 to 86°F
(10 to 30°C). The battery pack will recharge very slowly at low temperature
and will not charge fully at high temperature.

Press the POWER button to turn off the printer.

L _J

—

Q CHARGE
POWER [#] resume ERROR

<> D
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Using the Battery Pack

2 Connect the power cord to the AC adapter, insert the DC plug into the
printer, and insert the power cord into a power source.

The green CHARGE/ERROR light stays on until the battery pack is
completely recharged.

3 When the CHARGE/ERROR light goes off, you can disconnect the AC
adapter.

Note P * The battery pack requires 4 to 6 hours (maximum) to recharge.

* The battery pack may become warm during a long print job and may
not start recharging until it has cooled (approximately 30 minutes).
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Using the Battery Pack

B Replacing the Battery Pack

You can replace the battery pack at any time. You may want to purchase and carry extra
battery packs for emergencies. However, remember that new battery packs must be
fully charged before you can use them. Before you travel, make sure new battery packs
are fully charged.

You must replace a battery pack after it is exhausted. The CHARGE/ERROR light will flash
and the printer will beep six times when the battery pack becomes exhausted. When the
battery pack is exhausted, you cannot recharge it.

1 Press the POWER button to turn off the printer.

2 fthe optional Auto Sheet Feeder is installed on the printer, remove it.

3 Open the front cover.
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Using the Battery Pack

Push the battery pack release button to the right. The battery pack will
spring slightly out of the printer.

Remove the battery pack from the printer.

Remove the new battery pack from its packaging.
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Using the Battery Pack

7 Align the mark on the printer (>) with the mark on the battery pack (¢) and
insert the left end of the battery pack into the printer at a slight angle.

Insert here

Align [><| marks

8 Press the right side of the battery pack to lock it in place, and close the front
cover.

If you have just installed a new battery pack, you must allow it to charge before you can use
it. Just leave the AC adapter connected to the printer and the power outlet. The battery pack
will charge while the printer is turned off or on. About 4 to 6 hours are required for the
battery pack to fully charge.

Note P If you have replaced an exhausted battery pack, dispose of the battery
pack according to local regulations.
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Printing a Nozzle Check Pattern

If you see colors missing or broken in your printed output, print a Nozzle Check Pattern to
determine the condition of the print head.

If the BC-11e Color BJ Cartridge or BC-12e Photo BJ Cartridge is installed in the printer,
four colors (black, cyan, magenta, yellow) will be printed in the Nozzle Check Pattern. If the
BC-10 Black BJ Cartridge is installed, only a black pattern will be printed.

If the horizontal lines in the Nozzle Check Pattern are broken or irregular, the print heads
may be clogged and require cleaning.

To print a Nozzle Check Pattern, follow these steps:
1 Set a sheet of plain paper in the printer.
2 Press the POWER button to turn the printer off.
3 Press and hold down the POWER button until you hear the printer beep

four times then release it.

The Nozzle Check Pattern begins to print. The printer prints one page and
then stops.

You can also use the printer driver to print a Nozzle Check Pattern.
® Printing With Windows 98 or Windows CE
B Printing With Windows 2000
® Printing With Macintosh
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Printing a Nozzle Check Pattern

B Normal Nozzle Check Pattern

Here is a sample of a normal Nozzle Check Pattern printed with the BC-10 Black
BJ Cartridge.

Here is a sample of a normal Nozzle Check Pattern printed with a BC-11e Color
BJ Cartridge or a BC-12e Photo BJ Cartridge.

n __—Yellow
7 e s s e S R I Magenta
7 i e e S R —Cyan

Ut )——Black
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Cleaning the Print Head

Clean the print head whenever the print quality is poor. There are two methods for cleaning
the print head.

B Print Head Cleaning
This method takes about 30 seconds and improves print quality.

B Deep Print Head Cleaning

Use this more thorough method only after five consecutive print head cleanings fail to
produce a satisfactory Nozzle Check Pattern. This method takes about 60 seconds and
corrects severe nozzle clogging.

1 Make sure that the printer is turned on.

2 Press and hold down the RESUME button until you hear the required
number of beeps and then release it.

Print head cleaning 2 beeps (about 2 seconds)
Deep print head cleaning 3 beeps (about 3 seconds)
L J
[Slcantao es@ @Meum@ cranee
> O
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Note Pp

Cleaning the Print Head

Print head cleaning begins.

The POWER light flashes during print head cleaning. When print head
cleaning is finished, the POWER light remains on, indicating that the printer
is ready for operation.

After print head cleaning is complete, print another Nozzle Check Pattern.
If the Nozzle Check Pattern is not satisfactory, repeat print head cleaning
several times and print another Nozzle Check Pattern. If the results are still
not satisfactory, perform deep print head cleaning once or twice.

If necessary, replace the BJ tank(s).
® Replacing BJ Tanks

* Print head deep cleaning consumes a large amount of ink. Perform
deep print head cleaning only after five consecutive print head cleanings
fail to correct the problem. If you are sure the BJ tanks are full, and deep
print head cleaning does not solve the problem, the print head may be
worn out or damaged. Replace the BJ cartridge.

B Changing or Replacing a BJ Cartridge
* You can also perform print head cleaning and deep print head cleaning
with the printer driver.
B Printing With Windows 98 or Windows CE
® Printing With Windows 2000
® Printing With Macintosh
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Using the Low-Ink Alert

This printer employs a low-ink alert that warns you when ink in a BJ tank runs low. Before
the printer is shipped from the factory, the low-ink alert is turned off.

To turn on the low-ink alert manually, follow these steps:
1 Press the POWER button to turn off the printer.

2 Press and hold down the POWER button until the printer beeps 8 times
then release the POWER button.

When the low-ink alert is turned on, and the ink supply in a BJ tank runs low, the CHARGE/
ERROR light starts flashing orange. To determine which BJ tank is about to run out of ink,

open the cartridge cover and press the CARTRIDGE button to move the cartridge holder to
the center. The type and number of flashes tell you which BJ tank is about to run out of ink.

Flashing Meaning
Steady flash Black BJ tank requires replacement
2 alternating flashes Color BJ tank requires replacement
3 alternating flashes Color and black BJ tanks require replacement

You can also turn on this feature with a simple procedure in the printer driver.

® Printing With Windows 98 or Windows CE
® Printing With Windows 2000
® Printing With Macintosh
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Using the Low-Ink Alert

B Resetting the Low-Ink Alert After Replacing a BJ Tank

You can reset the low-ink alert manually with the printer’s operation panel. After replacing
the BJ tank, press and hold down the RESUME button for the required number of beeps,
depending on which BJ tanks you replaced.

Replaced BJ Tank Press & Hold Until you hear
Black RESUME 1 beep
Color RESUME 2 beeps
Black and Color RESUME 3 beeps
Cancel selection RESUME 4 beeps

Also, after a low-ink alert occurs, you can replace the BJ tank from the Maintenance tab of
the printer driver and reset the low-ink alert.

® Printing With Windows 98 or Windows CE
® Printing With Windows 2000
® Printing With Macintosh

Turning Off the Low-Ink Alert

1 Press POWER to turn off the printer.

2 Press and hold down the POWER button until the printer beeps 7 times.
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Maintaining BJ Cartridges and BJ Tanks

Be sure to use BJ cartridges and BJ tanks within six months of purchase to ensure
optimum printing. To avoid leaking or drying, follow these simple precautions:

* Do not attempt to disassemble a BJ cartridge or BJ tank.

Do not shake a BJ cartridge or BJ tank.
Do not unpack a BJ cartridge or BJ tank until you are ready to install it.

Do not remove BJ tanks from the BJ cartridge unnecessarily.

To prevent drying out the print head, do not use the print head unit with a
BJ tank missing.

* Always install a BJ cartridge or BJ tank as soon as you remove the
protective cap.

A Caution » Keep unused BJ cartridges and BJ tanks out of the reach of children,
autio and discard used BJ cartridges and BJ tanks immediately. If spilled, the
ink is difficult to clean.
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Maintaining BJ Cartridges and BJ Tanks

The BC-11e Color BJ Cartridge holds two BJ tanks: the BCI-11 Color BJ Tank and the
BCI-11 Black BJ Tank.

BCI-11 Black

BJ Tank

When the black ink
runs out, replace
this BJ tank.

BCI-11 Color

BJ Tank

When the colorink
runs out, replace
this BJ tank.

Print head unit

Print head

BC-11e Color BJ Cartridge
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Maintaining BJ Cartridges and BJ Tanks

The BC-10 Black BJ Cartridge holds only one BJ tank.

BCI-10 Black
BJ Tank

When the black
ink runs out,
replace this

BJ tank.

Print head unit

Print head

BC-10 Black BJ Cartridge
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Replacing BJ Tanks

When a BJ tank runs out of ink, only the tank requires replacement.

1 Make sure the printer is turned on and then press the CARTRIDGE button
to move the cartridge to the center.

2 Open the top cover.

Maintaining the Printer 68



Replacing BJ Tanks

If you have the BC-11e Color BJ Cartridge installed:

* Press in and lift the white tab to remove the BCI-11 Color BJ Tank.

* Press in and lift the gray tab to remove the BCI-11 Black BJ Tank.

If you have the BC-10 Black BJ Cartridge installed:

* Press in and lift the gray tab to remove the BCI-10 Black BJ Tank.

If you have the BC-12e Photo BJ Cartridge installed:

* Press in and lift the white tab to remove the BCI-12 Photo Color BJ Tank.
* Press in and lift the gray tab to remove the BCI-12 Photo Black BJ Tank.

White tab

Gray tab
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Replacing BJ Tanks

BCI-10 Black BJ Tank

Do not press the green tab!
This is for BJ Cartridge
replacement. Be sure to leave
the green print head unit in the
printer.

Note Pp * Do not touch the green tab.

* You do not remove the BJ cartridge when you replace a BJ tank.
Leave the BJ cartridge installed in the printer.

* Please dispose of empty BJ tanks in accordance with any local laws
regarding the disposal of consumables.

Maintaining the Printer

70



Replacing BJ Tanks

4 Select a new BJ tank; be sure to use the same type that you removed from
the printer. Remove the new BJ tank from its package and remove the

orange protective cap.

BCI-11 Black or BCI-12 Black

Orange
protective cap

BCI-11 Color or BCI-12 Color

protective cap

To avoid interfering
with the flow of ink and
to ensure optimum
performance of the

BJ cartridge, do not
touch the open ink
port on a BJ tank.
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5

Replacing BJ Tanks

Install the BJ tank.

With the label up, set the BJ tank into the BJ cartridge at a slight angle,
then gently press down on the right, raised end of the BJ tank until it locks
in place.

* Align the marks on the BJ tank with the marks (><) on the BJ cartridge.

* Press down on the right side until you hear the BJ tank lock in place.
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Replacing BJ Tanks

6 Close the top cover and press the CARTRIDGE button.

The printer moves the cartridge holder to the home position and
automatically starts cleaning the print heads. The POWER light flashes
during the print head cleaning. Print head cleaning is complete and the
printer is ready for operation when the POWER light remains on.

Note Pp You can also perform BJ tank replacement from the Maintenance tab of the
printer driver.

® Printing With Windows 98 or Windows CE
® Printing With Windows 2000
® Printing With Macintosh
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Changing or Replacing a BJ Cartridge

You can use these BJ cartridges with this printer.

BJ Cartridges and BJ Tanks Use for:
BC-11e Color BJ Cartridge Printing in color
e BCI-11 Color BJ Tank

e BCI-11 Black BJ Tank

BC-10 Black BJ Cartridge Printing in monochrome (black ink only)
* BCI-10 Black BJ Tank

BC-12e Photo BJ Cartridge Printing photographic images in color
* BCI-12 Photo Color BJ Tank
» BCI-12 Photo Black BJ Tank

Note Pp * You can use the BC-11e Color BJ Cartridge to print black only. However,
for large monochrome print jobs, like a document that contains mainly
text, always use the BC-10 Black BJ Cartridge.

* To avoid damaging the printer, do not touch the orange film cable under
the top cover.
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Changing or Replacing a BJ Cartridge

Replace the BJ cartridge if deep print head cleaning fails to restore print quality. In this
case, the print head may be damaged or worn out and requires replacement.

1 Make sure the printer is turned on and then press the CARTRIDGE button
to move the cartridge to the center.

2 Open the top cover.
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Changing or Replacing a BJ Cartridge

3 Remove the BJ cartridge.

Lift the green tab to remove the BJ cartridge from the holder.

Green tab

Note P Always lift the green tab to remove the BJ cartridge. The gray and white
tabs are for removing the individual BJ tanks.

If you are replacing a cartridge, dispose of the old BJ cartridge immediately.
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Changing or Replacing a BJ Cartridge

4 |f you are changing cartridges, immediately store the BJ cartridge you just
removed in an Ink Cartridge Storage Box.

Note P * When you are not using a BJ cartridge, always store it in an Ink
Cartridge Storage Box. Do not attempt to re-attach the orange protective
tape or protective cap to a BJ cartridge.

* Close the storage box lid tightly to prevent the BJ cartridge print head
from drying out and causing the BJ cartridge to become unusable.

Align these marks [><|

Storage box lid

Note P Dispose of the old BJ cartridge in accordance with any local laws
regarding the disposal of consumables.

Maintaining the Printer 77



Changing or Replacing a BJ Cartridge

5 Prepare the new BJ cartridge.

If you are installing a previously used BJ cartridge, remove it from its
storage box.

If you are installing a new BJ cartridge, pull off the top of the package and
remove the BJ cartridge. Invert the BJ cartridge with the label side down;
then remove the orange protective cap and the orange protective tape.

Remove the orange
protective tape.

Print Head
Do not touch this area.

protective cap.
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A\ Caution

Changing or Replacing a BJ Cartridge

To avoid damage to the printer, make sure you always remove
the orange protective cap and orange protective tape from a new
BJ cartridge before you install it in the printer.

To avoid minor cuts, do not touch electrical contacts on the BJ cartridge.

To avoid spilling ink on your clothing or around the work area, do not
drop or shake the BJ cartridge. Always turn the BJ cartridge upside
down before you remove the orange protective cap and tape.

Always handle the BJ cartridge carefully. Ink stains cannot be removed
from clothing.

To prevent staining your hands or damaging the print head, do not touch
the print head. After removing the orange protective cap and tape,
discard them immediately and do not attempt to re-attach them to a

BJ cartridge.
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Changing or Replacing a BJ Cartridge

6 With the label side up, set the BJ cartridge into the cartridge holder at a
slight angle.

Align the marks (>q) on the BJ cartridge with the marks on the holder. This
illustration shows the BC-10 Black BJ Cartridge being installed in the
printer. The BC-11e Color BJ Cartridge has similar marks that you align
for installation.

Insert the BJ Cartridge to align the

/ marks ([><])
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Changing or Replacing a BJ Cartridge

7/ Press down on the raised side of the BJ cartridge until it locks in place.

8 Close the top cover.

9 Wait about three seconds and press the CARTRIDGE button once.

After installing the BJ cartridge in the holder, the printer requires at least
two seconds to recognize the BJ cartridge.

The printer then moves the cartridge holder to the home position and
automatically starts cleaning the print heads. The POWER light flashes
during the print head cleaning. Print head cleaning is complete and the
printer is ready for operation when the POWER light remains on.

You can also use the printer driver to change a BJ cartridge.
B Printing With Windows 98 or Windows CE
® Printing With Windows 2000
B Printing With Macintosh
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Cleaning the Printer

Clean the printer regularly to avoid printing problems. Follow these precautions and

guidelines:

Before you clean the printer, press the POWER button to turn off the printer,
unplug the AC adapter from the power source, and remove the battery pack from
the printer.

Use only a soft cloth to clean the printer. Do not use paper towels or tissues.
Do not clean the grease from the cartridge rail.

To avoid damaging the surface of the printer, do not clean the printer body with
volatile liquids such as thinners, benzene, or any chemical or spray cleaners.

When cleaning the printer, avoid the area near the print head on the
BJ cartridge. Do not touch the print head, film cable, or other delicate
parts.

Do not submerge the printer in water.
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Cleaning the Printer

7 Open the top cover.

Film cable
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Cleaning the Printer

2 Clean the platen.

The platen, which holds the paper in position during ink transfer, may be
soiled after a paper jam or other paper feed problems. When the platen is
soiled with ink, the back or edge of the printed sheet may be smudged.
Use a soft, dry cloth to wipe the platen clean.

Instruction plate

Note P Do not bend the instruction plate.
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Cleaning the Printer

3 Clean the underside of the top cover. Ink residues may collect in this area.
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Transporting the Printer

Follow this procedure to pack the printer carefully for transporting to a service center or for

long term storage. Use the packing material that you saved when you unpacked the printer.

B Packing the Printer

1 Press the POWER button to turn off the printer. This secures the cartridge
holder in the home position.

2 On the right side of the printer, slide the Power Lock switch to the left
position. This locks the printer off so it cannot be turned on accidentally
during transportation.

Note P The next time you use the printer, make sure that you slide the Power Lock
switch to the right position before you press the POWER button to turn on
the printer.

3 If the optional Auto Sheet Feeder is attached, remove it.

4 |f the AC adapter and USB interface cable are connected, disconnect them
from the printer and the power outlet.

5 Make sure the top cover is closed.

Maintaining the Printer
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Note p

Transporting the Printer

If you are going to store the printer for a prolonged period (three months or
more), remove the battery pack.

You do not have to remove the battery pack to transport the printer.
Remove the battery pack only if you are going to store the printer for a
prolonged period (three months or more).

* Open the front cover.

* Push the battery pack release to the right. The battery pack will spring
slightly out of the printer.

* Remove the battery pack and close the front cover.
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Transporting the Printer

7/ Replace the printer and accessories in the original packing materials for
storage, or place them in a suitable carrying case for transport.

* It is not necessary to remove the BJ cartridge and BJ tanks from the
printer for transport.

* When travelling on an airplane, always pack the printer with your hand
luggage items to minimize shocks and vibrations to the printer.

* Avoid leaving the printer in a closed automobile where it may be exposed
to extremes of temperature or humidity.

Note P The printer can safely be sent through airport security X-ray machines.

B Shipping the Printer
Before shipping the printer by special delivery or post:

» Tape the lid of the box securely with strong tape.
* On the box write clearly FRAGILE or HANDLE WITH CARE.
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Transporting the Printer

B Travelling Abroad With the Printer
Here are some points to remember while travelling:

* You can use the universal AC adapter abroad to power the printer in countries
where AC 100~240V is used. However, you may need to purchase a power cord
for the countries where you intend to travel.

» X-ray or any other type of baggage inspection device will have no effect on this
printer.

B Universal AC Adapter AD-360U

The AC adapter is intended for use with this printer only; do not attempt to use the AC
adapter with other appliances or equipment or as a power/voltage converter in another
country. The power supply cord provided with purchase is for use in the United States or
Canada only. For other countries, you may need a power cord rated for use with the local
power supply.
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Printing With Windows 98 or Windows CE

Printer Driver Basics

Getting Ready to Print

Opening the Printer Properties Dialog Box
Selecting the Print Mode

Changing the Page Size

Using Online Help

Windows Printer Driver Features

Using the BJ Background Monitor

Using the BJ Backgrounder

Using the BJ Printer Status Monitor
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use
the printer with your computer, you must install the printer driver. For instructions on
installing the printer driver, refer to the Quick Start Guide.

Printing With Windows 98 or Windows CE
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Getting Ready to Print

After you have created a document with your software application and you are ready to
print, you’ll want to confirm the printer driver settings before printing.

Note P

The method of opening the printer driver may differ slightly, depending on
the software application. For details about starting a print job, refer to the
documentation for your software application.

First, open the printer Properties dialog box.
Normally, to open the printer driver from a software application, select Print
from the File menu then click the Properties button in the Print dialog box.

Canon BJC-55 Properties

Main | Page Layout| Stamp/Background | Mairtenance |

. Standard

o Tt TP Phato  SuperPhy

ot
I

Pints the active document

Canon BJCSS

e USBOOT

T Print to file

Cop

Number of gopies: || =]

L e

Cancel

BJ Cartidge:

Media Type:

5
Calor ~| I Grapscale Print

[lain Paper

Page Size: Letter
Orientatior: Portrait

Piirting Type Normak-size Piinfing

dyanced.. | About. | Detats |

0K | Cocd | aew | Hep |
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Getting Ready to Print

2 Click the print mode icon best suited for the print job.

By clicking a print mode icon you automatically enable the recommended
optimum settings for the type of document. After clicking on a print mode
icon, select the BJ Cartridge and Media Type that you are using.

Canon BJC-55 Properties [ 7] %]
Main | Page Layout | Stamp/Background | Maintenance |
: Select a print mode icon.
Choose Print Modg,
= ( B &t // #» Selecting the Print Mode
Sta:’\dld Dralt" F‘ho SuperPh
: i

e e i The BJ Cartridge and Media Type

HodoTipe [Pl Pape =l selections change automatically,
feosi Lt depending on which print mode icon
Orientation Partrait you select

Printing Typpe: Mormal-size Printing

A) Ditectior: ~ Pottait

Feed  ManualFeed Check the Page Size selection.

Stamp; Mone
Backaround Mone

Advanced.. | About.. | Defaults |

ok | cancel | mon | Hee |

Page Size

Select the page size beforehand in the software application. The first time
you open the printer driver, click the Page Layout tab and make sure the
selected page size is the same size selected in the software application. If
the selected page size on the Page Layout tab is different, click the down
arrow and select the page size from the drop-down list.

B Changing the Page Size
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Getting Ready to Print

When you are finished with the print settings, click OK to close the printer
Properties dialog box.

Canon BJC-55 Properties

Main | Page Layout | Stamp/Background | Maintenance |

EEENC;

Choose Print Mode;

Standard Draft DTF Fhoin  SuperPhot

- L]
BJ Cartridge: Color *| ™ Grayscale Print
Media Type: [Pt Paper =

Page Size: Letter
Drientatian Paitrait
Printing Type: Mormal-size Printing
&) Direction:  Portrait
Feed Manual Feed Stam: Mone
Backaround: MNone

|| —Click the OK button to
et [ aen (L ptae close the printer
A

-k ) .
€ o Y s | ok | Hoe | Properties dialog box.
- a— 2

Confirm that the printer is turned on and that paper is set in the printer.
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Getting Ready to Print

5 Start the print job.

The procedure to start the print job may differ slightly, depending on the

software application. Generally, you can start the print job by clicking the
OK button in the Print dialog box after closing from the printer Properties
dialog box.

Print HE

— Printer
Froperties

Mame:

Statuz: Defalt printer; Ready
Type: Canon BJC-55
‘where:  USBOOT

Comrment: ™ Prirt to file
i~ Print range Copie:

@Al Murnber of copies: IT 3:
 Pages from: |1 to:

e
¢ Selection

———-—
7
0K Y Carcel
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Getting Ready to Print

A screen like the one below is displayed during printing.

& Amazon World - WordPad
FEile Edit VYiew |nset Fomat Help

=10]x]

EENEEPEREEEE

BJ Backgrounder
Displays the progress of the

[riat = = [e s ulgl [z == _5” current print job. You can also
g -~ - -2 3 -4 5 ... usethe BJBackgrounderto
definitely the most dangerous to humans is the sand fly. When asked | Pause or halt the current print
by her editor to take a trip to the Amazon, the author idealistically _| job.
thought of exotic birds, mountains covered in ERELNT SN = B ® Using the BJ
ocean, hatives clothed in exotic apparel, or i, Phinting Backgrounder
But the trip through the Amazon required gre:
of transportation: boat, airplane, 4WD truck, &
discovered for herself such wonders as the ¢ 5 .
contains 30 times the Vitamin C of an ocrange Cme 1 1
when people in Brazil are poor, they do not he =

For Help, press F1 L e

s | € 2 2

| | [ Amszon World -wiordPed | E* Canon BJ Background Mo. .|| £ CIRSTR : Amazon W... {1} Canon B Printer Stalus M.

BJ Background Monitor
Click the button on the taskbar
to view the jobs queued for
printing and the status of the
current print job.
®» Using the BJ
Background Monitor

BJ Printer Status Monitor
Click the button on the taskbar to open the BJ Printer
Status Monitor to view the progress of the print job.
The BJ Printer Status Monitor opens automatically
and displays a message if the printer is not turned on,
if no paper is loaded in the printer, or if any other
problem occurs.

®» Using the BJ Printer Status Monitor
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Opening the Printer Properties Dialog Box

When you specify the print settings or use maintenance functions such as print head
cleaning, you must open the Printer Properties dialog box.

Note P This section describes the general procedures for opening the Printer
Properties dialog box. Depending on the application program you use,
different menu items may be used for printing. For more details, refer to the
documentation for your application program.

B From Your Application Program
You can open the Printer Properties dialog box from your application program before
printing.

1 Select the command used for printing (for example, Print or Print Setup
from the File menu) in your application program.

2 Make sure that Canon BJC-55 is selected in the Printer box.

If another printer name is displayed, click the down-arrow and then select
Canon BJC-55 from the pull-down list.

Print

Comment I~ Printto fle

- Piint range o
e Number of gopiess  [1 =)
© Pages from [1 to |—
€ Selection @ I Collate:

Cancel
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Opening the Printer Properties Dialog Box

3 Click the Properties button. The Printer Properties dialog box opens. The
Main, Page Layout, Stamp/Background, and Maintenance tabs are
displayed in the Printer Properties dialog box.

Canon BJC-55 Properties [ 7] x]
Main |Fage Layoutl Slamp/Backgroundl Mamlenancel
Chaoose Print Mode:
O
=Y ) )
shi Phato  SuperPhata
L]
B Cartridge: Colar = | [ Grapseale Print
Media Type: IPIam Paper j
Page Size: Letter
Orientation: Partrait
Frinting Type: Mormal-size Printing
A]Direction:  Portrait
Feed. Manual Feed Stamp Nane
Background: None
Advanced... | Abaut... | Defaults |
T = T

Printing With Windows 98 or Windows CE 98



Opening the Printer Properties Dialog Box

B From the Start Menu

When you wish to specify print settings that are common to all application programs, open
the Printer Properties dialog box from the Start menu.

This method is also helpful when you wish to use maintenance functions such as print head
cleaning without starting up an application program.

1 Click the Start button. Point to Settings, then click Printers.

2 When the Printers window is displayed, click the Canon BJC-55 icon.

nnnnnnnnnnn

uuuuuuuuuu
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Opening the Printer Properties Dialog Box

3 Select Properties from the File menu. Or, right-click on the Canon BJC-55
icon and select Properties from the pop-up menu. The Properties dialog
box opens. The Main, Page Layout, Stamp/Background, and Maintenance
tabs are contained in the Printer Properties dialog box.

Canon BJC-55 Properties

@Page\_ayoul I Slamp.‘Backglound | m Maintenance |
eriera Detals | ColorMenagement | & Main

Separator page: |[none| hd Browse...

Print Test Page

ok | caeel ||z | HR

Note p When you open the Printer Properties dialog box from the Start menu,
some other tabs (such as General and Details) are added by the Windows
operating system. For more details on these additional tabs, refer to your
Windows documentation.
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Selecting the Print Mode

The following default Print Mode settings are available:

This Print Mode selects standard quality for documents that contain only
word processed text. Use this setting when you have either the BC-10
Black or BC-11e Color BJ Cartridge installed and you are using plain

paper.
@ This Print Mode is for faster printing with slight loss in quality to print
oan  drafts for proofreading and checking; this setting consumes less ink.

Use this setting when you have either the BC-10 Black or BC-11e Color
BJ Cartridge installed and you are using plain paper.

This Print Mode produces standard quality for documents that contain a
mixture of text, graphics, photographs, and illustrations. Print quality is
adjusted automatically by recognition of what is on the page (text,
photograph). Use this setting when you have either the BC-10 Black or
BC-11e Color BJ Cartridge installed and you are using plain paper.

This Print Mode is a good choice for color photographs or any type of
image with gradations of color. It provides high quality printing with
the BC-11e Color BJ Cartridge.

#t  This Print Mode is the best choice for photographs or any type of graphic
w0 jmage with a wide range of gradations in color tone. It provides the best
quality printing with a BC-12e Photo BJ Cartridge. High Resolution
Paper is automatically selected and recommended for printing with this
selection.
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Selecting the Print Mode
Specifying the Print Mode

1 Inthe Main tab of the printer Properties dialog box, choose one of the Print
Mode icons.

Canon BJC-55 Propeties HER

Main | Page Layout| Stamp/Background | Maintznznce |

Vi & B

Draft DTF  FPhola  Supefhola

|

Chosss Pint Mo eme

The name and Bl Cartiidge: | Color =| T Grayscale Print
icon for the MediaTyper [ Plan Paper =l

current setting

Page Size: Letter
are displayed Diertlon Porvat
he re. Printing T ppe: Nemmnalsize Piinting
#)Diectiors  Porhait
Feed: Manual Feed S Nore
Background None
adyanced.. | Aok | pears |

0K | Coed | il | He |
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Selecting the Print Mode

Make sure that the BJ Cartridge and Media Type settings are correct for
the BJ cartridge and paper installed in the printer. If necessary, use the

pull-down menus to change the settings.

Canon BJC-55 Propertie:

Main | Paga Laout | Stamp/Backaround | Maintenance |

c i Mode:

5 i
=

Standard

e
Draft

DTP Photo  SuperPhato
¥
C_ X ) O C_C J
B Cartiidge: Color [ ‘r Giravscale Print
===\
‘ Media Type: | Plain Paper =]
- S eSSy J—
& Letter
- Portrait
A

Nermaksize Pinking

Stamp None
Background, Mane
adyanced. | About | Defaits |

T I A
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Selecting the Print Mode

B Adjusting and Saving Print Mode Settings

If you change any of the default settings, you see the words “User-Modified” displayed
below the icon.

Canon BJC-55 Properties HE

Main | Page Layout | Stamp/Backaound | Maintenancs |

P i I
SN
| BV

o | S Dt
\ USE"mUd‘f‘Ed]/ Selects gplimum sellings for test printing, | =
h,‘ | Color j ™ Grayscale Print

Media Type:

Page Size: Letter

Orientation: Portrait
Printing Type: Normal-size Printing
A) Direction:  Partrait
Feed. Marwal Feed Stamp Mane
Background: None:
pdgroed. | apow. | o |

06 | Cawel | b | Hen |

You can print with the modified setting(s) one time (the defaults are restored immediately
after the print job executes). If you intend to use these settings often, you can save the new
print mode, and then select it easily the next time.
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Selecting the Print Mode

To save a new print mode

1 After changing the setting(s), right-click the User-modified icon and select
Save As from the pop-up menu.

Canon BJC-55 Properties

Main | Page Layout | Stamp/Backgeund | Maintenancs |

VB

NeLZ: |
\NZ23=N
?}\ =

L e &) ~| ™ Grayscale Print
v EE—]

Duaft

Page Size Letter
Drientation: Portrait
Fatmips MR
#) Diection.  Parti
e S e
Bgont e
adgrced.. | apor. | petas |

0 | Ceed | b | Heb |
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Selecting the Print Mode

2 Click the Title box and enter a name for the Print Mode settings.

“Untitled" Propertiss
Quality | SpecialEffects | Color  Save |

Saved Settings:

3 Click the Save button and click the OK button.
The new print mode is saved and the settings are enabled as the current
settings.
To remove a print mode

71 Inthe Choose Print Mode panel, right-click the icon that you want to delete
and select Delete from the pop-up menu.

2 When the message asks you to confirm that you want to delete the print
mode, click the OK button.
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Changing the Page Size

You usually select the page size with a setting in your software application.

The first time that you execute a print job, follow the procedure below to confirm that the
page size setting in the software application is the same in the printer driver. If the settings
are not the same, select the correct page size in the printer driver.

1 Open the printer driver and select the Page Layout tab.

Canon BJC-55 Properties HE

-y
Main @[ Page Layout | Wamp/Background | Mairtenance |
-

3
Draft DTP Photo  SuperPhota

H

Choose Print Modg:

&
Standard

al
BJ Cartridge: Color = | ™ Grayscals Print

bediaType:  [Plan Paper =l

Page Size: Letter

Orientatior: Portrait
Pinting Type: Normalsize Printing
) Ditection:  Portrait
Feed Manual Feed Stamp Nane
Background. Mone
Advanced.. | About.. | Defauls |

K| caned | s | Hen |
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Changing the Page Size

2 If the Page Size setting is not the same as the setting in the software
application, click the down-arrow and select the correct page size from the

drop-down list.

Canon BJC-55 Properties

Main  PagsLayout | Stamp/Backgound | Mantenance |

Pand S

— Page Sige:
ET| 0 -
g Letter 050 1100 1, (i}‘
B -

-

" Buooklet Printing
" Paster Printing

i&, Ffitter Rener Siee
Letter 850 11.00in =
(]
¥ Background Printing , 21 Regersecrder

coess [T 3 50 | cotae
™ Duplzy Printing: '(' Long:side stapling) ) Shart-s1e stanlng
l" Binercoriol. | Defats |
§
\ < i ‘I Zancel Apply Help

This example shows Letter selected. After making your selection, click the
OK button.

Note Make sure the paper you load in the printer is the same size you select in
the printer driver. If the size of paper in the printer and the Page Size setting

do not match, the printer cannot execute your print job normally.
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Using Online Help

When you want to learn about a particular topic, the online help function provides the
necessary information on the screen of your computer.

B Finding Information on a Particular Topic

1 When you click the “?” button on the upper right corner of the Printer

Properties dialog box, the shape of the mouse pointer changes to “ [3? ».

2 Click the desired item to learn more about the item. A detailed explanation
appears.

Canon BJC-55 Properties [7] Canon BJC-55 Properties [x]
Main | Page Layout | Stamp/Backgiound | Mairtenance | Main | Page Layout | Stamp/Backgiound | Maintenance |
Choase Print Mode: Choose Print Mode:
0
g Aprint mode registers a combination of print guality and
Standard Dt DTF Fhoto  SupsiFhoto o iy g print quality Fhoto  SupsiPhata
k! _’I Wihen vou selectthe icon thatis the closestto the ﬂ
l—_[ ) docurnent or purpose, the system automatically sets the G o
ERESC Color | \_fGeveca g # recommended [BJ Cartridge] and [Media Type]. taycals Fin
= Ifthe selections are different frorm the iterns that hawve —
Media Type |F\am Paper J actually been setin the printer, correct the [BJ Cartridge]
and [Media Type] settings so that they match the printer
Pags Size Latter el o e U B Letts
Orientation: Portrait To specify settings for other print modes, selecttheicon Portrait
Piinting Type: Tk FieE fh”f[é"uumfalﬁg"[g”nﬁ ta]h”S”“”” Checkine contents of Nowmalsizz Prirting
The setlings can also be changed from these tabs.
A) Direction:  Portrait
Feed Manual Feed Stamp None Feed Matwial Feed Stamp: None
Background: None Backgiound: None:
advarced. | About | Defaks | e | oemis |

0K I Cancel | Sl | Help | Ok I Cancel | Ll | Help |
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Using Online Help

B Finding Information on an Operation Procedure

1 Click the Help button on the lower right corner of the Printer Properties
dialog box.

2 When the contents of the Canon BJ Printer Driver Help are displayed,
select the desired item to learn more about that item.

Canon BJC-55 Properties B B3 Help Topics: Canon BJ Printer Driver 7] ]
Main |Fage Layoull SlamprackgroundI Ma\ntenancel Contents | Index | Find |
Choose Print Mode:
Click a book, and then click Open. Or click another tab, such as Index.
- b
& e
Standard £ Photo  SuperPhoto @ BJ Printer Driver
i A @ Basic Printing Settings
EJ Cartridge: ICo\m ~| I Giapscals Print # 0 Color Alignment Settings
0 Additional Features
Ll g |Plam Paper j 0 Printer Maintenance
Pags Gize: Letter 0 Troubleshooting
0 BJ Background Monitor
Orientation: Partrait 0 B Status Monit
atus Monitar
Printing Type: Mormal-size Printing 0 B.J Printer Manitor
A) Ditsstion:  Portait @ Notes for Each Model
Feed: Marual Feed Stemps: e
Background; None
advarced.. | ppout | oeaus |
oK I Cared] I Apply | Help | Open I Print.... Cancel
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Using Online Help

B Closing the Printer Properties Dialog Box

After specifying the necessary print settings, close the Printer Properties dialog box and
start your print job.

1 Make sure that the information on Direction and Feed in the illustrated
guideline is correct.

BJ Cartridge IEDIOI *| I Grayscale Print
Media Type IF‘\ain Paper d

Page Size: Letter
Origntation: Portrait

Printing Type: Marmal-size Printing

lllustrated guideline

A] Direction:  Portrait

Feed Manual Feed S WNone

B ackground: Mone

Advanced | About | Defaults |

ok | Cancel | ey [T

2 Click the OK button. The print settings become enabled and the Printer
Properties dialog box closes.

Note p * When you want to enable the print settings without closing the Printer
Properties dialog box, click the Apply button.

* When you do not want to enable the print settings, click the Cancel
button.

* When you want to revert the print settings to the factory settings, click
the Defaults button in each tab.
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Windows Printer Driver Features

The printer Properties dialog box has four tabs with buttons and check boxes you use to set

up a print job.
B Main Tab

0o -
o

e—— pdneed. | mpow. | Do |

@ Choose Print Mode

Canon BJC-55 Properties

Main | PageLayout | Stamp/Backaiound | Maintenancs |

Choose Frint Mode,

o

Pholo  SuperPhoto

Standard
|
BJ Cartiidge: Color ~| T Grayscale Print
| |
Media Tys:|Flain Paper =

Page Size: Letter

Orientation: Portrait
Printing Type: Normalsize Printing
A) Directior: Portrait
Feed: Maruial Feed Stan: Nore
Background Nore

K| Gl | s || Hee |

o O

® Selecting the Print Mode

Printing With Windows 98 or Windows CE

The Print Mode icons hold the default settings for a
variety of common print jobs.
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€@ Current Settings
R

Phato
Uzer-modified)

Ma infa

6 BJ Cartridge

O Grayscale Print

6 Media Type

Windows Printer Driver Feat

Displays the currently selected icon.

If you change any setting for a default icon, the
“User-Modified” notation is displayed below the icon
in the Current Settings box. You can use the current
settings to execute the next print job, or you can
register the settings as a new print mode.

If the currently selected icon has just been deleted,
the “No Info” notation is displayed. In this case, click
another icon to select it.

Select a BJ cartridge from the drop-down list. Select
Black, Color, or Photo.

Check the box [v to print a color image in
grayscale. When Grayscale Print is off, color images
are printed in color.

Select a Media Type from the drop-down list.

Printing With Windows 98 or Windows CE
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G lllustrated guideline

0 About...
e Drefaultz

Windows Printer Driver Features

The (A) graphic displays the current selections for
the Orientation and Paper Feed method.

The Page Size, Orientation, and other settings
change to reflect the settings on the Page Layout
tab.

B Page Layout Tab
If you select an envelope setting (#10 Env. or DL
Env.), Orientation is automatically set for Portrait.

The Paper Feed method for this printer is always
Manual Feed.

Click the Advanced button to customize the current
Print Mode. You will see the Print Mode Properties
dialog box.

® Print Mode Properties Dialog Box

Displays the version number of the printer driver and
the copyright information.

Restores all settings to their default settings.
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Windows Printer Driver Features

B Page Layout Tab

Canon BJC-55 Properties HE

Main  Page Layout |Slampra\:kgruund| Maintenance |

= etter ool w11 UL In

— Oneniaton e
= & Paitait € Landscape
_—————— Printing Type:

e e & Normalsize Printing
e € Scaled Printing

" Page Layout Printing
" Booklet Printing
" Poster Printing

= [eres0amromn = o
e ¥ Backaround Printing a
5532 [ Reverse order
————— LCopies: 1 } ™ Coltt e
@4 Duplex Frinting: @) lcrpside st ) SHortside stagling

Printer contral... | Defaults | m
t

ok | Cencel |tk | HeR |

0 Page Size Usually the Page Size is set with the software
application. If the printer driver Page Size setting is
not the same as the page size selected by the
software application, you must change it here. Click
the down-arrow and select the correct page size
from the drop-down list.

B Changing the Page Size

a Orientation Click either radio button to select an Orientation.
Portrait For normal printing
Landscape  For documents rotated 90 degrees
for printing

Printing With Windows 98 or Windows CE 115



6 Printing Type

0 Printer Paper Size

Q Preview area

Windows Printer Driver Features

Click the appropriate radio button to select how you
want to lay out the print job. You'll want to select
“Normal-size Printing” for most print jobs.

® Printing Type Settings

Printing Type:
& Maomal-size Printing
" Scaled Printing
" Page Layout Printing
" Booklet Printing
" Paster Printing

Allows you to select the size of the paper loaded in
the printer after you have selected Scaled, Page
Layout, Booklet, or Poster Printing. Click the down-
arrow and select a paper size from the drop-down
list. If the size selected for the Printer Paper Size is
not the same as the size selected for Paper Size
above, then the printed document is enlarged or
reduced as required to fit the size of the paper in the
printer.

Allows you to preview how the printed document will
appear before executing the print job. If you have
selected a stamp or artistic background for the
document, you can preview how these will appear.
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Windows Printer Driver Features

e Background Printing  Allows printing jobs to execute in the background

€ Copies

0 Reverse Order

Q Collate

while you perform tasks with other software
applications. Background Printing is normally
enabled to allow you to use all of the features on the
Page Layout tab. Click the Background Printing box
to turn this feature on and off.

Tip: The following features are not available
when Background Printing is off: Copies,
Reverse order, Collate, Duplex Printing,

Long side stapling, Short side stapling, Page
Layout Printing, Booklet Printing, Poster Printing,
Printer Paper Size.

Enter the number of copies (1 to 999) that you want
to print.

Prints sequentially from the last page to the first so
the copies are stacked in order as they are printed.

Ensures that each copy of the document is printed

one at a time and in the correct page order, 5, 4, 3,
2, 1 if you selected Reverse Order, or 1, 2, 3, 4, 5 if
you did not select Reverse Order. When this feature
is off, the specified number of copies for each page
(1,1,1, 2,2, 2) is printed.
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@ Duplex Printing

®

Frinter contral...

Windows Printer Driver Features

Selects whether each sheet is printed on both sides
(front and back). Click the check box to turn this
feature on and off.

After you click the check box, you can select the
binding method, which leaves extra space on the
margin for stapling. Click the appropriate radio
button for the side where you want to bind the
document.

{* Long side stapling
¥ Short side stapling

Tip: When you set up a print job for Duplex
Printing, check the Media Type settings on the
Main tab and make sure Plain Paper is selected.

® Using Duplex Printing

Click this button to open the Printer Control dialog
box.

Ok I Cancel Defaults Help |
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Windows Printer Driver Features

@ Printer setup Click this box to conduct printer setup while the print
during spooling job is spooling. The printer will be ready to print as
soon as data is sent to the printer after spooling is
complete. Otherwise, the print job spools; after
spooling is complete and the print data is sent to the
printer, printer setup begins.

Using Duplex Printing

You can print a document with printing on both sides of each sheet and
specify the size of the margin for binding the left side or top of the printed
document.

W FLOWERS Eg — FLOWERS
% FLq 4FRs| Y ¥ FLOWERS| |¥ ¥
|

% vy Y‘Y

Wm LUE

SAOOM

Long side Back Short side Back
Stapling Stapling
Note P You can execute duplex printing only with plain paper or Canon Bubble

Jet paper. If the document contains dense color images, which require a
large amount of ink to print, you may not be able to use Duplex Printing
because the ink will show on the other side of the page.
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Note P

Canon BJC-55 Properties

Main  Page Layout | Stamp/Backaound | Maintenance |

o] Fage Size:

== | etter §.50 x 11.00 10

]

' Gl
o FimFm i
= emasorron =

Windows Printer Driver Features

Orie
& Porralt

© Landscape
Prirting Type:

% Mormal-size Printing

™ Sealed Printing

" Page Lapout Frinting

£ Bocklet Printing

I¥ Background Printing

@32 ™ Reyerse order
: I~ Colate

I £ Longsside staping__ " Shortsie staping I

Binercaniel. | Defaus |

o]

el | ook | Heb |

7 On the Page Layout tab, click the Duplex Printing box.

2 For the binding method, click the button for “Long side stapling” or “Short

side stapling.”

When you execute Duplex Printing, you must print one side, and then set
the ejected page back in the sheet feeder to print on the other side. When
the print job starts, the first side prints. Follow the instructions on screen to
load the printed sheet and click the OK button to print on the other side.
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Windows Printer Driver Features
B Printing Type Settings
You make the Printing Type settings on the Page Layout tab.

Normal-size Printing

Canon BJC-55 Properties [ 7] x]

Man  Page Layout | StamprBackground | Maintenance |

= | 00in

Orientation:  (* Partrajt ' Landscape

Frinting Type:
@ Mormak Prirting 0

" Scaled Printing

" Page Layout Printing
"~ Booklet Printing
= Paoster Printing

b, Printer Paper Size:
JLetier B.50: 11,0010 =

¥ Background Printin
o O 93T Feverse orer
Copies: 1 : ™ Collate

™ Duplex Printing ¥ Long-side stapling € Short-side stapling

Erinter contral.. | Defaults |

ok | Cencel |ty | Hep |

0 Normal-size Printing Prints the document at normal size without
enlargement or reduction. After using Scaled, Page
Layout, Booklet, or Poster Printing, click this radio
button ¢ to restore normal size printing.
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Windows Printer Driver Features

Scaled Printing

Scaled Printing allows you to automatically enlarge or reduce the size of the printed page
by loading larger or smaller paper in the printer and changing the Printer Paper Size setting.

Canon BJC-55 Properties
Main  Page Lapout | Slamp/Backgloundl Ma\nlenancel

Page Size:

g Letter .50 % 11.00#0 b

Orientation: & Partrajt " Landscape

Sealing:

oo g

(]

£ Booklet Printing

" Poster Printing

s, Plinter Paper Size:
[Letter 8504 11.001n |

¥ Backoround Pinfi
NN AT <32 I Reverse order
Copies. [T 3 R4 Cglate

™ Duplex Printing % Long-side stapling & Short-side stapling

Brercortiol. | Detsus |

0k | cencel | seew | Hee |

0 Scaled Printing Click this radio button & to enable scaled printing.
After you click this button, the Scaling spinbox
appears on the right.

9 Scaling Enter a number directly into the entry box or use the
arrows on the spinbox to set the percentage of
enlargement or reduction. You can enter a number
within the range 10 to 400%.

Printing With Windows 98 or Windows CE 122



Windows Printer Driver Features

Page Layout Printing

Use Page Layout Printing to print two or four pages at reduced size on one sheet of paper.
This printing method not only saves paper, it is also useful for printing double-page pictures
or charts, and printing pages for binding.

Canon BJC-55 Properties 2 x]

Main  Pags Layout | Stamp/Background | Mainenance |

Page Size:
o iz
el Letier 8.50 % 11.00in =

Orientafion: & Potrst € Landscape

o

Frinting Type:

© Nomnal-size Printing

. £ Soaled Prining
—'—@G‘ Page Lapout PnntlrI Specify. e

/‘ —  Booklet Printing
0 " Paster Printing
= Printer Paper Size: Page Layout Printing HE
Letier 850 4 11.00in 2
__I Pages: 2P 70
IV Background Printin
o : o2 ™ Reverse oder P Fage Orcer
Coes [1 B 82U Colae 470
™ Dupley Printing: & Long-side stapiing ¢ Short-side stapling
' o
Binercortol. | Defaks | I Frams Border e
T ccel | b | e | o | concel | Deaws | Hep |

0 Page Layout Printing Allows you to print 2 or 4 document pages on the
same sheet. Click this radio button ) to enable
Page Layout Printing. After you click the button, the
Specify button appears on the right.

Click this button to open the Page Layout Printing
dialog box.

12

6 Pages Select the number of pages that you want to print on
one sheet.
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0 Page Order

e Frame Border

Windows Printer Driver Features

Select the order in which you want the pages to print
on the sheet.

Click the check box to print a frame border around

each document page.

Booklet Printing

Booklet Printing is a special feature of Two-sided Printing. The pages are printed four to a
sheet (two pages each on front and back) and ordered in such a way that the pages will be
numbered consecutively after they are folded together and bound.

Canon BJC-55 Properties

Man  PageLayout | StampBackground | Maintenance |

Paga Size:

Orientation:  (* Potrait
Pinting T ppe:

€ Scaled Printing

Letter 850 % 11.00#n

€ Momaksize Printing

" Landscape

s -(' Page Lagout Prirt
£ Bookdel Piriing ﬂl
0/ € Poster Printing
4 Printer Paper Size;
7 e 50,11.00m al

¥ Background Prirting

A

™ Dupley Printing:

3 T Reverse order
T Colate

LCopies:

@ Long-side stapling ¢ Short-sids stapling

2]

Booklet Printing

Insert blank page: None

¥ Staple left side
* Stapling margi:

Printer contral.

Defaults |

0.2 E inch
I™ Freme Bordes

-0

o

oK | cancel |

Apply |

Hep |

@ Booklet Printing

[on | concel | pes | ep |

Click this radio button ' to enable Booklet Printing.

After you you click the button, the Specify button
appears on the right.

2]

box.
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6 Insert blank page

0 Staple left side

@ Stapling margin

G Frame Border

Windows Printer Driver Features

Determines how pages are arranged.

None All pages printed in order with no
blank pages inserted

Right page  Right pages printed as blank pages
Left page Left pages printed as blank pages
Tip: For @ and @ the settings may change

depending on the Page Size and Orientation
settings.

Select the side where the printed document is to be
stapled. Click this check box to print the pages for
stapling on the left side.

Enter a number to set the width of the stapling
margin, measured from the center of the page.

Click the check box to print a frame border around
each document page.
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Poster Printing

Windows Printer Driver Features

Poster Printing allows you to print an original enlarged to print on 4, 9, or 16 sheets. You
can then cut along the marks that print on the page margins and paste or tape the sheets
together to form one large poster.

Canon BJC-55 Properties

2]
Main  Page Layout | StampBackaround | Maintenance |
_ElJ Page Size:
== |Letter 850 11.000n hd

Oriertation: & Porat " Landscape
Prirting Type:
€ Nomaksize Printing

€ Scaled Printing

U € Page Layout Printing
€ Booklet Fiinting

5 Puoster Frinting

Specify.

2]

4]

¢ Printer Paper Size: Poster Printing [7]x]
¥ [t 850, 11.00m =l
Bﬂ Image divisions
¥ Backgiound Prinfin 8y
oo é G2 T Reerce xder —
Copies: |1 ST calate > eH
v Codnd
I Duplex Printing: @ Long-side stapling ¢ Short-side stapling
[V Print "Cut/Paste" in marging
Prirter contral, | Defaults | [V Piint "Cut/Paste" ines in margins 76
O | e | b | e | [0 | conel | Detmts | meb |

c Poster Printing

2]

Enlarges the original image then divides and prints it
onto the number of sheets that you specify. The
printed sheets can be assembled to form one large

poster.

Click this button to open the Poster Printing dialog

box.
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@ 'mage divisions

@ Frint “Cut/Paste’
in margins

Q Print “Cut/Paste”
lines in margins

G Preview area
This page not printed

Fuint all pages
Lelete al pages

Help

Windows Printer Driver Features

Click the radio button to select the number of pages
for the image to be printed on.

+1 2 x 2 Total of 4 pages print
&+ 3 x 3 Total of 9 pages print
*1 4 x 4 Total of 16 pages print

Tip: The greater the number of pages, the larger
the poster.

Click the check box to print “Cut” or “Paste” in the
margins to be used as guidelines when assembling
the poster.

Click the check box to print dotted lines in the
margins to be used as guidelines when assembling
the poster.

* In the preview area, click any page to de-select it
for printing. Pages with artistic backgrounds are
not printed.

* Right-click the preview area to open the pop-up

menu and select “Print all pages” to print all pages.

* Right-click the preview area to open the pop-up
menu and select “Delete all pages” to delete all the
pages.

Printing With Windows 98 or Windows CE
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B Stamp/Background Tab

Windows Printer Driver Features

A selection of default stamps (IMPORTANT, CONFIDENTIAL, etc.) are available for
immediate use, or you can create your own stamps in bold color with borders.

You can also print a colorful bitmap file behind text as a background to create an artistic
effect. By adjusting the density of the background printing, you can experiment with a

variety of effects.

Canon BJC-55 Properties

Main | Page Layout Stamnfﬁackglwnd|Maintenance

I™ Place stamp over text

™ Gtamp first page anly

Define Stamp. .

I™ Backaround first page only

Select Backgmound,

ok

Concel | b | Hep |

0 Stamp

e Place stamp over text

6 Stamp first page only

Select one of the default stamps from the drop-down

list.

Click this check box to print the selected stamp over
the underlying text on the document page.

Click this check box to print the stamp only on the

first page of the document.
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00

Define Stamp...

Background
Background first
page only

Select Background...

Preview area

Windows Printer Driver Features

Click this button to adjust the settings of the selected
stamp or to create a new stamp.

® Using the Stamp Settings Properties
Dialog Box

Select a background pattern from the drop-down list.

Click this check box to print the background only
on the first page of the document. Otherwise, the
background prints on every page of the document.

Click this button to adjust the settings for the
selected background or to create a new background.

® Using the Background Settings
Properties Dialog Box

The stamp and background that you select are
displayed in the preview area so you can see how
the page will appear after printing.
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B Using the Stamp Settings Properties Dialog Box

Click the Define Stamp button on the Stamp/Background tab to open the Stamp Settings

Properties dialog box. Use the Text, Color, Placement, and Save Setting tabs to create and
position a stamp for printing.

Note The screen below shows the “SECRET” stamp selected. If None is
selected under Stamp on the Stamp/Background tab, nothing is displayed
in the preview area after you click the Define Stamp button until you enter
some text for the new stamp in the Stamp Text box.

D & © ¢
@ Texttab Define the text and font of the
Tewt |coor | Placment| Save satis | stamp.
secer Q Color tab Specify the color of the stamp.

Q Placement tab Specify the position of the stamp.
0 Save settings Specify the name of the new

stamp.
|!§?+F Bold
- =1 i
W =l
[ ok | cancel | Hep |
Note } Use the online help to find out about each setting.
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B Using the Background Settings Properties Dialog Box

Click the Select Background button to open the Background Settings Properties dialog box.

Use this dialog box to select backgrounds for display. Two artistic backgrounds, Sample 1
and Sample 2, are provided.

Background Settings:[Sample 1] Properties

Layout Methad:

' Fil page

" Fit tn paper size

" Set position
PBosition

fffffffffff S 2 O
RPosition |_
F-Pasition: l—

Itizeti:
SelectFle. | Defauts |

0K | cancel | Hep |

0 Background tab Specify the file to use as the background, the layout
of the file, and the intensity.
e Save settings Specify the name of the new background.
Note p Use the online help to find out about each setting.
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B Maintenance Tab

Use the Maintenance tab to perform routine tasks like cleaning the print heads and
changing BJ tanks. To start a procedure, click an icon and, when a message is displayed,
click the OK button.

Canon BJC-55 Properties

Main | Page Layout | Stamp/Backgiound  Maintenance |

Print Head Cleaning Q @

Test Prints
w L

Powir J Q

Start Status Manitor LCustom Setting. e

prooee

ok | Cencel | ik | HeR |

ﬂ Print Head Cleaning Clean the print heads when the print quality is not
satisfactory.

$® Click to clean the print head

g Click to deep clean the print head
B Cleaning the Print Head
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Note P Deep cleaning the print heads consumes ink. Deep clean the print heads
only after consecutive print head cleanings fail to improve the print quality.

e Test Prints

@ Change BJ Tank

Click this button to print the Nozzle Check
Pattern; use this test print to check the
condition of the print heads

® Printing a Nozzle Check Pattern

Click the appropriate icon when you need to replace
a BJ tank.

a® Replace the black BJ tank in the BC-10 Black
BJ Cartridge

ﬂ Replace the color BJ tank in the BC-11e Color
BJ Cartridge or BC-12e Photo BJ Cartridge

Replace the black BJ tank in the BC-11e Color
BJ Cartridge or BC-12e Photo BJ Cartridge

Replace both black and color BJ tanks in the
BC-11e Color BJ Cartridge or BC-12e Photo
BJ Cartridge

® Replacing BJ Tanks
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0 Change BJ Cartridge Click the appropriate button when you need to

Q Power

e Start Status Monitor

replace a BJ cartridge.
| Install new BC-10 Black BJ Cartridge

8 Replace BC-11e Color BJ Cartridge or BC-12e
Photo BJ Cartridge

a9 Replace BC-10 Black BJ Cartridge

a2 Install a new BC-11e Color BJ Cartridge or
BC-12e Photo BJ Cartridge

® Changing or Replacing a BJ Cartridge

fm  Click to turn off power to the printer.
Click to open the Auto Power dialog box.

Auto Power EHE

At Power OFfF ISD min. j

Cancel | Defaults | Help |

Set the Auto Power Off time and click Send. The
printer will power-off if it does not receive data in this
amount of time.

Opens the BJ Printer Status Monitor.
® Using the BJ Printer Status Monitor
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Opens the Custom Setting dialog box.

™ Display low ink warming

Send | cancel | Deaus |

Shows a simple description of the curently selected feature

Click the check box to turn on the low-ink

alert and then click the Send button to enable
the setting on the printer.
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B Print Mode Properties Dialog Box

You open the Print Mode Properties dialog box by clicking the Advanced button on the Main
tab. The name of the currently selected print mode icon is displayed in the title bar
(Standard Properties, DTP Properties, etc.).

Quality tab

B [Standard] Properties

Print Quality:

ine
%ll' Image Optimizer

o
D I~ Phato Optimizer
= flifolePeze — | |
s

° oco

oK I Cancel | Help |

o BJ Cartridge Same as the BJ Cartridge option on the Main tab.
® Main Tab
9 Grayscale Print Same as the Grayscale Print option on the Main tab.
® Main Tab
e Media Type Same as the Media Type option on the Main tab.
® Main Tab
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O Paper Feed

© Frint Quality

Windows Printer Driver Features

Make sure the paper feed method is set to Manual
Feed.

Drag the button on the slide bar left or right to adjust
the quality of the printed image.

PFrint Quality

=3

Fast Fine

Slide the button to the right to print a better quality
image and slide to the left to increase printing speed
(quality may deteriorate slightly).
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e Halftoning

€ mage Optimizer

@ Photo Optimizer

Windows Printer Driver Features

Select one of the four methods to create mid-range
color tones for printing.

~ auwe  Automatically selects the most suitable
method for halftoning based on the colors in
the document.

Simplifies the halftoning process to achieve
high-speed printing.

Fire(Fast]

Creates sharper color boundaries.

Creates not only sharper boundaries but
also creates finer intermediate tones.

Diffugion

Smoothes photographic and graphic images by
removing jagged edges that tend to appear when an
image is enlarged for printing.

Allows you to adjust the color balance of images
captured with a digital camera.
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0 Whole Page

Windows Printer Driver Features

Allows you to adjust multiple graphic images on the
document page. This setting is available only when
the Photo Optimizer is enabled. Click the check box
to apply the Photo Optimizer option to the entire
page. Otherwise, the Photo Optimizer is applied
only to the graphic or photo images on the page.

Tip:

* Normally, click this check box off to apply the
Photo Optimizer only to graphic or photo
images. However, if the page(s) contain
trimmed or rotated images, click this check
box on.

* The Photo Optimizer can be used with
Background Printing.
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Special Effects tab

“Untitled" Properties HE

Qualty  Special Effects | Coiar | Save |

¥ Simulate liushratiors
| Contrast @ . ﬂ] ¢ o

o1 | T Monochiome Effects
ol & sepia
=1  Blue

] e e
" Green

 Select Calar
Coor 4] i

Defaus
0k | Cencel | Hep |

ﬂ Simulate lllustration  Enabling this feature converts a 256-color image so
it appears to be an illustration.

When Simulate lllustration is on, drag the button on
the slide bar left or right to set the Contrast to one of
the four settings.

Jal

o
Contrast B g o o
= ,_l I_ ke |

Set to the left for a darker image, or set to the right
for a brighter image.
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Note Pp

Windows Printer Driver Features

Tip: You can turn on Simulate lllustration feature
and then select one of the Monochrome Effects
below.

When the Background Printing option on the Page Layout tab is turned off,
all of the options on the Special Effects sheet are grayed out and disabled.

Q Monochrome Effects Enabling this feature converts a full-color image to a
single color for printing.

After clicking the check box, click the appropriate
button to select the color (Sepia, Blue, Pink, Green).

To create your own monochrome effect, click the
Select Color button and then drag the button on the
slide bar left or right to adjust the color, or click the
arrows on either end of the slide bar to adjust the
color.

The color is displayed
here as it is adjusted.

% Select Color I 5
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Color tab

“Untitled” Properties

Qualty | Special Effects Calor | Save |

Windows Printer Driver Features

I [T UseICH I

Color Balance

©

LCyan: o4

Magenta: 0 4

> |+ |~ |=

0
04

wellow:

Black:

Dutput Style: Ao =

Brightrigss Marmal ‘[

0000

sty i — &
Defaults
ok I Cancel | Help |

@ Color Adjustment

Click the check box to enable all the Color Balance

slide bars and options.

© UseiCMm

Tip: When the Color Adjustment box is checked,
the Color Balance, Output Style, and Brightness
features are enabled.

Click the check box to enable ICM (Image Color
Management) for Windows 98.
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@ Intensity

Windows Printer Driver Features

Tip:

* This check box appears only when the printer
driver has been installed for Windows 98. After
ICM is selected, all other options on the Color
tab (Color Balance, Output Style, Brightness)
are disabled.

* If you click the ICM check box on, make sure
that Background Printing is selected on the
Page/Layout tab. If Background Printing is off,
you may not be able to use other settings
correctly.

Drag the button on the slide bar left or right, or click
on the left or right side of the slide bar, to adjust the
Intensity (the amount of ink used in the print job).

Intensity: 0 _ﬂ]— B

Select a setting to the right for a darker image or the
left for a lighter image, with the range —50 to +50.
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0 Color Balance Drag the buttons on the slide bars to the left or right,
or click the arrows on either end of the slide bar, to
adjust the color balance for each printed color.

Color Balance

|

LCvan: 4

H

4

] 3
Magenta: a4 *
*ellow: 1} +

1}

@H

Black: 4 »

Color balance can be adjusted within the range —50
to +50. Slide the buttons to the left to lighten the
colors or to the right to darken the colors.

e Output Style Specifies how you prefer printed output to
emphasize intermediate tones or produce bright
primary colors for printed photographs and graphics.

Auto Automatically recognizes the type of
image data and selects the best
matching method.

Accurate  Accurately reproduces intermediate
tones such as skin, sky, and natural
green colors.

Vivid Prints bright primary colors for
computer business graphics, such as
line and bar charts.
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G Brightness Adjusts the contrast between intermediate tones
that fall between white and black (Normal, Light,
Dark, Very Dark). Adjusting the contrast from Light
(no correction) to Very Dark makes the overall image
brighter, with stronger contrast in the light areas and
lower contrast in dark areas.

Save tab

“Untitled” Properties EHE

Guality | Special Effests | Color  Save |

Saved Settings:

0_

e__

e_
e_,

e—‘ I Cancel | Help I

ﬂ Saved Settings panel Lists all the saved print mode icons and their names.
Select an icon here to edit or delete icons from the
panel. After you select an icon here, the Title and
Description are displayed below.
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@ Move icon buttons

O Title

O Icon Selection

@ Description

Windows Printer Driver Features

Allow you to change the order of appearance of the
print mode icons in the Choose Print Mode panel on
the Main tab.

ﬂ Select the icon in the Saved Settings panel and
== click this button to move it one position to the left
every time you click the button.

~y Select the icon in the Saved Settings panel and

== click this button to move it one position to the
right every time you click the button.

To save the current Quality and Color tab settings to
a new print mode setting, enter a title here. If you
select an icon in the Saved Settings panel, the title
of the selected icon is displayed here.

Select an icon from this panel to save with a new
print mode, or to change the icon of the print mode
currently selected in the Saved Settings panel.
Select a new icon here, click the Save As button,
and enter a new name for the icon.

If you are saving a new print mode icon, enter a
description that will identify the icon, or enter a new
comment for the icon selected in the Saved Settings
panel. Click the Save As button and enter a new
name for the icon. You can edit the description
displayed here.
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e Delete

e Save az..

0

Windows Printer Driver Features

Click this button to save all the tab settings (Quality,
Special Effects, Color) with the new selected icon
and description. You can then select the new print
mode from the Choose Print Mode panel on the
Main tab.

Deletes the icon selected in the Saved Settings
panel.

Tip: This button is grayed out and disabled if a
standard icon is selected.

Click this button to save an icon selected in the
Saved Settings panel under another name.

Tip: This button is grayed out and disabled if a
standard icon is selected.

Click this button to open a saved icon and restore it
to the Choose Print Mode panel on the Main tab so
it is available for selection.
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Using the BJ Background Monitor

The BJ Background Monitor allows you to monitor the progress of document print jobs
executing in the background. Use the BJ Background Monitor to view print jobs queued for
printing, remove them from the queue, or change the order of execution in the queue.

Note P * You can use the BJ Background Monitor to adjust background printing
priorities and to change the directory to store print data files temporarily.

* The BJ Background Monitor is available only when Background Printing
is checked on in the printer driver Page Layout tab.

B Opening the BJ Background Monitor

When the Background Printing option on the Page Layout tab is checked, the
BJ Background Monitor button will appear automatically in the Windows taskbar
when a print job starts.

To open the BJ Background Monitor, click the BJ Background Monitor
button in the taskbar.

| i Canon B4 Backaround Mo.. |25 CJRSTR  Amszon wioid

R start H EF D H ] Vacation Spots in Bolton -

gﬂ Canon BJ Background Mo.. |
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Using the BJ Background Monitor

The BJ Background Monitor opens and displays the names of the
documents queued for printing.

&P Canon BJ Background Monitor

JH[=] E3 .
Fis Edt Option Hep Drag the column boundaries
Application/Pint Docunent | Pagels)(Size) | Tme/Date ] left or right to adjust the width
E Amazon world dpagel1K)  1210:46 PM 07/15/2000 | of the columns for better
Annual Report 4page(51K] 12:11:48 PM 07/15/2000 viewing.
“acation Spats in Balton Spage(53K) 12:12:08 PM 07/15/2000
|

Application/Print Document

Displays the name of the document and application for each document in
the queue. The documents are listed in order of execution, and the
document currently printing is marked with the E icon.

Page(s) (Size)

Displays the number of pages in the document and the size of the file.
Time/Date

Displays the time and date that each document was selected for printing.
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B Changing the Print Order in the BJ Background Monitor
Note P * The print job that is currently printing cannot be removed from its
position at the head of the queue.

* While the order of execution is being changed, the current print job will
automatically pause temporarily.

1 Point to the name of the document that you want to move in the queue.

P Canon BJ Background Monitor M= e
File Edi Option Help

Application/Print 0 ocument IF‘age[s] (Size] IT\me/Date I

& Amazon World 4page(51K] 1210:46 PM 07/15/2000 =

Annual Fegort 4pagel5T1K) 12:11:48 PM 07/15/2001

2 Click and drag the document to the new position in the queue.

&P Canon BJ Background Monitor [_[OIX]
File Edit Option Help

[ bpplicationsPiint Dacument | Pagels) (Sizel | Tme/Date |

& Amazon world dpagel51K] 12:10:46 Pt 07/15/2000 :I

Printing With Windows 98 or Windows CE 150



Using the BJ Background Monitor

3 When you release the mouse button, the document will be in the new

& Canon BJ Background Monitor [_ O] ]
File Edit Option Help
Application/Print Document I Page(s] [Size] I Time/Date I
&, Amazon World dpage{51€) 12:10:46 PM 07/15/2000 =
Annusl Report Apage(51K) 12:11:48 PM 07/15/2000

B Cancelling a Print Job With the BJ Background Monitor

1 Click on the name of the print job you want to cancel.

& Canon BJ Background Monitor [_ O] <]
File Edit Option Help
| Application/Print Document I Page(s] (Size] I Time/Date I
IE Amazon world 4page(51K] 12:10:46 PM 07/15/2000 d
- - -
5
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2 From the Edit menu, select Delete.

T
ARl Hee
Z Dok o _
N o e @ Focumert | Pagels) (Size] | Tme/Date |

& Amazon World 4page{51K] 12:10:46 PM 07/15/2000 =l

Spage{53K] 12:12:08 Pr 07/15/2000

Annual Feport 4page{51K] 1211:48 PM 07/15/2000

A message asks you to confirm that you want to delete the print job.

3 Click the OK button to delete the print job.

Canon BJ Background Monitor

& Standing by for printing. OK. to delete?

The document is removed from the list.

P Canon BJ Background Monitor M= e
File Edit Option Help
Application/Print 0 ocument I Page(s) (Size) IT\me/Date I
& Amazon Wworld 4page(51K] 12:10:46 PM 07/15/2000 ;I
| -]
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B Closing the BJ Background Monitor
From the File menu, select Quit.

’_- gn BJ_Background Monitor =] B3
=x_pon BLE
e EX
>l
[
(SN, [Pagels)sizel [ Timesnate |
v End After Printing =

The BJ Background Monitor closes.

If you want the BJ Background Monitor to close automatically after the
last job is printed, from the File menu, select End After Printing. This feature

is enabled when End After Printing is marked with a check mark
in the menu.

& Canon BJ Background Monitor
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Using the BJ Backgrounder

While the BJ Backgrounder is displayed on the screen, you can use it to cancel or pause
the current print job.

Note P If several print jobs are queued in the background waiting to print, use the
BJ Background Monitor to cancel any print job, including the job currently
executing. You can also use the BJ Printer Status Monitor to cancel a print

job.
B Cancelling the Current Print Job With the BJ Backgrounder
1 Click the Cancel button of the BJ Backgrounder.

ZECJRSTR : Vacation Spots in B.... [HE B3

-
ancel
m o =
Pages: 1 /B
Copies: 1 P

A message will ask you to confirm that you want to cancel the print job.

2 Click the OK button to cancel the print job.

Canon BJ Backgrounder

& Cancel print job?
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Using the BJ Backgrounder

B Pausing a Print Job With the BJ Backgrounder
1 Click the Pause button on the BJ Backgrounder.

£ CIRSTR : Vacation Spots in B... [HJE B

Printing el
o o
- ( | Pause |} ,

Pages: 1 408
Copies. 1 Ao

The current print job pauses.

2 To restart the print job, click the Resume button.

#2 CJRSTR : Vacation Spots in B... [HJE B

Pauzing e
- ’ e

Pages: 1
Copies: 1

The current print job resumes printing.
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Using the BJ Printer Status Monitor

The BJ Printer Status Monitor displays the status of the current print job. If the printer runs
out of paper, if the paper jams, or if any other problems occur, the BJ Printer Status Monitor
will display a message that describes the problem.

Note } To use the BJ Printer Status Monitor with Windows, bi-directional
communication must be turned on.

Use this procedure to set the printer driver and enable bi-directional support.

1 Open the printer driver from the Start menu.

2 Click the Details tab and click the Spool Settings button.
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Using the BJ Printer Status Monitor

Click the button for “Enable bi-directional support for this printer” to enable
bi-directional support.

Spool Settings [ 2] %]

@ Spoal print jobs 50 program finishes printing Faster

 Start printing after last page is spooled
€& Start printing after first page is spooled
" Piint directy to the printer

Spool data format: | Rk’ j

& Enable bi-directional suppart for this printer
" Digable bi-directional support for this printer

ak. I Cancel Restore Defaults
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Using the BJ Printer Status Monitor

B Viewing the BJ Printer Status Monitor
The BJ Printer Status Monitor opens automatically every time a print job starts.

The screen below shows a print job executing normally:

3 Canon BJ Status Monitor - USBPRNO1 M=
Options  Port  Help

{Printer Status | Guide | Ink informati X X .
| ] rtitmsior| —— This area graphically displays the current status of
Prirter Name:  |Canon BJC-55 - USBPANT the printer and the progress of the print job.

Dacument Name:  |Uacument

Status:

— Displays the appropriate icon for the BJ cartridge
currently installed in the printer:

Printing. -

|
|

Start Time 4414/2000 2:42:35 P Color or Photo BJ Cartridge installed

s 1oo: |

Pages Printed: 1] Coned) Fiiniing

Cartridge: @ Black.

Lonink: — Hane Scanner Cartridge installed

@ Black BJ Cartridge installed

The BJ Printer Status Monitor closes automatically after the print job is
complete.

During a print job, you will see the BJ Printer Status Monitor button in the
taskbar.

| ol o) H ] Amazon Wold - Word___ I Canon BJ Backaiound Mo...| 51 CIRSTR : Amazonword |
£ICIRSTR : Amazon World
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Using the BJ Printer Status Monitor

Note P * To open the BJ Printer Status Monitor when a print job is not executing,
open the printer driver, select the Maintenance tab, and click the Start
Status Monitor button.

* If the “Display low ink warning” box is checked in the Custom Setting
dialog box, the Ink Information tab will be displayed in the BJ Printer
Status Monitor. To open the Custom Settings dialog box, click the
Custom Setting button on the Maintenance tab.
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Using the BJ Printer Status Monitor

B Handling Errors With the BJ Printer Status Monitor

If the printer runs out of paper, if the paper jams, or if any other type of problem occurs, the

BJ Printer Status Monitor will automatically open with a message displayed in its Printer
Status tab.

1 Look at the Status graphic display and read the message for a description
of the problem.

{§f} Canon BJ Status Monitor - USBPRNO1 9 =1

Opt Port  Help

| Guide: | Ink: information

Printer Name: |Eanon BJC-55 - USBPRNO1

Dacument Name:  [Dacument

Status:

The printer could not feed =
paper. Load paper into the

printer, then press the
RESUME button. If there is

Start Ti 4/14/2000 2:42:36 PM

Pages Printed. a

Cartridge: @ Black

Lowt Ink: Mane

If you want to cancel the print job, click the Cancel Printing button. When

the message asks you to confirm that you want to cancel the print job, click
the OK button.
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Using the BJ Printer Status Monitor

2 Click the Guide tab to display a solution for the problem.

(i Canon BJ Status Monitor - USBPRNO1 _ =] ]
DOptions  Port Help

Frirter Status Ink infarmation |

Load paper into the printer. If there iz paper loaded already,
remave and reload it. [Mext]

<Eack| Nexts

If the Next button is enabled, click it to display the next page of the text that
will guide you to a solution for the problem.

Click the Back button to return to the previous display.

3 Follow the step-by-step instructions on the screen to solve the problem.

After you have corrected the problem, the print job will re-start
automatically.
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Using the BJ Printer Status Monitor

B Setting the BJ Printer Status Monitor Display for Every Print Job

If you want the BJ Printer Status Monitor to open for every print job, select “Always Display
Current Job” from the Options menu. When this command is marked with a check mark in
the menu, the BJ Printer Status Monitor will open for every job, not only when an error
occurs.

For more details about the BJ Status Monitor, click the Help button in the BJ Printer Status
Monitor menu bar and select Help Topics to open online Help for the BJ Printer Status
Monitor.

B BJ Printer Status Monitor Low-Ink Alert

When the ink supply runs low in a BJ tank, the BJ Printer Status Monitor will open and
display a low-ink alert message.

1 Look at the Status graphic display and read the message for a description
of the problem.

@ Canon BJ Status Monitor - USBPRNO1 9 [

Options  Portt Help

SfarTime:

Frogess: i3

PagesPrinted o

Cartridge: Color [BC-11e]
Low Ink: DD@D Icon of the BJ tank(s) that is low.
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Using the BJ Printer Status Monitor

2 Click the Ink Information tab to display more details about the BJ tanks.

@) Canon BJ Status Monitor - USBPRND1 _ =] ]
Fort Help

DOptions

color BJ cartridge

1) The fallowing ink is running lov
Black

Colar

3 Follow the step-by-step instructions on the screen to solve the problem.

After you have corrected the problem, the print job will re-start
automatically.

Note P If the low ink alert is grayed out, or if the Ink Information tab is not visible,
open the printer driver, select the Maintenance tab, and click the Custom
Setting button. In the Custom Setting dialog box, click on the “Display low
ink warning” check box, and then click the Send button.
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Printing With Windows 2000

Printer Driver Basics

Opening the Printer Properties Dialog Box
Setting Up the Printer Driver

Using the Print Advisor

Using the Tabs

Using Online Help

Closing the Printer Properties Dialog Box
Windows 2000 Printer Driver Features
Making the Most of the Printer Driver

Using Maintenance Functions
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Printer Driver Basics

The printer driver is a program that converts text or image files you have created with an
application into print data and sends that data to the printer. The printer driver processes
print data so the printer can use it.

After you connect the printer to your computer, you must install the printer driver. For
instructions on installing the printer driver, see the Quick Start Guide.
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Opening the Printer Properties Dialog Box

To specify the print settings or use maintenance functions such as print head cleaning, you
must open the Printer Properties dialog box. There are two ways you can do this:

e From your software application

¢ From the Start menu

Note P This section describes the general procedures for opening the Printer
Properties dialog box. Depending on the application program you use,
different menu items may be used for printing. For more details, see the
documentation for your application program.

B From Your Application
You can open the Printer Properties dialog box from your application before printing.

1 Select the command used for printing (for example, Print or Print Setup
from the File menu) in your application.

2 Make sure Canon BJC-55 is selected in the Printer box.
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Opening the Printer Properties Dialog Box

If another printer name is displayed, click the down-arrow and then select
Canon BJC-55 from the drop-down list.

Print HE
i~ Printer
Mame: Properties I

Status: Default printer: leady
Type.  CanonBICSS
Where:  USEOD1

Comment: I~ Print ta file
-~ Print rang Copi
Al Number of copiss: [ =

" Pages from: [1 to I—
© Selection ™ Callate
Cancel

Click Properties.

The Canon BJC-55 Properties dialog box opens. Make sure the Main,
Page Setup, Effects, Profiles, and Maintenance tabs are displayed in the
dialog box.

& Canon BIC-55 Properties E 2ix|

Main | Page Setup | Eftects | Profiles | Maintenance |

B Cartidge:

I™ Don't Prink in Color

Media Type: Plain Paper S
Paper Source: | Manual Feed =

Print Quaity € High

@ Standard
 Draft

€ Custom Set
Y Color Adustment: & Auto
€ Manual Set
About Defauks
Cancel Help
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Opening the Printer Properties Dialog Box

B Directly From the Start Menu

To specify print settings that are common to all the applications you use, open the Canon
BJC-55 Printing Preferences dialog box from the Start menu.

This method is also helpful when you want to use maintenance functions such as print head
cleaning without starting up an application.

1 Click Start. Point to Settings, then click Printers.
2 When the Printer window is displayed, click the Canon BJC-55 icon.

3 Select Printing Preferences... from the File menu.

The Canon BJC-55 Printing Preferences dialog box opens. Make sure the
Main, Page Setup, Effects, Profiles, and Maintenance tabs are displayed in
the dialog box.

&% Canon BIC-55 Printing Preferences 21|
Mai ance |
BJ Cartridge:
=1
I™ Dontt Print in Color
Media Type: Plain Paper -
Paper Source: Manual Feed -
Print Quality:  High
@ (% Standard
 Dialt
" Custom et
| Color Adustment: 1 Auto
" Manual Set
About Default
0K | Ceneel | Hen |
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Setting Up the Printer Driver

Before you start a print job, open the Canon BJC-55 Properties or Canon BJC-55 Printing
Preferences dialog box and specify the printer driver settings for the print job. The easiest
way to do this is to use the Print Advisor, which will make the basic settings for you.
Alternatively, you can manually specify any setting you like with the different tabs in the
Printer Properties dialog box, allowing you fine control over such aspects as print quality
and color adjustment.
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Using the Print Advisor

The Print Advisor wizard takes you through a simple step-by-step question-and-answer
sequence to find out what kind of print job you want to do. Based on your responses, the
Print Advisor suggests how the printer driver should be set up to handle your print job, and
will automatically apply these settings if you're satisfied with them.

To use the Print Advisor, simply click Print Advisor on the Main tab of the Canon BJC-55
Properties or Canon BJC-55 Printing Preferences dialog box and then respond to the
questions that appear. After responding to each group of questions, click Next to go to the
next group. If you change your mind about anything, you can click Back to change your
previous responses.
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Using the Tabs

You can specify printer driver settings manually with the different tabs in the Printer
Properties dialog box.
B Specifying the BJ Cartridge and Media Type

For correct printing, it is important you match the BJ Cartridge and Media Type settings in
the printer driver with the BJ cartridge and print medium in the printer.

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Main tab.

%% Canon BIC-55 Properties 21X

Main | Page Setup' Effects' Pmli\esl Maintenancel

Bl Cartridge:
=T}
E | Colar j Detect. |

™ Don't Print in Color

MediaType: | Plain Paper =
Paper Source: IManuaI Feed j

Print Gluality, " High

@_. @ Standard
" Draft

" Custom Set |
| Color Adjustment: © Auto
 Manual Set..
Abaout Defaults |
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Note P

2

3

Using the Tabs

Click the down-arrow in the BJ Cartridge box and select the appropriate
cartridge specification from the drop-down list.

Click the down-arrow in the Media Type box and select the appropriate print
medium from the drop-down list.

It is possible to set BJ Cartridge automatically by clicking the Detect...
button on the Main tab. For this feature to work, your printer cable must
allow bi-directional communication and you must first open the Canon
BJC-55 Properties dialog box from the Start menu and check Enable
bi-directional support on the Ports tab.
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Using the Tabs

B Setting the Page Size
Set the page size you want to use from within your application before printing.

Also make sure the Page Size setting on the Page Setup tab of the Canon BJC-55
Properties or Canon BJC-55 Printing Preferences dialog box matches the paper size
setting in your application.

&® Canon BIC-55 Properties 2|

Man  Page Setup | Effects | Profiles | Maintenance |

I Scaled Printing
g Page Size: ILEttEf j
l:‘ + [ Scaling 100 = % (20400
5 Faper Size; ISama az Page Size j
Page Layout: IW-up Printing j
I™ Fiint Page Border
Letter Orientation: 5" Partrait (" Landscape
Actual-zize
1-up Frirtity
P J Copies: 1 3: [1-933)

[~ Reverse Order
I~ Collate

2
z
T E
g 1
1
1

Defaults |
Ok I Cancel | Help |
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Using the Tabs

Changing the page size
1 Click the Page Setup tab.

2 Click the down-arrow in the Page Size box, then select the appropriate size
from the drop-down list.

Setting a custom paper size
1 Click the Page Setup tab.

2 Click the down-arrow in the Page Size box, then select Custom... from the
drop-down list.

The Custom Paper Size dialog box opens.

Custom Paper Size 2=l

Units:  mm
& inches

Faper Size width: I 850 in[3.94-16.54)
Height: I 11.00 in[3.94-23.39)

QK I Cancel | Help

3 Select inches or millimeters as the units of measurement with the Units
radio buttons, and enter the desired height and width.

4 Click OK.
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Using the Tabs

B Confirming the Paper Source
You can set the Paper Source on the Main tab. The BJC-55 supports Manual Feed only.

&% Canon BIC-55 Printing Preferences 2lx|

Main | Page Setupl Effec:tsl F'rohlesl Malntenancel

BJ Cartridge:

=T
| Color j Detect...

™ Dant Print in Colar

Media Type: Plair Paper j

Paper Source:

Print Quality: " High

ﬂ : ' Standard
At  Diaft

' Custom et
; i Color Adjustment: @ Auto
& Frint Adwisor " Manual Set..
Abaout | Defaults |

QK I Cancel | Help |
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Using Online Help

To find out about a particular topic, use the online help function to display information on
your computer screen.

B Getting Information on a Particular Topic

1 Click ? at the top right of the Canon BJC-55 Properties or Canon BJC-55
Printing Preferences dialog box.

The mouse pointer changes to “?”.

2 Click the item you want to know more about.

A simple explanation appears.
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B Getting Information on an Operation Procedure

1

Using Online Help

Click Help at the bottom right of the Canon BJC-55 Properties or Canon

BJC-55 Printing Preferences dialog box.
An overview of the current tab appears.

Click any of the listed features to find out more about that feature.

< Canon BJ Printer Help

=1l x|

File Edit EBookmark Options Help

1ndex| Back | Pririt I

Main Tab

Basic printing is set up in the Main tab in accordance with the kind of the B1 Cartridge in the

printer and the media type, Unless special printing is done, normal printing can be carried out if
only the items on this tab are set.

Features

Basic Printing Setup
Easy Printing Setup with Print Adwisar

For an explanation of items on the setup screen...

Click on the 2l button at the right end of the title bar. Click on the item you want to see an
explanation for when the pointer changes to %?

Related features

Custom Print Quality Setup
Manual Color Adjustrment
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Closing the Printer Properties Dialog Box

After specifying the necessary print settings, close the Canon BJC-55 Properties or Canon
BJC-55 Printing Preferences dialog box and start your print job.

1 Make sure the printer is set up as shown in the graphic on the Main tab.

%% Canon BIC-55 Properties x|
Main | Page Setupl Effectsl F‘rofi\esl Maintenancel
BJ Cartridge:
=0}
| Calar j Detect |
™ Don't Piint in Color
Media Type: IF‘Iain Paper j
Paper Source: IManuaI Feed j
Print Quiality:  High
% Standard
S%f  Diraft
" Custom Sef..
| Color sdjustment: & Auto
& Print Adwizor. ..  Manual B
About | Defaults |
ak. I Cancel | Help |
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Closing the Printer Properties Dialog Box

2 Click OK.
The print settings are applied and the dialog box closes.

Note P » If you do not want to apply the print settings, click Cancel.

* To restore the print settings to their standard values, click Defaults on
each tab.
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Windows 2000 Printer Driver Features

B Main Tab

&% Canon B1C-55 Properties 21l

Main | Page Setupl Effeclsl Prufilasl Mainlenancal

B.J Cartridge: I c
=] |
| Color - Detect... |
™ Don't Frint in Color e
Media Type: IPIam FPaper _: e
Paper Source: IManuaI Feed _: e
Print Quality: " High ]
: (% Stardard e
S " Draft
(o Custom__| St
; ) i Color Adjustment: (G e
@ Frint Adwisar...  Manual Sef...

oK. I Cancel | Help |

0 BJ Cartridge Specify the type of BJ cartridge installed in the
printer. Select Black, Color, or Photo.

Click the Detect button to allow the printer driver
to detect the type of cartridge installed.
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g Don’t Print in Color

e Media Type
0 Paper Source
e Print Quality

@ Color Adjustment

@ !llustrated guideline

Q Print Advisor

Windows 2000 Printer Driver Features

Click this box to print a color document in
grayscale.

Select a Media Type from the drop-down list.

This must be Manual Feed.

Specify the print quality. Select High, Standard,
Draft, or Custom. If you select Custom, click the
Set button to specify unique settings.

B Changing the Print Quality/
Halftoning

Select Auto or Manual. If you select Manual,
click the Set button to specify unique settings.

® Adjusting Images

This graphic shows how to set up the printer to
match the current printing settings.

Click this button to use the Print Advisor to set
up your print job.

Printing With Windows 2000 181



B Page Setup Tab

%> Canon BIC-55 Propetties

Main  FPage Setup I Effectsl F'rofilesl Maintenancel

]

&
‘ Letter ‘

Actual-size
1-up Frinting

Windows 2000 Printer Driver Features

2lx]
[~ Scaled Printing
g Page Size: ILeller ;: e
+ [ Gcaling 100 = (20-400)
E Faper Size; ISame az Page Size _: o
Page Lapout: |1-up Pritting ;I

™ Frirt Page Barder

Origntation: f;' Partrait r' Landscape
Copies: I'I 3: [1-333)

™ Reverse Order
[T Collate

Y

|
Defaults i

® 000 0 00

QK. I Canecel | Help |

@ Scaled Printing

© Page Size

Click this box to enable scaled printing.

B Printing Enlarged and Reduced
Documents (Scaled Printing)

Select a page size from the drop-down list. This
page size must match the page size specified in
your software application.
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© Scaling

0 Paper Size

@ Page Layout

@ Orientation

€ Copies

0 Reverse Order

Q Collate

@ Defaults

Windows 2000 Printer Driver Features

Click this box to scale your print job. Then enter
the percentage of enlargement or reduction. You
can enter a number within the range 20 to
400%.

Specify the size of the paper loaded in the
printer. If the size selected for the Page Size is
not the same as the Paper Size, the printed
document is enlarged or reduced as required to
fit the size of the paper in the printer.

Specify how the document pages are to be laid
out on each sheet. When you print more than
one page per sheet, you can specify a border.

Click either radio button to select an Orientation:
* Portrait For normal printing

* Landscape For documents rotated 90
degrees for printing

Enter the number of copies (1 to 999) that you
want to print.

Click to print a multi-page document in reverse
order.

When printing multiple copies, click here to
collate each copy.

Click this button to reset each setting to its
default value.
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B Effects Tab

&% Canon BIC-55 Properties

Main | Page Setup Effects | F'rofilesl Maintenancel

‘ Effects:0OFF

Windows 2000 Printer Driver Features

211

[ Simulate lustration

Contrast: @

[ Monochrome Effects:

{* Gepia ) Blue
) Pink " Green
! Select Color 1
Calar: ﬂ j
‘ I:‘ [ Image Optimizer e
[ Photo Optimizer e
I &pply Throughout Page
Defaults I| e
0K I Cancel Help

0 Simulate lllustration  Click here to make a photographic image look
like a hand-drawn illustration.

© Contrast

Use to adjust the simulated illustration making it

lighter or darker.
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Windows 2000 Printer Driver Features

6 Monochrome Effects Click here to print the document as a single

0 Image Optimizer

@ Photo Optimizer

Q Defaults

color. Choose one of the listed colors, or click
Select Color to specify a color from the color
bar.

Click to smooth jagged edges; this is particularly
effective with low-resolution images.

Click to correct the color of digital camera
images and scanned images. Click the “Apply
Throughout Page” box to treat the whole page
as a single image; otherwise, images are
treated individually.

Click to reset all settings to their defaults.
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B Profiles Tab

&% Canon BIC-55 Properties

Main |PageSetup Effects Frofiles Maintenancel

Frinting Profiles:

E [refault Settings

Windows 2000 Printer Driver Features

el

Details:

Parameter | Setting -

BJ Cartridge Color

Dron't Print in Caolar OFF

Media Type Plain Paper

Paper Source M anual Feed

Print Guality Standard oo

Color Adjustment Auto

Scaled Printing QOFF

Fage Size Customn..

Paper Size Same as Page Size

Scaling OFF =
Drescription:

Current Settings displayed. Click Add to Profiles... to add these ;I

print settings to Printing Profiles. e

=

Add to Profiles.. Fietrieve fram Prafiles Delete |

ok I Cancel Help

ﬂ Printing Profiles

© Details

O O O

Lists the names of all printing profiles available
for selection and their associated icons.

Indicates the settings associated with the
selected Printing Profiles list.
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6 Description

O Add to Profiles...

Retrieve from
Profiles

@ Delete

Windows 2000 Printer Driver Features

Describes the Printing Profiles list. You entered
this description when you created the Printing
Profiles list.

Click here to save the settings currently
associated with the printer driver tabs as a
Printing Profile. You give the profile a name,
icon, and description.

Click here to retrieve an existing Printing Profile.

Click here to delete the selected Printing Profile.

Printing With Windows 2000 187



Windows 2000 Printer Driver Features

B Maintenance Tab

&% Canon BIC-55 Properties x|

ity I Page Setupl Effeclsl Profles  Maintenance |

Cleanin i Deep Cleaning MNozzle Check

b Start Status Manitor... e

ak I Cancel | Help

0 Cleaning Click the left button to clean the print head. Click
the right button to deep clean the print head.
e Nozzle Check Click to print a Nozzle Check Pattern.
e Change BJ Click to move the cartridge holder so you can
Cartridge change the BJ cartridge.
0 Toner Click the left button to power off the printer. Click

the right button to specify the Auto Power
Setting for turning the printer off automatically.

e Start Status Click to start the BJ Status Monitor.
Monitor...
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Making the Most of the Printer Driver

B Printing Enlarged and Reduced Documents (Scaled Printing)

The Scaled Printing feature of the printer driver allows you to set a scaling value to print an
enlarged or reduced page image.

Scaling to fit

Use this method to specify a paper size different from the original page size. This allows you
to achieve the best print-image fit for the paper size being used.

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Page Setup tab.

2 Check Scaled Printing. The Scaling and Paper Size settings are enabled.

3 Click the down-arrow to the right of the Paper Size box and select the
desired paper size.

The enlargement or reduction ratio is calculated automatically and Auto is
displayed in the Scaling box. (To make a fine adjustment, check the Scaling
checkbox and change the value in the Scaling box.)
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Note P

Making the Most of the Printer Driver

Confirm the layout of the printout in the graphic and click OK.

%" Canon BIC-55 Properties

fain  Page Setup | Effectsl Profilesl Maintenancel

5 Page Size:

+ [ Scaing

E Paper Size:

¥ Scaled Printing

i 3

I Letter

[foe = %040

=

Page Layaut:

I 1-up Printing

I~ Print Fage Barder

Orientation:

% Partrait f" Landscape

Letter->Canon 4 4 B in
Scaling:Auto
1-up Printing

Copies:

F
z
z
1
1
1

[1 =] (1939

™ Reverse Order
I Collate

Defaults |

o]

Cancel I Help |

To change back to the original value (100%), uncheck Scaled Printing.

(You can also click the Defaul

ts button.)
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Making the Most of the Printer Driver

Scaling to order

Use this method to apply a specific scaling factor even though you are printing on the right
size of paper for the print job. You can also use this method to fine-tune the scaling factor
when scaling to fit.

1

Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Page Setup tab.

Check Scaled Printing. The Scaling and Paper Size settings are enabled.
Check Scaling.

Set the desired enlargement or reduction ratio in the Scaling box.

To change the value of the enlargement or reduction ratio, click the up- or
down-arrow to the right of the Scaling box. (You can also enter the value
directly.)
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Note p

Making the Most of the Printer Driver

Confirm the layout of the printout in the graphic and click OK.

&% Canon BIC-55 Properties

2=
Main  Page Setup | Effectsl Profilesl Maintenancel
W Scaled Printing
B PageSicz:  [1117 (3oaled Pin) =]
I:‘ + ¥ Scaling = % [20-400)
E Paper Size: ILetter |
Fage Lapout: |1-up Printing j
™ Frint Page Border,
R & . -
j 114175 Latter Oirtaton: | A] @ Fora Landscape
Scaling 647
1-up Printin
el Copies: [ = nas
" Reverss Order
I~ Collate
Defaults |
aK I Cancel | Help |

To change the scaling factor back to its original value (100%), uncheck
Scaled Printing. (You can also click the Defaults button.)
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Making the Most of the Printer Driver

B Printing a Banner
You can print banners by loading special banner paper in the printer.

Note P

1

2

Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Main tab.

Click the down-arrow of the Media Type box and select Banner.

A confirmation message appears.

If you click Help, detailed instructions on banner printing are displayed. To
skip these instructions, click OK.

Confirm the printer settings by looking at the graphic and click OK.

» Always specify 1 in the Copies box of the application you are using. If
you specify more than one copy, the banner won’t be printed properly.

* To turn banner printing off, select any media type except Banner in the
Media Type box.
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Making the Most of the Printer Driver

B Optimizing Images
Low-resolution images, such as web-page graphics downloaded via the Internet, and

images you have enlarged with a graphics application often contain jagged edges. To
smooth these edges when printing, turn the Image Optimizer on.

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Effects tab.

2 Check Image Optimizer to enable the Image Optimizer setting.

3 Click OK.
The printer properties dialog box closes and printing starts.

* The Image Optimizer setting may have little or no effect on printing,
Note P depending on the application you are using.

* The Image Optimizer setting has more effect on low-resolution images
than on high-resolution ones.

¢ Using the Image Optimizer may slow printing down.
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B Changing the Print Quality/Halftoning

If your printouts are not satisfactory, the printer driver lets you make fine adjustments to the
print quality and halftoning settings.

Note P If there is a problem in the image data you want to print, the print quality
and halftoning settings may not be visible or effective.

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Main tab.

2 Select Custom for the Print Quality and click the Set... button.
The Set Print Quality dialog box opens.

Set Print Quality 2lx

5 4 3 2 1
Frirt Quality:  Standand 4 .._ﬂ]; @

Fast Fine

7

Auto Dithering Diffuzion

QK I Cancel | Help |

Halftoning:
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3 Set Print Quality and Halftoning the way you want.

4

Print Quality To improve the print quality, drag the Print Quality slider

Halftoning

Click OK.
The Set Print Quality dialog box closes.

toward Fine. The resolution and print mode change
according to the setting of the slide bar. Using a higher
setting increases printing time.

The colors and shapes of printouts are reproduced by the
ink dots ejected from the nozzles of the print heads.
Halftoning determines the color boundaries of intermediate
tones.

Dithering lines up ink dots of different colors according to
rules specified in the printer driver. Use this setting for
printing graphics or charts with clearly defined color
boundaries.

Diffusion randomly positions ink dots of different colors.
Use this setting for printing natural images such as
photographs.

Auto lets the printer driver automatically distinguish
between the types of image data and use the most
appropriate halftoning method.
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5 Click OK.
The Printer Properties dialog box closes.

Note P Depending on the BJ Cartridge and Media Type settings on the Main tab,
some of the Print Quality and Halftoning settings are not available.

B Adjusting Images

If the color of your printouts is unsatisfactory, you can adjust the color balance and intensity.
Use this feature only when you want to make fine adjustments to the color balance in the
printouts, and do not change the settings too much. (This feature does not correct the
overall color balance of the image data as some image editing applications do.)

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Main tab.
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2 Select Manual for Color Adjustment and click the Set... button.

The Manual Color Adjustment dialog box opens.

Manual Color Adjustment 21|
Calor Balance
Cyar: o 4] n
Magenta; oA »
“Yellow: 0 4] [ ]] 1
Black: (I} 3
Intensity: oA 4
I” Enable ICM
Print Type: IAutD j
Erightness: I Mormal ﬂ
] I Cancel | Defaults | Help |

3 Set the following items as needed. (Use the online Help feature for more

details.)

Color Balance Move the sliders for the individual colors. For example,
when blues are too strong in the printouts, drag the slide
bar for Cyan to the left.

Intensity

Move the slider to adjust the overall lightness or darkness
of printing.
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Enable ICM  Check this box to turn on the Image Color Management
function built into Windows.

Print Type Selects the type of color correction applied: Auto, Photo, or
Graphic.

Brightness Selects the brightness of printing: Normal, Light, or Dark.

Click OK.
The Manual Color Adjustment dialog box closes.

Click OK.
The Printer Properties dialog box closes.
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With the printer driver’s Maintenance tab, you can access various functions that affect how
your printer performs.

&% Canon BIC-55 Properties 2]x

Main | Page Setup | Effects | Frofiles  Maintenance |

B Cleaning the Print Heads

Cleaning the print heads clears the nozzles. There are two ways to clean the print heads:
normal print head cleaning and deep print head cleaning. Always try normal print head
cleaning first. If this doesn’t correct the problem, then try deep print head cleaning.

Note Pp Cleaning the print heads uses up a lot of ink, so only do it when absolutely
necessary.
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Normal print head cleaning

1

2

Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Maintenance tab.

Click the Cleaning button.

When a confirmation message appears, make sure the printer is on and
click OK. Print head cleaning begins.

Print a Nozzle Check Pattern to confirm the success of normal print head
cleaning.

B Printing a Nozzle Check Pattern

Deep print head cleaning
If normal print head cleaning does not correct the problem, perform deep print head

cleaning.

Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Maintenance tab.

Click the Deep Cleaning button.

When a confirmation message appears, make sure the printer is on and
click OK. Deep print head cleaning begins.

Print a Nozzle Check Pattern to confirm the success of deep print head
cleaning.

B Printing a Nozzle Check Pattern
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Note P Always execute normal print head cleaning first. Only when the normal print
head cleaning does not correct the problem, perform deep print head
cleaning.

B Printing a Nozzle Check Pattern

The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the
print head nozzles and whether the print head is correctly aligned. Print the Nozzle Check
Pattern when your printouts are streaked or the color tones are not correct, or after
performing print head cleaning.

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Maintenance tab.

2 Click the Nozzle Check button.

3 When a confirmation message appears, make sure paper is loaded in the
printer and the printer is on.

4 Click OK.

Note P If cleaning has no effect, do normal print head cleaning and deep print head
cleaning again. If, after cleaning the print head several times, the Nozzle
Check Pattern is still not satisfactory, the print head may be worn out and
the BJ cartridge must be replaced.
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B Changing the BJ Cartridge

1

2

3
4

Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Maintenance tab.

Click the Change BJ Cartridge button and click OK. The cartridge holder
moves to the center.

Change the BJ Cartridge and press the CARTRIDGE button.

Click OK to close the Change BJ Cartridge dialog box.

B Turning the Printer On and Off

You can turn the printer on and off from the Canon BJC-55 Properties or Canon BJC-55
Printing Preferences dialog box.

In addition, the Auto Power feature can turn the printer off if no data has been sent to the
printer for a certain period and turn the printer back on when data is sent to the printer.

Turning the printer off

1

2

Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Maintenance tab.

Click the Power Off button on the left.

When a confirmation message appears, click OK.
The printer is turned off.
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Setting the Auto-Power feature

1 Open the Canon BJC-55 Properties or Canon BJC-55 Printing Preferences
dialog box and click the Maintenance tab.

2 Click the Auto Power button on the right.

3 Select the desired setting in the Auto Power Setting dialog box.

Auto Power On Click the down-arrow and select either Enable or
Disable. When this setting is enabled, the printer
is turned on when data is sent to the printer. The
default setting is Disable.

Auto Power Off Click the down-arrow and select the desired
value: 30 minutes or Disable. If data has not
been sent to the printer within the 30 minute
time interval, the printer is turned off
automatically.

4 Make sure the printer is turned on and click Send.

5 When a confirmation message appears, click OK.
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Printing With Macintosh

Overview of Printing With the Macintosh Printer Driver
Selecting the Printer Driver in Chooser

Opening the Macintosh Printer Driver

Using Balloon Help

Macintosh Printer Driver Features

Using the BJ Print Monitor

Uninstalling the Macintosh Printer Driver
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After you have created a document with your software application and you are ready to
print, you’ll want to confirm the printer driver settings before printing.

Note P The procedure for setting up and executing a print job may differ,
depending on the software application. For details, refer to the software
application documentation.

1 First, select the printer driver.

From the Apple menu, select Chooser and click the BJC-55 icon. Make
sure that BJC-55 is selected under Connected To and click the Close box in
the upper right corner of the window.

Cﬁ‘ile Edit View Special Help = (hooser————————&
e f 5
s A1t This Computer ’._\ =1 | Connected to:
&0 Apple System Profiler @ / \ [ Bac=s51 1=
I’ppIeCD Audio Player appleShare ' BJC-55 l
[ypwutomated Tasks » V.
’_Z e Se—
\’ BUC-S5(5erver)
-
| 5, voncror Panels
Close box
Li Backgrounding
Gon ® o
[ @® Active
- AppleTalk
) Inactive 162
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Note P

Note P

Overview of Printing With the Macintosh Printer Driver

After you select the printer driver, you do not need to select it again unless
you want to select another printer.

Select the paper size for the document that you are going to print.

In the software application, open the File menu and select Page Setup to
open the Page Setup dialog box. Use this dialog box to select the paper
size.

@Edit Font_Size

Nev) 8N After selecting the paper size,

Opep...  *®0 | click the OK button to close

Uofe BEW the dialog box.

savfe 85

_5 - ;Ai:“__\ Canon BIC- 55 Version 3.6

( Page Setup... 2/ - A5 o< ]
T e - e - Paper Size: |v Ad

Pl 33

Print One Copy Check the Paper Size _—

i Scale: Legal Custom
Quit 380 selection. #10 Envelope -
Orientation : Dl Enyelone

Canon 101.6x 1524mm
Custom1
Custom?2
Custom3

Height:11.00inch  Width 8 50inch

* If you want to enlarge or reduce the size of the document on the page,
click on the Scale box and enter the percent of enlargement or reduction,
or click the arrows to open the pop-up menu and select a setting.

* |f you want to rotate the document and print sideways relative to the
paper feed direction, click the Orientation icon on the right.

The paper size setting is normally selected in the software application, but
you can also use this procedure to change the paper size selection.
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3 Click the print mode icon appropriate for the print job.

In the software application, from the File menu select Print to open the Print
dialog box then select the appropriate Print Mode icon.

Canon BJC-55 Version 3.6
=)
Cupies:E Pages: @ All O Fro
BJ Cartridge :
Media Type :
Plain Paper
. . -_Optiuns...
Select the icon appropriate FaperFeed :
. . Mi 1 >
for the print job. arna
[ Print Grayscale

* To select another BJ cartridge, click the BJ Cartridge box and select the
name of the BJ cartridge from the pop-up menu.

* To select another media type, click the Media Type box and select the
name of the media from the pop-up menu.

* Paper Feed is always set to Manual.

4 Make sure the printer is turned on and that paper is set in the printer.
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5 Start the print job.
Click the Print button to start the print job.

Canon BIC-55 Version 3.6 —gm.om ey

S rintflh
- —
Conies: 1] poaes: @1 0 rom [ | To [ ] [“gomeer)
BJ Cartridge : it Mode :

Color ¥

Media Type :
Plain Paper ) ent Settings :Text
- .  Print Quality : Normal(Fast) H
Paper Feed : ! Malftaning - Scatter !
m ! Eolor Correction :BJ Standsrd ] Apply..

[ Print Grayscale

The BJ Print Monitor is displayed while the print job is executing.

Use these buttons 0 =——BI PrintMonitor =—-—HIH
to pause or cancel
the current print job.

Arnazon World txt The name of the
Preparing to print... print job that is

currently printing

Docurnent Marme Fages Copies Receive Time . .
= is displayed here.
If more than one ——{— Annual Report txt 3 1 1341 7/24/99
print job has been
started, the print -
jobs waiting to print
are listed here. Documents Queusd : 2 %
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Selecting the Printer Driver in Chooser

Before you can execute a print job, go to the Apple menu and select Chooser. Make sure
that the correct printer driver is selected.

1 From the Apple menu, select Chooser.

/;vle Edit View Special Help
\_Jl‘ltThis Computer

D £pple System Profiler
JgppleCD Audio Player
\wtomated Tasks 13

N
Pt

2 Click the BJC-55 icon.

OJ=———————(hooser—=———————8H

Connected to :

Acrobal’“‘ RLDvriter  AppleShare
{8\
l picss  J

\ 4

S

Backgrounding

@ On () Off

L1 DY

(O Active

AppleTalk @ Inactive

7.6.2
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Selecting the Printer Driver in Chooser

If the BJC-55 icon is not displayed, check the printer and make sure that it
is turned on and connected to the computer. If the printer is turned on and
connected, then the printer driver has not been installed correctly. For
details on installing the printer driver, see your Quick Start Guide.

Make sure that BJC-55 is displayed in the “Connected to:” panel.

00— thonser———————H

- Connecied to:

EC-55 | S — -

Appleshare

BUC-55(Server, gl

Backgrounding
(2 On @ Off

@& Active
J Inactive 762

= AppleTalk
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4 Click the Close box to close the Chooser and save the selection.

P

Chooser ———————

0y

- Cannected to:
BJC-55 1 [=]

AppleShare BC-55

BuC-5505erver)

Close
box

-~
Backgrounding
O On @ Off

® Active
3 Inactive 762

[+ | AppleTalk

B Turning On Background Printing
To turn on background printing, in the Chooser, click the Backgrounding On button.

With background printing turned on, you can start one or more print jobs and print in the
background while you use other software applications for other tasks.

With background printing turned on, you can use the BJ Print Monitor to manage print jobs
queued for printing.

® Using the BJ Print Monitor

Note P With background printing turned off, you cannot use another software
application until the current print job is complete.

Printing With Macintosh 212



Opening the Macintosh Printer Driver

Use the printer driver screens to select the paper size and other important options for a
print job. There are two printer driver screens, the Page Setup dialog box and the Print
dialog box.

Note P The names of the menus and appearances of the screens may differ
slightly, depending on the software application. For details, refer to your
software application documentation.

® Opening the Page Setup Dialog Box
® Opening the Print Dialog Box
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B Opening the Page Setup Dialog Box

1

Opening the Macintosh Printer Driver

In the software application, open the File menu and select Page Setup.

,(@)mt Font size

Open... 380
Close BW
Save 8BS
Cavn

]

|

|
;__;4—-__~
il “pageserur. — [RY

P| mt One Copy

Quit 380

The Page Setup dialog box opens.

Canon BIC-55

5“5"‘..1" Scale: o Ei
Orientation :

[] Save Settings

Height:11.00inch  Width :3.50inch

Version 3.6
0K
Paper Size : | Letter B
—_—_—_————
[ Banner Printing
Custom

2 Use this dialog box to select the paper size and direction of printing for the

document.

Click the OK button to close the dialog box and save your changes, or click
the Cancel button to close without saving selections.
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1

Opening the Macintosh Printer Driver

In the software application, open the File menu and select Print.

-
(ﬁb‘zdit Font Size
Ne\n‘ 8N
Ope,.. 20

Closy: BEW
Savy: 385

Sm'z As..

.

The Print dialog box opens.

Canon BJC-55

Version 3.6

Cuuies:El Pages: ®All O From l:| To |:|
BJ Cartridge : Print Mode :
Media Type :

Plain Paper 3 ext

i Options...

Paper Feed : alftoning - Scatter i

Manual 2|  Color Comection B Standard : Apply-..
[ Print Grayscale

2 Use this dialog box to select the print quality, color, and other important

settings for the document.

Click the OK button to close the dialog box and save your changes, or click
the Cancel button to close without saving selections.
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Using Balloon Help

If you want more information about an option displayed in a dialog box, turn on Balloon
Help. With Balloon Help turned on, every time you point to an item on the screen a brief
description of the item appears in a small balloon.

1 Select Show Balloons from the Help menu.

2 Display the printer driver screens (such as the Page Setup dialog box or the
Print dialog box).

3 Position the cursor over the item for which you want to display an
explanation. An explanation of the item is displayed.

Canon BJC-55 Version 3.6

Cnuies:El Pages: @ All ) From I:l To I:l
BJ Cartridge : Print Mode :
Color
M[mﬁ urrent Settings : Te
PaperFeed: :;
[ Print Grayscale
Note P To switch off balloon help, select Hide Balloons from the Help menu.
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B Page Setup Dialog Box

Canon BJC-55

Version 3.6

0
2/

0K
Paper Size : | BS =
e

Height:11.00inch | Width:8.50inch

I? Save Settings

| 9
Tﬂ

@ Paper Size

© scale

@ Orientation

Click this option and from the pop-up menu select a
paper size for printing.

Enter a setting from 25% to 400% to set the rate of
reduction or enlargement, or click the arrow E] icon
and select a setting from the pop-up menu.

Click to determine the orientation of the printed
document.

=

Click for normal print jobs.

Click to rotate the image 90 degrees, relative
to the direction of paper feed.
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@ Preview area

Q Save Settings

O ©on)

@ (wimes

Macintosh Printer Driver Features

Graphically displays the print area and orientation of
the document, relative to the paper size.

Click this button on to save the Page Setup dialog
box settings.

Click the Paper Size item and select Custom1,
Custom2, or Custom3 from the pop-up menu to
enable the Custom button and then click the Custom
button to open the Custom dialog box. Use the
options in this dialog box to define and register a
custom paper size.

® Custom Dialog Box

Click this button to open the Printer Utility dialog
box. Use this dialog box to perform print head
cleaning, printing test prints, and changing ink
cartridges.

® Printer Utility Dialog Box
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B Custom Dialog Box

Click the Paper Size item and select Custom1, Custom2, or Custom3 to enable the Custom
button. Then click the Custom button to open the Custom dialog box.

Macintosh Printer Driver Features

Canon BIC- 55

Version 3.6
Apply “* — 0

0 — [ Media: ‘Custuml

977 Unit ;

| Cancel

O mm @ inch

Paper Size:

— Margin

o

Height : [ 11.0

Left: 1.0 Top: 1.0

Width : | 8.5

Right: 1.0 Bottom : 2.0

© Vedia
e Unit

@ Paper Size

Enter a name for the custom paper size in this box.

Click the radio button to select the units of measure.

& mm Define the custom paper size in
millimeters

& inch Define the custom paper size in inches
Enter the dimensions for Height and Width, using

the units you selected above. You can enter
numbers within the following range:

Height 3.94 to 23.00 inches
(100.0 to 584.2 mm)

Width 3.94 to 9.50 inches
(100.0 to 241.3 mm)
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0 Click this button to register the new paper size under
the name you entered. The next time you open the
Paper Size pop-up menu, this name will be available
for selection.

B Printer Utility Dialog Box

In the Page Setup dialog box, click the Utilities button to open the Printer Utility dialog box.
Then click the panel switch and from the pop-up menu, select Cleaning, Test Print, Change
BJ Tank, Change BJ Cartridge, or Special Settings to change the panel display.

Canon BJC-55Printer Utility Version 3.3

+ Cleaning
Test Print
Change Ink Tank ng
Change Bl Cartridge [, cleaning.

Special Settings

® Print Head Cleaning panel
B Test Print panel

B Change BJ Tank panel

B Change BJ Cartridge panel

B Special Settings panel
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Print Head Cleaning panel

In the Printer Ultility dialog box, click the panel switch, and select Cleaning from the pop-up
menu. The Cleaning panel displays the icons used to start print head cleaning and print
head deep cleaning.

Canon BJC-55 Printer Utility Version 3.6

@ Print head cleaning
Starts print-head cleaning.
@ Print head deep cleaning
Starts print-head deep cleaning.

=

n Print head cleaning Click these icons to clean the print heads.

Click to clean the print head if the print head
has become clogged and print quality has
deteriorated.

Click to deep clean (flush) the print head if
five consecutive cleanings with the print
cleaning icon above does not solve the
problem.

Note P Print head deep cleaning consumes a large amount of ink, so use it only
after five consecutive print head cleanings do not solve your printing
problem.
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Test Print panel

In the Printer Utility dialog box, click the panel switch, and select Test Print from the pop-up
menu. The Test Print panel displays the icons to start the test prints.

Canon BJC-55 Printer Utility Version 3.6

— | Test Print *
Demo Print
2 Prints a demo-print pattern.

B Nozzle check pattern
Prints a nozzle-check pattern.

Cooe

0 Test Print Click an icon to start a test print.

x| Click to start printing the printer demonstration
sheet.

Click to start printing a Nozzle Check Pattern.
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Change BJ Tank panel

Macintosh Printer Driver Features

In the Printer Utility dialog box, click the panel switch, and select Change Ink Tank from the
pop-up menu. The Change Ink Tank panel displays the icons used to change the BJ tanks.

Canon BJC-55 Printer Utility Version 3.6

— | Change Ink Tank ¥

¥ @ Replace black ink tank
a=

Run black ink tank replacement process.

Replace color ink tank
Run colorink tank replacement process.

Replace black and color ink tanks
Run black and color ink tank replacement
processes simultaneously.

Pyl .

49

0 Change BJ Tank

Select the icon for the BJ tank that you are going
to replace.

Click to replace the black BJ tank in the BC-10
= Black BJ Cartridge.

8 Click to replace the color BJ tank in the
= BC-11e Color BJ Cartridge or BC-12e Photo BJ
Cartridge (whichever is installed in the printer).

Click to replace black BJ tank in the BC-11e
= Color BJ Cartridge or BC-12e Photo BJ
Cartridge (whichever is installed in the printer).
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@] Click to replace both the black and color BJ
= tanks in the BC-11e Color BJ Cartridge or
BC-12e Photo BJ Cartridge (whichever is
installed in the printer).

© oo Click to close the Printer Utility dialog box.

Change BJ Cartridge panel

In the Printer Utility dialog box, click the panel switch, and select Change BJ Cartridge from
the pop-up menu. The Change BJ Cartridge panel displays the icon used to change the BJ

cartridge.

Canon BJC-55Printer Utility Version 3.6

— | Change BJ Cartridge *

Change BJ Cartridge
Run BJ Cartridge replacement process.

Close

0 Change BJ Cartridge @ Click this icon to change the BJ cartridge
installed in the printer with another BJ

cartridge or the optional IS-12 Color Image
Scanner Cartridge.
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Special Settings panel
In the Printer Ultility dialog box, click the panel switch, and select Special Settings from the
pop-up menu. The Special Settings panel displays the icon used to select the Low Ink

Warning feature.

Canon BJIC-55 Printer Utility Version 3.6

— | Special Settings ¥

0 [ Ink low warning

0 Low Ink Warning Click the check box on, then click the Send button

to turn on the low ink alert.
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B Print Dialog Box

Canon BIC-55

opies :
07 BJ Cartridge :
Color =
07' Media Type :
Plain Paper 3

(et -

|
e—, Paper Feed ; = |
Manual =] | ColorComection B Standard A 77@
07— [ Print Grayscale

Current print settings are displayed here

0 Pages To print all the pages in the document, click the All
button on. To print only part of the document, click
the From radio button on, then enter the page
numbers to be printed.

e Copies Type in the number of copies to be printed
(1 to 999).

Q BJ Cartridge Click this item, or the [#] icon and then select the
BJ cartridge from the pop-up menu.

Black Selects the BC-10 Black BJ Cartridge
Color Selects the BC-11e Color BJ Cartridge
Photo Selects the BC-12e Photo BJ Cartridge
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O Vedia Type Click this item or the (2] icon and then select the
name of the media type from the pop-up menu.

+~ Plain Paper
Transparency
Back Print Film
High Gloss Film
Envelope

Glossy Photo Paper

Glossy Photo Cards
Other Paper

Some print media require special handling
procedures, loading procedures, and handling
procedures after printing. For details about using
special print media, refer to the instructions provided
with the print media package.

Make sure the print media loaded in the printer is
selected by name in the printer driver. If the Media
Type setting does not match the print media loaded
in the printer, the print job will not execute correctly.

e Paper Feed Make sure the paper feed method is set to Manual.
This printer feeds one sheet at a time only.

Q Print Grayscale Click this check box on to print grayscale.
[¥ Prints color documents in grayscale
"' Prints color documents in color

Printing With Macintosh 227



Macintosh Printer Driver Features

Q Print Mode Select the icon that best matches the content of the
print job. Selecting a print mode icon automatically
sets the optimum Print Quality, Halftoning, Color
Correction, Color Balance, and other settings.

Print Mode Icons

Text Select for printing text documents at normal quality.

Graphic Select for printing graphs and other computer
graphics with sharp color boundaries.

Photo Select for printing photographs and other graphics
that use gradations of color and tone.

e

@ Manual Allows you to customize the Print Mode settings for
special print jobs.

® Setting Up a Print Job Manually
@ Click the Manual |g] icon to enable the Details

button, then click the Details button to open the
Detailed Setting dialog box so you can select the
print settings manually.

B Setting Up a Print Job Manually

(9] Click this button to open the Options dialog box. Use
this dialog box to select the page printing sequence,
print destination, and page layout.

® Options Dialog Box
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(10] Click this button to open the Register Settings dialog
box. Use this dialog box to register a set of print
settings, or to import registered print settings.

(11 ) )| Click this button to start the print job.

If you press and hold down the option key on the keyboard, the [Crant_J button is replaced by
the button. Click the Preview button to preview the print job on the screen.

® Displaying a Print Preview of the Document
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B Detailed Setting Dialog Box

To open the Detailed Setting dialog box, in the Print dialog click the Manual | g | icon under
Print Mode and then click the Details button.

Quality panel
In the Detailed Setting dialog box, click the Quality icon to open the Quality panel.

Canon Detailed Setting

. IPrintoualiw: Fast —=—=fF———— Fine Iige

i NormalFast) Graphic representation
0 of the Print Quality
Special eect setting selected on the
Presented on all = arftoning slide bar.
three Detailed == Hotoning: i o
Setting panels. fattern  Scatter —
D [ Photo Optimizer
[ Whole page e
é— Presented on all three Detailed Setting panels.
0 Panel switching Click an icon to change the panel display for the

selected item.

Quality

Click to open the Special effects panel.

Special effects

Click to open the Color panel.

Calor
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QPrint Quality

e Halftoning

Macintosh Printer Driver Features

Slide the button on the slide bar to the left or right to
adjust the Print Quality.

Print Quality: Fast =————=1= Fine

Drag the button right for higher quality, or drag it left
for faster printing speed with less quality.

Tip: Some Print Quality selections may not be
available, depending on the BJ cartridge and
media selected for the print job.

Click an icon to select the method used to create
halftones with arrayed ink dots.

=51 Select to print images with clearly defined

— boundaries between primary colors and large
areas of uniform color. Best selection for color
business graphics such as charts and tables,

etc.

7| Select to print images with subtle boundaries

-

— and a wide range of colors and tones. Best
selection for photographs.

Pattern
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0 Photo Optimizer

© Whole Page

G Restore Defaults

Macintosh Printer Driver Features

Select to adjust the color balance of a photographic
image scanned or captured with a digital camera.
This setting can correct underexposed or
overexposed photographs.

Click the check box to use Photo Optimizer, which
improves the appearance of photographic images.

Selects what part of the page is selected for
adjustment with the Photo Optimizer. Click the box
to apply Photo Optimizer equally to all images on
the page. Otherwise, Photo Optimizer is applied to
images separately as required.

Tip: The default setting for the Whole Page is off.
Check the box on if the page contains trimmed
or rotated images on the page. With the Whole
Page checked on, printing may be slower.

Click this button to reset all options in the dialog box
to their default settings.

Printing With Macintosh 232



Special Effects panel

Macintosh Printer Driver Features

In the Print dialog, click the Manual |&| icon under Print Mode then click the Details button.
In the Detailed Setting dialog box, click the Special effects icon to open the Special Effects

panel.

Canon Detailed Setting

[ Simulate illustration

[ Monochrome effects

Contrast: h 0

Color: (0 EE

[Esture Defaults Cancel OK

a Simulate lllustration

Converts a full color image into a simulated
illustration. Check the box to convert to a simulated
illustration. Otherwise, the image prints with normal,
full color.

Contrast of the simulated illustration can be adjusted
through four steps by sliding the button on the slide
bar left or right.

[ Simulate illustration

Contrast: e

Slide right for a brighter image, left for a darker
image.
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e Monochrome Effects

Macintosh Printer Driver Features

Tip: You turn on the Simulate lllustration feature
then select one of the Monochrome Effects
below to combine these features.

Displays a full color image in one color that you
select from the list below. Click the check box to
enable the color choices so you can apply a single
color to a full color image for printing. Otherwise, the
Monochrome Effects selections are disabled.

To select a color:

Click the radio button of the colors you want to apply
to the image: Sepia, Blue, Pink, or Green.

To create your own color:

Click the Select Color button, then drag the button
on the slide bar left or right to adjust the color.

@ Select color -
Color: (=

The adjusted color is displayed here as you move
the button left or right.
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Macintosh Printer Driver Features

Color panel

In the Print dialog, click the Manual |&| icon under Print Mode then click the Details button.
In the Detailed Setting dialog box, click the Color icon to open the Color panel.

Canon Detailed Setting

Color Correction : | BJ Standard =

i (Pee =}

Matching Method : | Photo B

Quality Printer Profile : Recommended by Can... | & 70

o [ Gamma Correction: 1.4 C (rmmmmm

Speial effests Color Balance : +10 ——0—= (yan

= 4 e e

Calor 45 ——l—— Yellow

-10 ——r——m Black

e Density : 2 C—

DT

n Color Correction Click the item or the arrows [#] icon and select the

Color Correction method from the pop-up menu.

BJ Standard Best selection for printing on the BJ
printer. (Always selected until you
select another.)

ColorSync  Employs Apple ColorSync for color
correction.

Tip: If you select ColorSync, be
sure to select the Matching
Method and Gamma Correction
settings also.

None No color correction.
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Q Matching Method

0 Printer Profile

0 Gamma Correction

Macintosh Printer Driver Features

Click this item or the arrows [#] icon and select a
setting from the pop-up menu to select the color
matching method.

Auto Select for automatic selection of the
matching method (Photo or Graphic)
based on the content of the document.

Photo Select to print photographs with natural
color and tones.

Graphic  Select for documents that contain
illustrations and graphics.

Spot Color Select for a document with precise color
specifications, like a color sample.

Select the printer profile used for color correction.
Normally you’ll want to use “Recommended by
Canon”.

Click this check box if you want to adjust the level of
color contrast. This turns Gamma Correction on.
Otherwise, Gamma Correction is off and the printer
driver uses standard contrast.

[0 Gamma Correction; 1.8 C—m

After you turn Gamma Correction on, move the
button on the slide bar left or right to set a value.
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6 Color Balance

Macintosh Printer Driver Features

For each color, move the slide left and right to adjust
the saturation of each color.

ColorBalance : 0 :éz Cyan
1] \“:Gv’szzm Magenta
0 ——b—— Yellow
0 === Black

Move right for a more intense color, move left for a
less intense color through the range —50 to +50.

Drag the button on the slide bar left or right to adjust
the overall density.

Density: 0 r—

Move right to increase density, move left to decrease
density through the range —50 to +50.

Printing With Macintosh 237
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B Options Dialog Box
In the Print dialog box, click the Options button to display the Options dialog box.

Canon Options
=

{— Destination : @ Printer

(O Preview

(» PICTFile

3
7? [ Printin reverse order

07—% O Print collated pages
1

Page Order: [Hurizuntﬂlly from top left i]*ie

0 Destination Selects the destination of the print output. Click a
radio button to select the destination.

& Printer ~ Sends print job to the printer.

&=, Preview Displays print job in the preview area
for viewing before printing.

® Displaying a Print Preview of the
Document

& PICT file Sends the print job to a PICT file.
® Saving a Document as a PICT File
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a Print in reverse order

Q Print collated pages

Q Page Layout

© Page Order

Macintosh Printer Driver Features

Prints in reverse order, from the last page to the first.

Check the box to print pages from the last page to
the first so they are stacked in the correct order as
they are ejected from the printer.

Otherwise pages are printed from the first page to
the last.

Click this check box to print collated copies. All
pages of one copy are printed before printing the
next copy. Otherwise, the specified number of
copies are printed separately for each page.

Click on this item or the arrows [#] icon then select
the number of documents that you want to print on
one sheet.

After you have set Page Layout to print more than
one document per sheet, click this item or the
arrows [#] icon then select the order of printing on
the sheet.

Tip: These selections differ, depending on the
number documents you select to print on one
sheet. For details, turn on Balloon Help, open
the pop-up menu, then point to each selection
for a detailed explanation.
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a Preview area

Macintosh Printer Driver Features

After you have set Page Layout to print more than
one document per sheet, click this item or the
arrows [#] icon then select whether you want a
border printed around each document printed on the
sheet. Available selections are None, Fine Line,
Broad Line.

The preview area reflects the current Page Layout
selections so you can confirm or adjust the settings.
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B Displaying a Print Preview of the Document

The Preview dialog box allows you to view the appearance of the document before it is
printed.

71 Inthe Print dialog box, click the Options button.

2 Click the Preview radio button for Destination, then click the OK button to

return to the Print dialog box. In the Print dialog box, the Preview button has
replaced the Print button.

Version 3.6
copies:[1_| Pages:@an Qfrom [ |To [ |
B Cartridge : H

Options...
Apply...

3 Click the Preview button to open the Preview dialog box.

o

==
Cam

ot

Starts the print job.

Closes the Preview dialog and cancels the print job.
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Macintosh Printer Driver Features

B Saving a Document as a PICT File

To save your document as a PICT file, click the Options button and change the output
destination.

71 Open the Print dialog box, and click the Options button.

2 Select PICT File as the output destination, and click the OK button.

Canon Options

Destination: ) Printer
2 Preview
( @ PICT File ’
:2: [ Print in reverse order
i )
[ Print collated pages

e

Page Layout: | 1 Up =

Page Order: [ Left to right &

3 Click the File button in the Print dialog box.

Canon BJC-55

Cuples:D Pages: @ All O From l:l To |:|

BJ Cartridge : Pi Mode :

Media Type :
Plain Paper * ext

Paper Feed : alfto atran
Manual 3] i ColorComraction Apply...

O Print Grayscale
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Macintosh Printer Driver Features

4 Type in the name under which you want to save and click the Save button.

= Macintosh=-HD = = Macintosh=HD
3} Anble Extras
aApplicatiuns
[, Assistants
o Erteas CRew ]
[, Installer Logs =
Save as:
— =

The document data is saved in PICT file format.
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B Register Settings Dialog Box
In the Print dialog box, click the Apply button to open the Register Settings dialog box.

Canon Register Settings

Settings :

vFactory Defaults

0 Settings:

2 | T
© o)

Close |
Import |
Apply |
Remove {—

Defaults —

Macintosh Printer Driver Features

Lists the currently registered settings.

Click to close the Registered Settings dialog box
and return to the Print dialog box.

Click a setting in the list then click the Import button
to import the settings.

Tip: If you select Factory Defaults, all printer
driver settings will be restored to their default
settings.
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O v

© (Remove)

Macintosh Printer Driver Features

Click this button to open the New Settings Name
dialog box. You can register all the previous selected
printer driver settings under a new name.

New Settings Name :
FAMILY PHOTOS |

Enter a name and click the OK button.

If a registered setting already exists with the same
name that you have entered, a message will ask you
to confirm that you want to write over it. You can
write over the file or enter a new name.

Click the name of the registered setting in the list
that you want to remove then click the Remove
button.

Tip: The Factory Defaults setting cannot be
removed from the list.
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@ (oios |

Macintosh Printer Driver Features

Select the name of the setting in the list that you
want to select for the default setting then click the
Defaults button. The settings in the selected file will
be enabled every time you open the printer driver.

Canon Register Settings

Settings :
Factory Defaults
wFAMILY PHOTOS

Import

Apply

Remove

I
=3
@
B

Defaults

A check mark is displayed with the setting selected
for default.
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Macintosh Printer Driver Features

B Setting Up a Print Job Manually

You can select the Manual [£ | icon and select the Print Quality, Halftoning, Color
Correction, Color Balance, and other settings for a print job.

1 Click the Manual [£]icon, then click the Details button.

Ccanon BIC-55 Version 3.6

Copies:[1_ | Pages: ®AIl O from [ |To [ ]

B) Cartridge : Print Mode : - ~
Color B

Media Type : ‘d
Plain Paper s

Paper Feed :
Manual B

[O Print Grayscale

2 Select the settings for the print job.

Open the Quality, Special Effects, and Color panels and select the settings.

Camnon Detailed Setting

- e a——

' . ' Print Quality: Fast ——(=————= Fine
|

Qualit
Halt Normal(Fast)

Pattern Scatter
D I Photo Optimizer
[0 Whole page
Restore Defaults I

E

Halftoning :

1=

o

TVTV_L
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Macintosh Printer Driver Features

3 Click the OK button to close the dialog box and return to the Print dialog
box.

The settings you have selected will be used to execute the print job.

B Registering Manual Settings for Future Use

After selecting the settings manually, you can execute the current print job, or you can
register the settings under a name so you can use them again whenever needed.

To register manual settings

1 Inthe Print dialog box, click the Apply button.

Canon BJC-55

Version 3.6
=
(nuies:El Pages: @ All O From l:l To I:l
BJ Cartridge : Print Mode :

Media Type :

Plain Paper > 95 T

Text
i [options..|

Paper Feed :

slftoning : Scatter i P
Manual = ColarCorrection Bl Standard F € Anply Y
H 2

b —
[ Print Grayscale

2 The Register Settings dialog box opens. Use this dialog box to register the
settings under a name of your choice. Click the Apply button.

Canon Register Settings

Cowse
Settings :
vFactory Defaults
g—
(I
~———
|
Defaults

a]r
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Macintosh Printer Driver Features

3 Type in the name you want to use to register the current settings and click
OK.

New Settings Name :

Report

(Lcancer | [ ok ]

4 Click the Close button to return to the Print dialog box.
To retrieve registered settings for another print job
1 Inthe Print dialog box, click the Apply button.

2 Click the name of the registered settings that you want to use and click the
Import button.

Canon Register Settings

:

[ Close ]

Settings :

vFactory Defaults (.
Defaults

D

3 Click the Close button to return to the Print dialog box.
Click the OK button to start the print job with the imported settings.
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Macintosh Printer Driver Features
To remove registered print settings

1 Open the Print dialog box and click the Apply button.

2 Click the print mode setting you want to remove and then click the Remove

button.
Canon Register Settings
Close
Settings : E
+Factory Defaults
|
% Defaults I

3 When a confirmation message appears, click the OK button.
The selected print setting is removed from the list.

4 Click the Close button to return to the Print dialog box.

Canon Register Settings
Close
Settings : y
v Factory Defaults
|
% Defaults
Note p You cannot delete factory default settings.
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Using the BJ Print Monitor

The BJ Print Monitor allows you to monitor and manage the print jobs printing in the
background. You can monitor the progress of the current print job, change the order of
printing in the jobs queued for printing, and cancel any print job.

Note p In order to use the BJ Print Monitor, you must select Backgrounding in the
Chooser. If the feature is turned off, the BJ Print Monitor cannot open.

® Turning On Background Printing

B Opening the BJ Print Monitor

When Backgrounding is turned on in the Chooser, the BJ Print Monitor starts automatically
as soon as you start a print job. Also the BJ Print Monitor is displayed in the application
menu.

1 With print jobs executing in the background, open the application menu and
select BJ Print Monitor.

" @& File Edit View Special Help PELTIYIE <4 Finder [N

+ 2 BJ PrintMonitor
v K] Finder
4 script Editor
%
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Note Pp

Using the BJ Print Monitor

The name of the print job currently executing and the names of all print jobs
queued for printing are listed in the order of execution in the BJ Print
Monitor.

. @ Suspends printing of the document.
Restarts the printing of the document.

j - BJPrintMonitor —______ E
o] Suspends the printing of specified documents only.
@ Restarts the printing of the documents suspended
T with @] .

Cancels printing of the specified document.

— Shows information on the document currently being
printed. The icon on the left gradually fills with black as
printing proceeds.

S0

Docurnents Quaued : 1

Lists the names of the queued documents.

To display more information about the document queued for printing,
double-click the name of the document to open the Document Information
window.
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Using the BJ Print Monitor

B Use the BJ Print Monitor to Perform These Tasks

e Change the order of the documents in the print queue
Highlight the name of the document whose position you want to change and click
and drag it to the desired position in the queue. When you release the button, the
document moves to the selected position.

e Stop printing
Click the name of the document name you want to stop printing and then click
the icon. The selected document is deleted from the list.

e Suspend or restart printing
Click the name of the document you want to suspend and then click the [@1].
To restart printing, click the |2’ icon.
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Using the BJ Print Monitor

B Changing the BJ Print Monitor Preferences

You can change the preferences to effect how the BJ Print Monitor is displayed, how errors
are reported, and so on.

1 With the BJ Print Monitor open, open the File menu and select Pause
Printing.

i g(qjgyelp 3 % BJ PrintMonitor
upen Status Window 30 - -
Close Status Window %W BJ PrintMonitor
ac

=
Macintosh-HD

uuuuuu

The current print job pauses.
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Using the BJ Print Monitor

2 From the File menu, select Preferences.

Y eyt
Open Status Windew %0 - -
Close Status Window #W BJ PrintMonitor

gy e

= = e e e e

Pages Copies  Reoeive Time

z 1 S06PMAMES

The Preferences dialog box opens.
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3

Using the BJ Print Monitor

Click the check boxes on for the settings you want, then click the OK button.

Canon Preferences

|~ ] Show BJ PrintMonitor window when printing

0 977 [J Ask at startup to print documents remaining in gueue
When a printing error needs to be reported :
+ ) Only display + in Application menu e
'h_ + (J Also displayicon in menu bar
D ﬂa + @ Also display alert

Background Priority :
0o

n Show BJ PrintMonitor window when printing
Displays the BJ Print Monitor window on the desktop during printing.

e Ask at startup to print documents remaining in queue
Displays a dialog box when you restart the computer and asks
whether you want to continue printing the documents that were in the
gueue when you previously shut down the computer.

e When a printing error needs to be reported
Selects the type of notification for problems that occur during
background printing.

o Background Priority
Sets the priority of printing relative to other processing (High, Normal,
Low).
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Using the BJ Print Monitor

B Closing the BJ Print Monitor After Print Jobs Are Completed
From the File menu, select Close Status Window.

P
=
Hi:
o
n
=
b
=
F
215
£

e
-
3
=
S
=
5
=
=
2
g

——— — e — ————
Preferences...

Pause Printing

Docurnent Hame Pages  Copies

Docurnents Queued :0
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Uninstalling the Macintosh Printer Driver

Note P * You must use this procedure to remove the printer driver from your

system when it is no longer needed, or before installing a new version
of the printer driver.

* Shut down all other software applications before you uninstall the printer
driver.

1 Set the Canon Creative CD-ROM in the CD-ROM drive.

2 Double-click the Printer Driver folder.

O=———————(JANONBI=————[8
5] Sitems, 88 K available
_,A—\
'\Pr\nter Dr’wr’ 15 Scan Copy Utility
N=’/
Manusl Acrobat Reader 3.0

3 Double-click the folder for your language.

0 =—=UL] Printer briver ———=HHE
Sitems, 745.6 ME avsilable
R -_ i
SN N
\ English ) French German
-—/
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Uninstalling the Macintosh Printer Driver

Double-click the BJ Installer icon.

m

0 [ US English Bl
8 el Zitems, B Kavailable
N

/

\ﬁf?}ﬂsmlfev"
N 4 [a]

4[r

Read the License Agreement and click the Agree button.

Software License Agreement

Read this Software License agreement carefully before you use this
software. If you agree to this License Agreement, click on Agree. If not,
click on Do Not Agree.

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT-READ THIS AGREEMENT BEFORE INSTALLING THE PRINTER
DRIVER FOR BUBBLE-JET PRINTER. BY INSTALLING THE PRINTER DRIVER FOR
BUBBLE-JET PRINTER, YOU ARE DEEMED TO AGREE TO BE BOUND BY THIS
AGREEMENT.

This legal documentis a license agreement between you and Canon

Inc.("Canon®).
BY INSTALLING THE PRINTER DRIVER FOR BUBBLE- JET PRINTER (THE, o
-

Do Not Aql'ee] £ Agree JD

‘_’!_

In the Choose list, click BJC-55 and click the Choose button.

Choose

Installing the software required for the printer you
have chosen.

BIC-55

PTES

[Ccancer { (Coiwose ) )

N—f’

Printing With Macintosh 259



Note P

Uninstalling the Macintosh Printer Driver

7/ Click the Custom remove tab and click the check boxes for the items that

you want to remove.

If a message warns you that another application is running in the
background, click the Continue button to close the software application and

continue.

If the open software application contains data that has not been saved,
click the Cancel button. Save the data in the open software application,
close the application, and start over.

] BJC-55 Script

HE

Destination

| E—

Macintesh HD

CANOH_E.J

Easy install T Custom install Custom remove
ar

Explanation ©

QuickDraw

Disk space available 2,097,100K

This package contains a complete set of software needed to use the BIC-55 ina
onment running under System 5.1 or later

Selected size oK
TN
ot { )
N\

~—-7

8 Click the Remove button.

A description of the
selected item is
displayed here.

9 When you are prompted to re-start the computer, click the Restart button.
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Troubleshooting

Error Messages

Problems and Solutions
Before You Call For Service
Getting Help From Canon
Servicing the Printer
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Error Messages

One of the following messages may appear when an error occurs:

Error writing to USBPRNxx: for Printer BJC-55

Service error xxx! Call for service!

This program has attempted an i1llegal operation and will shut down.
File cannot be found on the specified path or disk.

Cannot execute print due to insufficient disk space.

Waste i1nk absorber full! Call for service!

Cannot execute print due to insufficient memory.

Cannot execute background printing due to insufficient memory.
Paper Jam!

Error No. * 300 (* alphanumeric code)

Type x Error (x integer)
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Problems and Solutions

Printout is not clear or has white
streaks

Strange characters printing

Cannot start the print job

USBPRNXxx: write error appears
on the screen

Cannot install the printer driver

Application Error or General
Protection Fault appears
on the screen

Cannot print to the end of the
print job

Paper does not feed manually

Printout rotated 90 degrees

Vertical lines are broken

BJ cartridge does not return to
the home position after
installation

Cannot print via wireless
infrared connections

Paper skews or jams during
feeding

Screen colors and the printed
colors do not match

Document prints in black only

Colors are broken or uneven

Printing beyond the edge of a
page, or portions of a
printed page are missing

Printer does not turn on

Printer seems to be working but
nothing prints

Print job halts

Printing blurred or smudged

Printout is excessively curled

Battery is not charging

CHARGE/ERROR light is orange

“Error Number: *300” appears
on the screen and print job
does not execute

“Type x Error” appears on the
screen

Cannot execute background
printing

Cannot select the printer driver
in the Chooser
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Problems and Solutions

B Printout is not clear or has white streaks
Low ink could cause faded characters and white lines to appear on the printout.

Try printing a Nozzle Check Pattern
Check the status of the BJ cartridge by printing the Nozzle Check Pattern.
® Printing a Nozzle Check Pattern

Look at the Nozzle Check Pattern to confirm the print quality.

A normal Nozzle Check
Pattern printed with
BC-10 Black BJ Cartridge

A faded, broken Nozzle
Check Pattern

Only specific colors are faded
The specific color ink may have run out. Replace the BJ tank with a new

one. Then print a Nozzle Check Pattern to see if the printing quality has
been restored.

The Nozzle Check Patterns are faded regardless of color

The print head may be clogged. Clean the print head.
B Cleaning the Print Head
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Problems and Solutions

If print quality is not restored after cleaning

Perform print head deep cleaning to flush the nozzles. Print a Nozzle

Check Pattern to see if the printing quality has been restored. Repeat deep
cleaning if the problem still persists.

B Cleaning the Print Head
If print quality is not restored after deep cleaning

The ink may have run out. Replace the BJ tank and print the Nozzle Check
Pattern to see if the print quality has been restored.

B Printing a Nozzle Check Pattern
If print quality is not restored after replacing the BJ tank(s)

Replace the BJ cartridge.
B Changing or Replacing a BJ Cartridge
The print head may be worn out or the ink may have dried and ruined the

nozzles. After replacing the BJ cartridge, print a Nozzle Check Pattern to
see if the printing quality has been restored.

Note P If you will not be using the printer for an extended amount of time, leave the
BJ cartridge installed inside the printer or remove it and keep it in the Ink
Cartridge Storage Box to avoid damage.
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Problems and Solutions

ghegk to see if the orange protective cap or tape has been re-attached to the print
ea

Reattaching the orange cap or tape could cause dust and small particles to enter through
the print head, which may cause the ink to clog. Once removed, the orange cap and the
tape must not be re-attached to the print head. If you have mistakenly done so, install the
BJ cartridge and execute print head cleaning. Use only the Ink Cartridge storage box to
store a BJ cartridge when it is not installed in the printer.

Make sure that you are printing on the correct side of the paper

The paper that you are using to print may have only one correct print side. Plain paper,
Bubble Jet paper, or Transparencies can be printed on either side. However, special print
media like High Resolution Paper, Glossy Photo Paper, and High Gloss Film have only one
correct print side.

® Media You Can Use With This Printer
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Problems and Solutions

B Strange characters printing

The text or the image on the screen appears normal but the printer prints strange
unreadable characters.

Normal Abnormal - Strange characters

PrlnterFeatures —— P S ONBm? __ X 8 x $/ A$H1 RS+ I(S - (4-03
[

W Simple, compact design

The light, yet sturdy construction of
the BJC-55 allows easy set up
and operation, even for beginners.

W Variety of print media

‘The printer produces superb color printing
on plain paper or coated paper like Canon's
High Resolution Paper, but for professional
jobs you may prefer one of the many special
media you can use with this printer, like
transparencies for OHP presentations, back

printfim, glossy photo paper, high gloss fim,

W Drop Modulation Technology

The BC-11e Color BJ Cartridge and
BC-12e Photo BJ Cartridge employ
Canon’s new dual drop technology,
which produces fine halftones with
combinations of large and small dots,
resulting in truly stunning color
photographs on Canon special media
like high resolution paper, glossy photo
paper, or high gloss film.

W Easy operation
In the printer driver you only need to

[ hoto cards.
Or glossy photo cards. select the BJ cartridge and type of

media for the print job to produce
sensational results. Printing on
special media like back print film was
never easier.
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Problems and Solutions

Check to see if the BJC-55 printer is selected as the default printer
Select the Canon BJC-55 as the default printer.

Selecting the BJC-55 as the default printer | Windows )

1 Click Start, select Settings, and click Printers.

2 Right-click the Canon BJC-55 icon and then click Set as Default to turn this
selection on. Make sure there is a check mark by Set as Default.

Fle Edt Miew Go Favoites Hel

b
- I A=
ut

Up

Addiess [ Pinters

= 9
- Add Printer

Printers

,Ej Specifies that the selected printer is the default printer.

Selecting the BJC-55 as the default printer | Macintosh )

1 Fromthe Apple menu, select Chooser.

2 Inthe Chooser, click the BJC-55 icon, then click the Close box.
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Check interface cable connections at the printer and computer

The interface cable could be defective. Replace it with a new interface cable and resume
printing.

If your system contains a printer switching device, a USB hub, or an external buffer, remove
the device and try connecting the printer directly to the computer.

If the printer operates normally without the switching device, the USB hub, or the external
buffer, contact the manufacturer of that device.
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Check to see if a print job has been canceled before completion

If you cancel a print job during printing, the data remaining in the printer may cause the
printer to produce strange characters. In this situation, restart the computer and the printer,
and start the print job again.

; If you are using Windows, click Start, point to Programs, click BJ Printer,
M) then click BJ Printer Monitor and cancel the print job.

Determine if the problem exists only within a particular document

If unknown characters and letters are printed only for a specific document file, then the
problem may exist within that file, or the software application that you are using. In this
case, try typing the same text in a newly created file. If the new document prints normally
then the problem exists in the original document file. If the same problem occurs with the
new file, call the Canon Customer Care Center.

® Before You Call For Service
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B Cannot start the print job
The printer does not respond when the print job is executed from the computer.

Check the printer status and its cable connections
Make sure the printer is ready for printing and that the cable is connected correctly.

* Make sure that the printer is turned on.
* Check the orange CHARGE/ERROR light.
®» CHARGE/ERROR light is orange
* Make sure that the power cable is properly plugged into the power outlet.
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* Make sure that the power outlet is usable by connecting another electrical
appliance to it and turning it on.
* Make sure that the interface cable is connected properly.

* |Interface cable could be defective. Replace it with a new interface cable and
resume printing.

* If your system contains a printer switching device, a USB hub, or an external
buffer, remove the device and try connecting the printer directly to the computer.

If the printer operates normally without the switching device, the USB hub, or the
external buffer, contact the manufacturer of that device.

Check to see if the Canon BJC-55 printer has been selected as the default printer
Select the Canon BJC-55 as the default printer.

B Selecting the BJC-55 as the default printer

Check to see if the printer port setting is correct _Windows )

If the printer and the computer are connected to the USB interface, USBPRNxx: must be
selected as the printer port.

Selecting USBPRNxx: as the printer port

1 Click Start, select Settings, and click Printers.
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Right-click Canon BJC-55 and then click Properties.
Click the Details tab.

Go to “Print to the following port” and select USBPRNxx: (Printer Port).

Canon BJC-55 Properties 2] x]
2 Pagelayout | ) StampiBackgound | @k Maintenance |
General Details Color Management | &3 Main

7 CanonBJCHS

Frint to the following port

[ISEPANTT [Devi AddPot. |

Delete Por.
|Canon BIC-55 | HewDiiver.

et Rz Pt | e |

Frint using the following driver

Timeout setting:

Not selected 15 seconds
Transmission retry: [45 seconds

Spoo| Setings.. | PatSetings.. |

T e e |

If the problem persists, make sure the printer port (USBPRNxXx) is
operating normally.
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Checking the operation status of USBPRNxx:

Note P

1

2
3
4

Click Start, select Settings, and click Control Panel.
Double-click the System icon.
Select the Device Manager tab.

Double-click Ports (Universal Serial Bus Controller) and double-click Canon
BJC-55.

Click the General tab. Under Device Status, read the information regarding
printer port status. If the message indicates that the device is not
performing normally remove the BJC-55 device, and reinstall the printer
driver.

The display and the procedures above may be different depending on your
Windows version. Refer to your Windows documentation for complete
instructions.
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Check to make sure that the printer has been selected with the Chooser (Macintosh')

Make sure that the BJC-55 is selected with the Chooser. Also make sure
that the correct printer port is selected.

Selecting the printer with the Chooser

1 From the Apple menu, select Chooser.

2 Click the BJC-55 icon.

T || | Connected to:
@ BJC-55 1
AppleShare

Backgrounding

2 ) On @ off
@ Active
() Inactive 7.6.2

DI

AppleTalk

3 Click the Close box.

Check to see if you are printing a large amount of text or a large image

A large amount of data could slow down the print job because the computer must spend
more time to process data and send it to the printer. This is common when printing a very
large photographic image or a large amount of text. The computer processing speed, which
is affected by the system (CPU, memory, space available on the hard disk, cache, interface,
etc.), also affects the amount of time required to process a print job. Refer to your computer
documentation for details.
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Check the BJ cartridge by printing a Nozzle Check Pattern
Use the printer operation panel to print a Nozzle Check Pattern.

® Printing a Nozzle Check Pattern

If the Nozzle Check Pattern does not print ...

The printer may be damaged. Call the Canon Customer Care Center.
® Before You Call For Service

If the Nozzle Check Pattern prints normally ...

There may be a problem in the software application, or the interface cable
could be damaged or not plugged in correctly.
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Cannot print via the infrared port

If the print job does not start when using the infrared port, check the location of the printer
in relation to the computer or PDA. Change the location of the printer so the infrared ports
are facing one another at the correct distance and angle.

The distance and the angle between the infrared ports could differ with computer model,
the PDA capability, and the surrounding environment. Keep the distance within 3 feet

(0.8 m) and remove any object blocking the path between the infrared ports. Print data
cannot be sent or received if an object blocks the path between the infrared ports. Start the
print job again.

If you see COMn Write Error ora similar message on the screen, turn off the printer,
turn it on again, then start the print job again. The correct COM port must be selected for
the computer or PDA.

® Using Infrared Data Transmission
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B USBPRNXxx: write error appears on the screen

If an error occurs when the print job is sent to USB port USBPRNXxx, you will see a
message similar to this:

Printers Folder

There wasz an emor writing to USEPRMO for the printer [Canan BJC-55):
Cannot access the part. It may be in use by anather program.
Quit ather programs and by printing again.

Check the interface cable connections
Check the interface cable connections at both the computer and the printer.

Check the printer spooling setting

The printer spooling might not be operating properly. Discontinue printer spooling and try
printing again by sending the print data directly to the printer.

Turning off print spooling
Click Start, point to Settings, and click Printers.
Right-click Canon BJC-55 and select Properties.

Select the Details tab.

AR W N =

Click the Spool Settings button.
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5 Click the button on for “Print directly to the printer” (this turns off spooling).

Spool Settings HE

£ Spool print jobs so program finishes printing faster
€ Start printing after last page is spooled
o

page is spooled

Spool data format: | R j

& Enable bi-directional support for this printer
" Disable bi-directional support for this printer

ok I Cancel Restore Defaults

Make sure the printer port (USBPRNXxx) is operating properly
Check the operation status of the printer port.

® Checking the operation status of USBPRNxx
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Check to see if the printer driver is installed properly

It is possible that the printer driver may not be installed properly. In this situation, uninstall
the printer driver and re-install from the beginning.

Re-installing the printer driver

1 Click Start, select Programs, click BJ Printer, then click Uninstall.

2 Inthe Uninstall dialog box, click the Yes button.
3 Click the OK button to uninstall the printer driver.

4 Re-install the printer driver. For details, refer to the Quick Start Guide.

Troubleshooting 280



Problems and Solutions

B Cannot install the printer driver

If the printer driver installation was interrupted and did not continue, some possible causes
and solutions are listed below.

Make sure that you followed the installation procedure correctly

Follow the instructions in the Quick Start Guide to install the printer driver. Make sure you
select the correct method, based on the operating system you are using—Windows or
Macintosh.

Check the Printer Driver CD-ROM

The Printer Driver CD-ROM could be damaged. Check that you can read the contents of
the CD-ROM.

Make sure no other applications are open and running

It is strongly recommended that you shut down all applications before you run the printer
driver installation program. Be sure to close any virus protection programs that may be
running in the background.

Make sure that your operating system is stable

A serious error could cause Windows or the Mac OS to become unstable. If you are
experiencing a problem with the printer driver installation, re-start the computer by shutting
it down, turning the power off, and turning it on again. Then re-install the printer driver.
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Check to see if the following message is displayed

File cannot be found on the specified path or disk.

Make sure you load the Printer Driver CD-ROM and select the CD-ROM drive. The name of
the drive (D:, E:, F:, etc.) depends on the computer.

Check to see if the USB driver is installed correctly.

Follow the procedures in the Quick Start Guide to install the printer driver again. If
re-installing the printer driver does not solve the problem, the USB driver may not be
installed correctly. First, check the status of the USB driver. If the USB driver is not
performing correctly, remove it and then re-install the printer driver.

Checking the status of the USB controller

1

Check the USB cable and make sure that it is securely connected to the
computer and the printer, and make sure that the printer is turned on.

On the desktop, click the Start button, point to Settings, and then click
Control Panel.

Double-click the System icon.
Click the Device Manager tab.

Double-click Universal serial bus controller, and make sure that Canon
BJC-55 is selected.
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Problems and Solutions

* If you see Canon BJC-55 displayed, the USB driver is installed correctly.

e |f you see an exclamation mark (!) displayed, the USB driver is not
installed correctly. Remove it and re-install the printer driver.

* If nothing is displayed, click the Other Devices heading. If you see the
USB driver under Other Devices, the driver is not installed correctly.
Remove it and then re-install the printer driver.

Removing a device

A\ Caution

Proceed carefully to avoid accidentally removing another important device.
Removing any other device could interfere with the performance of
Windows.

On the Device Manager tab, double-click Other Devices, and then click
Canon BJC-55.

Click the Remove button.

Read the confirmation, make sure Canon BJC-55 is selected, and then
click the OK button.

Click the Close button.

Click the “x” in the upper right corner to close the System Properties
window.
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6 Disconnect the USB cable from the computer.
7 On the desktop, click the Start button, and then click Shut Down.

8 Click Restart and then click the OK button.

When the computer starts up, see the Quick Start Guide to install the USB
printer driver again.

B Application Error or General Protection Fault appears on the screen

An application error or general protection fault are Windows system errors. For more
details, see your Windows online Help.

v leditd (<]
This program has perfarmed an ilegal operation
and will be shut down

f the prablem persists, contact the program

wendor.
Detailz>>»

Check to see if you are using Windows 3.1 application software

If you use Windows 3.1 application software on Windows 95/98/2000, it may not operate
correctly and could cause an error. Use only Windows 95/98/2000 application software.
Contact the software manufacturer and inquire about an updated version of your Windows
3.1 software application.

Check to see if one of the following messages has been displayed

Cannot execute print due to insufficient memory.
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Refer to the software application manual for the amount of memory required to run the
program. Add more memory (RAM) if required. Shut down all other software applications
before you open the software application and try again.

Cannot execute background printing due to insufficient
memory .

Shut down all programs running in the background to free up memory.

Cannot execute print due to insufficient disk space.
Delete any unnecessary files to make room on the hard disk.

Check to see if there are any errors in the document
Try printing a newly created document.

Check to see if the printer driver has been installed properly

It is possible that the printer driver may not have been installed properly. Uninstall the
printer driver and re-install it from the beginning. See your Quick Start Guide for details.
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B Cannot print to the end of the print job

Part of the text is missing at the bottom of the last page printed and the following pages are

not printed.

Normal

Printer Features

B Simple, compact design

The light, yet sturdy construction of
the BJC-55 allows easy set up
and operation, even for beginners.

W Variety of print media

The printer produces superb color printing
on plain paper or coated paper like Canon's
High Resolution Paper, but for professional
jobs you may prefer one of the many special
media you can use with this printer, like
transparencies for OHP presentations, back
print flm, glossy photo paper, high gloss film,
or glossy photo cards.

B Drop Modulation Technology

The BC-11e Color BJ Cartridge and
BC-12e Photo BJ Cartridge employ
Canon’s new dual drop technology,
which produces fine halftones with
combinations of large and small dots,
resulting in truly stunning color
photographs on Canon special media
like high resolution paper, glossy photo
paper, or high gloss film.

W Easy operation

In the printer driver you only need to
select the BJ cartridge and type of
media for the print job to produce
sensational results. Printing on
special media like back print film was
never easier.

Abnormal (part of last page missing)

Printer Features

W Simple, compact design

The light, yet sturdy construction of
the BJC-55 allows easy set up
and operation, even for beginners,
and it will not require much space
in your work area.

W Variety of print media
‘The printer produces superb colour printing
on plain paper or coated paper like Canon
Linh Reenitinn anar HRAN it fr

W Drop Modulation Technology

The BC-11e Color BJ Cartridge and
BC-12e Photo BJ Cartridge employ
Canon'’s new dual drop technology,
which produces fine halftones with
combinations of large and small dots,
resulting in truly stunning color
photographs on Canon special media
like high resolution paper, glossy photo
paper, or high gloss film.

Problems and Solutions
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Check the printer and interface cable
Check the printer status and the interface cable connections.

® Check interface cable connections at the printer and computer
Check to see if paper or special print media you are using has been selected in the
printer driver

If you are printing on a paper size that has not been selected in the printer driver or the
software application, part of the text may be cut off.

* Use the selected paper size, or change the paper size selection in the software
application.

* Check the printer driver paper size selection and make sure that it is the same as
the paper size selected in the software application.

* |f the software application does not allow paper size selection, select the paper
size in the printer driver.
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Check to see if you have disrupted the infrared data transfer in progress or activated
another infrared communication device nearby

Do not disrupt the infrared communication between the printer data port and the computer
port. Any physical disruption of more than 10 seconds will cause cancellation of the print
job, and blank sheets will be ejected from the printer. Remove any physical object blocking
the line of sight between the infrared ports on the printer and computer.

Do not attempt to use other infrared devices nearby while a print job is executing. For
example, using electrical home appliances such as a remote controlled TV could disrupt the
infrared data transmission between the printer and computer and cause the print job to halt.
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B Paper does not feed manually

If you cannot feed paper or other media with manual feed, check the points below. Press
the RESUME button to resume printing after correcting the cause of the problem.

Is the paper set correctly?

* If the paper or media is curled, flatten it and align the left edge with the left side
of the front cover. Insert the sheet straight into the printer.

* Move the paper guide to the correct mark for the size of the sheet you are
loading.
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* Do not load the following type of paper in the Feed Slot.

Excessively thin paper (64 g/m? or less)

Excessively thick paper (106 g/m? or more)

Postcards

Thick envelopes (use only US Com#10 or European DL)
Punched or heavily embossed paper

* If the top edge of the sheet is too small or if the sheet is not straight, the printer
will beep once and the CHARGE/ERROR light will flash. Pull the sheet out of the
manual feed slot and try to insert the sheet straight into the printer with the left
edge aligned with the left side of the manual feed slot. When the paper is
inserted correctly, it will return slightly and the printer will not beep.

Is Auto Feeder selected for the Paper Feed in the printer driver?
In order to feed paper manually, Manual Feed must be selected in the printer driver.

Selecting Manual Feed | Windows )

Click Start, point to Settings, and click Printers.
Right-click the Canon BJC-55 icon and select Properties.
Click the Main tab.

Click the Advanced button.

A A QWO N =

Click the Quality tab.
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6 For the Paper Feed option

“Untitled” Properties

Hually | 8pecial Effects | Color | Save |

Color > | I Grayscale Print

BJ Cartridge:

Media Type: Plain Paper ™
Paper Feed M Al Feet
Print Quality

Fast Fine
Halitaning [V Auto:

%I’ Image Optimizer

D ™ Phato Dptimizer

I Whole Fage

il

Diffusiar

Firelfast] Fitie

Defaults

, select Manual Feed.

[2]x]

[ o |

Cancel | Help

Selecting Manual Feed | Macintosh )

1 From the File menu select

2 For the Paper Feed option,

Print (or similar command).

select Manual Feed.

Canon BJC-55 Version 3.6
(npies:El Pages: @ All (O From l:| To l:l
BJ Cartridge : Print Mode :
Media Type :

Plain Paper =

Manual =

Print Grayscale

Problems and Solutions
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B Printout rotated 90 degrees
If the printout is rotated 90 degrees, the Orientation setting is not correct.

Portrait orientation

ABC,Inc.
Annual Corporate Report
1999

Landscape orientation o

ABC,Inc.
nnual Corporate Report

Check to see if the correct Orientation has been selected
Select portrait if the text is printed in landscape orientation.

Selecting the orientation | Windows )

1 Click Start, select Settings, and click Printers.
2 Right-click the Canon BJC-55 icon and select Properties.

3 Select the Page Layout tab.
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4 Click Portrait to print lengthwise to the direction of paper feed.

Canon BJC-55 Propetties

i
o, Pl Paper Sze
= [Ceasaraaiom ¥

= el Defauks
0K Concel | il | Heb |

Note P Some software applications allow you to select the Orientation for the print
job. If you select the Orientation with the software application, you must
select the identical setting with the printer driver. If the software application

does not allow selection of the Orientation, you must use the printer driver
Orientation selection.
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Selecting the orientation | Macintosh )

1 From the File menu, select Page Setup.

2 For the Orientation setting, click the

Canon BJC-55 Version 3.6

B Vertical lines are broken
Vertical lines in the printed document are broken or jagged.

Make sure the BJ cartridge is correctly installed

Remove the BJ cartridge and install it correctly. Make sure the triangular marks on the
BJ cartridge and holder are aligned then press down gently on the raised side of the
BJ cartridge until you hear it lock in place.

Align marks
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Check the Print Quality setting
Use the Print Quality slide bar to select Fine.

Selecting Fine for Print Quality | Windows )

Click Start, select Settings, and click Printers.
Right-click the Canon BJC-55 icon and select Properties.
Select the Main tab.

Click the Advanced button.

A A QWO N =

On the Quality tab, drag the Print Quality slide bar completely to the right to
select Fine.

B [Standard] Properties

Quality |Specla\Elfecls| Color | Save |

B.J Cartridge: TN | [ Grapscale Print
Media Type: Plain Paper B

EoperFeed  [Manual Feed |

Print Quality:
Fast Fine
lftoni

g %l‘ Image Dptimizer
o

@l ' ? l' Photo Optiiast

Fie: Diffusisn

I~ | hole Page

Freffast]

Defaults
0K, I Cancel | Help |
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Selecting Fine for Print Quality | Macintosh )

A A QWO N =

From the File menu, select Print.

Under Print Mode, click the Manual icon.

Click the Details button.

Click the Quality icon.

Problems and Solutions

Drag the Print Quality slide bar completely to the right to select Fine.

Canon Detailed Setting

. @:Qualiw: Fast :0:. Fine

[ Photo Optimizer

D [0 Whole page

AP

o
ety Normal(Fast)
Spesial effects \
ﬁ; Halftoning : @
AAAAAA )
Color
Pattern Scatter

Restore Defaults -
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B BJ cartridge does not return to the home position after installation

After replacing the BJ cartridge or a BJ tank, the cartridge holder does not return to the
home position. When the CARTRIDGE button is pressed, the printer beeps but the POWER
light remains flashing.

Make sure the BJ cartridge is installed correctly
Turn the printer off, wait a few seconds, turn it back on, and then re-install the BJ cartridge.

® Changing or Replacing a BJ Cartridge

If the BJ cartridge and holder do not return to the home position, then remove the
BJ cartridge and install another BJ cartridge.
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B Cannot print via wireless infrared connections ( Windows )

The print job does not execute when the computer is set
up for a wireless infrared connection with the printer.

Make sure the infrared driver is installed correctly

The Microsoft Infrared Communication Driver must be installed to perform printing jobs via
infrared communication from the computer. Other infrared drivers may not operate correctly.
Make sure that the correct infrared communication driver is installed.

® Using Infrared Data Transmission

Note p Some computers may require adjusting a BIOS setting to enable infrared
communication. For details, see your computer documentation.

Make sure an infrared communication driver can be used

Open the Infrared Monitor and verify that the infrared communication has been enabled and
that the printer has been detected.

Confirming the infrared connection

1 Click Start, select Settings, and click Control Panel.
2 Double-click the Infrared icon.

3 Select the Options tab.
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4 Click the check box on for “Enable infrared communication.”

5

Note P

B Infrared Monitor

Statug ;| Ur I Preferences] \danlilicatiom]

(IV Enable infrared communicatiun.)

Providing application support on COM4 and LPT3

¥ Search for and provide status for devices within range.

Search every |3 3: seconds.
(F Limit connection speed to: )

V¥ Irstall software for Plug and Play devices within range.

Fiestore Defaults
0K | Cancel | ‘ Help |

Check the connection speed to see if it is checked off.

The operation of some computers could be unstable if the connection
speed is set for 4Mbps. Click the “Limit connection speed to” check box on,

and then select 115.2kbps from the drop-down list box.

Is the printer positioned at the correct distance and angle from the computer?

The printer must be located at the correct distance and angle from the computer in order for
the infrared interface to operate correctly.

® Using Infrared Data Transmission
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Check to see if you are using anything other than PC/AT compatible
The computer must be PC/AT compatible to print using infrared communication.

Make sure the correct port is selected to receive data

Make sure that COM4: (Infrared Serial (COM) Port) is selected in the data receiving printer
port to print by infrared communication. Selecting any port other than this port may cause
an error.

Note P The number of the serial port (COM4) may differ, depending on the
operating system environment.

Selecting the infrared transceiver port

1 Click Start, select Settings, and click Printers.
2 Right-click the Canon BJC-55 icon and select Properties.

3 Click the Details tab.
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4 Click the down-arrow for “Print to the following port” and select
“COM4: (Infrared Serial (COM) Port).”

Canon BJC-55 Properties [Z]

@Fage\_ayuut | @Stampr‘Backgmund | m Maintenance |
General Details | Color Management | 5 Main

~% CanonBJCES

ddPat. |

Delet Part
New Driver.

COMd: (Infrared Serial [COM) Port)
FILE: [Creates a file on disk]
LPT1: [ECP Printer Port)

LPT3. [Infiared Priting [LPT| P

Timeout setting

Not selected 15 secands
Transmission tetry: [45 seconds

Spool Satings.. | | PortSetings.. |

T = A |

Make sure the BJC-55 is connected properly with the computer via infrared port

Confirming correct infrared connection

1 Click Start, select Settings, and click Control Panel.

2 Double-click the Infrared Monitor icon.

Troubleshooting 301



Problems and Solutions

3 Make sure that BJC-55 is listed as the currently active infrared device.

M Infrared Monitor HE

Opliohs | Preferences | |dentification |

} 1 One available infrared device is within range.
Searching for devices within range every 3 seconds.

Software for Plug and Play devices within range will
install automatic:ally.

Avwailable infrared devices within range:
BJC-55

oK I Cancel | pmly | Help |

If you do not see BJC-55 displayed, first check the area between the computer and the
printer and make sure nothing is blocking infrared communication. If nothing is between the
printer and computer, press the POWER button to turn off the printer, and then disconnect
the power cord and remove the battery. Next, re-install the battery, connect the power cord,
press the POWER button to turn on the printer, and then execute the print job again.
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B Paper skews or jams during feeding
If a sheet of paper skews and jams, a message is displayed:

Paper Jam!

Make sure the paper is set correctly in the paper feed slot
® Loading Paper in the Printer
Removing a paper jam
1 Gently pull the paper out of the printer with one hand while holding the

printer in place with the other. You can pull the paper out from the front or
the back of the printer.

2 If the paper tears off inside the printer, turn off the printer and open the top
cover. Remove the remaining paper, taking care not to touch the film cable.
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3 Press the POWER button to turn on the printer again. The printer is now
ready to print.

4 Open the top cover and check the platen. If the platen is soiled and the
reverse side of your output is stained with ink after a paper jam occurs,
clean the platen inside the printer.

B Cleaning the Printer

* If paper jams occur repeatedly, you may be loading the paper
incorrectly, or using the wrong kind of paper.

* Make sure that you are loading and feeding the paper or special media
correctly.

® Paper Handling

Make sure paper is feeding straight into the printer
If the sheet of paper is not inserted straight, the sheet will be returned without feeding into
the printer. Insert the sheet straight into the printer.

After inserting the sheet into the printer until it stops, hold it in place for about two
seconds

The sheet may not feed straight if you do not hold it in position for at least two seconds, or if
you do not hold it steadily in position.

Make sure a foreign object is not blocking the feed slot
Check the feed slot. If something is blocking the feed slot, remove it.
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Make sure the printed sheets are not sticking to the surface below due to static cling
Static cling between the sheet and the surface of the desk or work table could stop feeding,
causing the printer to print repeatedly over the same area without advancing the paper,
especially when using High Gloss Film or Back Print Film. When printing with these special
media, set a sheet of plain paper in back of the printer where the sheets are ejected before
starting the print job.

B Screen colors and the printed colors do not match

The colors on the printout are unsatisfactory. For example, on-screen blue is printed purple
or deep red, or on-screen light green appears deep green or weak yellow (strong red). Light
green appears deep green (weak yellow).

Determine if the print head needs to be cleaned

The print head could be clogged or the ink may have run out when the colors on the printout
do not match the screen.

1 Print a Nozzle Check Pattern.
» Printing a Nozzle Check Pattern

2 Clean the print head.
® Cleaning the Print Head
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Determine if only certain colors are unsatisfactory
Adjust the printer driver color setting to match the colors.

Adjusting the color | Windows )

1

O O K ON

Click Start, select Settings, and click Printers.

Right-click the Canon BJC-55 icon and select Properties.
Select the Main tab.

Click the Advanced button.

Select the Color tab.

Click the Color Adjustment box; make sure a check mark appears.

B [Standard] Properties
Gual\ty] Special Effects  Color ISave }
Cl Celey A - \
Color Balance:
Cyan o [T — o

Magents 0 4f [
Yellow 0 i
Black: 0 A [—
Dulput Style Aula -

Erightrigss Harmal y
Intensity 0 - —
Defaults

oK Cancel | Heb |
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Adjusting the color | Macintosh )
From the File menu, select Print.
Under Print Mode, click the Manual icon.

Click the Details button.

AR WO N =

Click the Color icon.

Canon Detailed Setting

Color Correction : m

Matching Method :
Quality Printer Profile :
[0 Gamma Correction: 1.4

Special effects ColorBalance : T —— Cyan
. 0 t:ém_ Magenta
Color 0 ———— vellow

0 :_ Black

Density: 0 :4_
% Restore Defaults

B Document prints in black only
A document that contains colored text or images prints only black ink.

Check to see if the BC-11e Color BJ Cartridge is installed

Press the CARTRIDGE button to move the cartridge holder to the center and then open the
top cover to see if a BC-11e Color BJ Cartridge is installed. Always use a BC-11e Color
BJ Cartridge for color printing.
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Make sure that Grayscale Print is turned off

While Grayscale Print is selected, all colors will print in black and white. For color printing,
click the Grayscale Print box to remove the check mark.

Turning Grayscale Print off | Windows )

A WO N =

Click Start, select Settings, and click Printers.

Right-click the BJC-55 icon and select Properties from the pop-up menu.

Select the Main tab.

Click the Grayscale Print box to remove the check mark.

Canon BJC-55 Properties HE!
%5 Pagelayout | (&) Stamp/Backgiound | #} Maintenance |
Geneial | Detals | ColrManagement & Main

Chaase Fiint Made:
i i,
— Drsit Photn  SupsiPhota
o
BJ Catidge: | Color il' B[aysn:aleprint)
MediaType: | Plain Paper |
Fage Size Letter
Origntation: Paortrait
Piirting Type: Mormak-sias Prirting
Al Diectiors Portrsit
Feed  ManuslFesd - T
Backaroundt Mores
Advanced.. | About | Defaits |
0k | Concel | amb | Hep |
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Turning Grayscale Print off ( Macintosh )

1 From the File menu, select Print.

Problems and Solutions

2 Inthe Print dialog box, click the Print Grayscale box to remove the check

mark.

Canon BJC-55

Version 3.6
ersion ”ﬁl

(npies:El Pages: @ All ) From To

Bl Cartridge :

Print Mode :

[Cnlor

Media Type :

III (o

[Plain Paper L] Wt Sattings :Text
Paper Feed: : it Qu |gt)‘c: rmaiFast : -
[Manua 2] Color Correction B Standard AP

[] Print Grayscale

Make sure the color settings are correct in the software application

Some application software may contain a dialog box with an option to select black and
white only. Change this setting to enable color printing.

Make sure the BJC-55 is selected as the default printer

Select the Canon BJC-55 as the default printer.
® Selecting the BJC-55 as the default printer
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B Colors are broken or uneven
Printed colors are faded, broken or uneven, compared to the colors on the screen.

Make sure the correct BJ cartridge and media type are selected for the print job

Check the printer driver settings, and make sure that the correct BJ Cartridge and Media
Type settings are selected for the print job.

Selecting the BJ Cartridge and Media Type | Windows )

1 Click Start, select Settings, and click Printers.

2 Right-click the BJC-55 icon and select Properties from the pop-up menu.
3 Select the Main tab.
4

Select the BJ Cartridge and Media Type for the print job.

Canon BJC-55 Properties

2 Pagelayout | ) Stamp/Backgiound | i Maintenance |
General | Detals | Color Mansgement 3 Main

Choose Print hade:

<
BJ Cartridge: Color -
Media Type: | Plain Paper ] |

Page Size Letter

Drientation: Portrait

Finting Type: Namal-size Printing

Feed Manual Feed e Nore

Background: None

sanced.. | epot. | Defauts |

0K | Concel | gepb | Hep |
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Selecting the BJ Cartridge and Media Type | Macintosh )

1 From the File menu, select Print.

2 In the Print dialog box, select the BJ Cartridge and Media Type for the
print job.

‘Canon BIC-55

Version 3.6
Copies : - Pages: @Al ) From l:l To l:l

ﬁ] Cartridge :

Media Type :

ode :

s Test

ren a
uality - Hormal(Fast) Options...

—————— |
Pl

PaperFeed: Pn Seatt
e

ing er
alor Correction : B) Standard Apply.

Manual *

[ Print Grayscale

Make sure that Canon BJ tanks are installed in the BJ cartridge

The color quality may degrade if you use ink from other manufacturers. For best quality, use
Canon BJ tanks.
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B Printing beyond the edge of a page, or portions of a printed page

are missing

The print start position is incorrect, causing the end of the page to extend onto the next
sheet. If the print start position is incorrect, this can cause the print area to shift and appear
out of position at the top, bottom, left, or right on the printed sheet.

Determine if you are printing on a paper size different from what is selected in the

application software

Make sure you use the paper size selected in the software application. Select the correct
paper size setting in the software application.

Selecting the paper size

Setting the correct margins in the software application ensures that the
print area will be centered on each page of the document. For details about
setting the margins for a document, refer to your software application
documentation.

Top margin

I

Left margin |«

|

Bottom margin

Right margin
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¢ If the print area shifts to the top, increase the top margin, and
decrease the bottom margin.

* If the print area shifts to the left, increase the left margin, and
decrease the right margin.

* If the print area shifts to the bottom, increase the bottom margin, and
decrease the top margin. (If the bottom margin is not adjustable in the
software application, then reduce the number of lines on a page to
increase the bottom margin.)

* If the print area shifts to the right, increase the right margin, and
decrease the left margin. (If the right margin is not adjustable in the
software application, then reduce the number of characters in a line of
a text to increase the right margin.)

Determine if you are printing on a page size different than the page size selected in
the printer driver

The print area will shift to the top left if you are printing on a paper larger than what is
selected in the printer driver, and will shift to the bottom right if you print on a paper size
smaller than what is selected in the printer driver. Select the paper size in the printer driver.

Determine if the Scale print option is selected

If you are attempting to execute a Scale print, make sure the rate of enlargement/reduction
is set correctly and make sure that the Paper Size selection is correct.

Determine if you are printing on a paper size shorter than what is selected in the

software application
Make sure you use the paper size that is selected in the software application.

Troubleshooting 313



Problems and Solutions

Determine if the top margin value in the software application is too large

Reduce the top margin value to the minimum allowed by the software application. If this is
not possible, then reduce the number of lines allowed per printed page. Refer to your
software application documentation for details.

B Printer does not turn on
The POWER light does not come on when you press the POWER button.

Check the printer and power cable

* Make sure that the lock switch is set to the right.
* Press the POWER button again to see if the POWER light comes on.

* [f the power outlet is overloaded, then the printer will automatically turn off. If this
occurs, unplug the printer and wait a few moments and plug it in again.

* Plug other electrical appliances into the same power outlet to see if it is working.

* Connect the power cord to the printer and plug in the power cord to the power

outlet securely.
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Make sure the battery is fully charged

When you are using the printer on battery power only, you cannot turn on the printer if the
battery is low. With the battery installed in the printer, connect and use the AC adapter.

Make sure the Power Lock switch is not set in the LOCK position

If the Power Lock switch is set forward in the LOCK position, the printer will not turn on even
if you press the POWER button. Slide the Power Lock switch to the unlock position.
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B Printer seems to be working but nothing prints
The printer is operating but only blank pages are ejected.

Remove the BJ cartridge and make sure that the orange protective tape was
removed from the print head

The ink will not flow with the orange protective tape attached. Make sure the orange tape is
removed before installing a BJ cartridge in the printer.

Do not touch the
print head area or
electrical contacts.

Orange
Protective Cap

Orange
Protective Tape

Print a nozzle check pattern
Print a nozzle check pattern to confirm that the print quality has been restored.

® Printing a Nozzle Check Pattern

If the nozzle check pattern prints ...

A problem probably exists in the interface cable connection, the infrared
communication environment, or software application.
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If the Nozzle Check Pattern does not print ...

Execute a print head cleaning and deep print head cleaning.
B Cleaning the Print Head

If the printing cannot be restored after five print head cleanings then the ink
may have run out. Replace the BJ tank with a new one.

® Replacing BJ Tanks

B Print job halts
The print job halts before it has completed.

Determine if the print job contains a large color image

High resolution pictures or images could cause the print job to pause temporarily due to the
time required to process the large amount of data being sent. The print process should
resume normally.

Check for the following message

Paper Jam!

A sheet of paper is jammed in the printer. Remove it to resume printing.

®» Removing a paper jam
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Determine how long the printer has been in constant operation

Continuous printing for an extended length of time could cause the print head to overheat
and cause it to stop. The print head will stop for a few moments at the end of each pass to
allow it to cool off after it has become overheated.

During heavy duty printing of large areas of dark color, the printer may automatically halt to
protect the print head from damage. In such a case, further printing is not possible until the
print head has completely cooled. Turn off the printer and wait approximately 15 minutes.

A\ Caution| |fthe print head has overheated, do not touch the print head until it has
cooled.

If you are using the infrared interface, make sure there is not an obstacle between
the printer and the computer

When you use the infrared interface for printing, the area between the printer and the
computer must be free of any obstacle that could interfere with the line-of-sight
communication between the computer and printer. Remove any obstacles.
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B Printing blurred or smudged

Determine if you are printing on plain paper with Print Quality set for Fine

Printing in the Fine mode could result in excess ink on the paper. Reduce the print quality to
avoid blurring or smudging.

® Printing With Windows 98 or Windows CE
® Printing With Windows 2000
® Printing With Macintosh

Check to see if the paper thickness is within the specified thickness
Do not use paper thicker than 28 Ib. (105 g/m?) to avoid blurring or smudging on the paper.

Determine if the document exceeds the recommended print area

Adjust the setting to print within the recommended print area. Printing outside the
recommended printing area could cause blurring or smudging.

® Printing Area

If you are using glossy paper, make sure that you print on the glossy side only
Always load glossy paper with the glossy side facing up.

Check to see if the paper is curled or bent
To remove the curl, bend the sheet gently in the direction opposite the curl.
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B Printout is excessively curled
The printed sheet is excessively curled, wrinkled, or warped.

Determine if you are printing an image or picture that has dense colors

Printing an image or picture with dense colors requires a large amount of ink and could
curl or wrinkle the paper. For such print jobs, use High Resolution Paper or Glossy
Paper. These sheets have specially coated surfaces designed to increase the absorption
of the ink, which avoids curling or wrinkling.

Note P Special print media must be printed on the correct print side.
® Media You Can Use With This Printer

Check Intensity setting in the printer driver
To reduce wrinkling and curling, reduce the amount of ink used in the print job.

Lowering the Intensity setting | Windows )
1 Open the printer driver.
2 On the Main tab, click the Advanced button then select the Color tab.

3 Slide the button on the Intensity slide bar to the left to reduce the amount of
ink used in the print job.
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Lowering the Density setting | Macintosh )

1 From the File menu, select Print.

2 Inthe Print dialog box, click the Manual [&] icon then click the Details
button.

3 In the Detailed Setting dialog box, click the Color icon.

4 Drag the button on the Density slide bar to the left to reduce the amount of
ink used in the print job.

B Battery is not charging

You have been using the printer and you want to charge the battery but you cannot
proceed. The AC adapter is connected to the printer and plugged into a power outlet, but
the CHARGE/ERROR light is not green.

Check to see if you are executing a long print job

After prolonged use, the printer may heat up and not allow you to recharge the battery for
about 30 minutes until the printer has cooled. Wait for the printer to cool, then try to charge
the battery again.

Troubleshooting 321



Problems and Solutions

B CHARGE/ERROR light is orange

The orange CHARGE/ERROR light comes on, the printer beeps, and the printer does not
operate.

The printer will beep when an error occurs and the orange CHARGE/ERROR light will
come on or flash to let you know when and what type of error has occurred. You may need
to turn the printer off and turn it on again in order to identify the problem.

CHARGE/
ERROR Beeps Meaning Solution
Light
Lights and | 1 Paper not set in feed slot | Remove the paper from the feed slot and load it correctly.
remains on correctly
2 Paper jam Remove the paper jam.
3 BJ cartridge not installed | Install a BJ cartridge correcily.
4 Correct BJ cartridge not | Replace with a correct BJ cartridge.
installed
6 Battery is not installed Install the battery pack.
correctly

1 long, Battery is nearly dead Charge the battery as soon as possible.
1 short
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CHARGE/
ERROR Beeps Meaning Solution
Light
Flashing 1 Paper not set in feed slot Remove the paper from the feed slot and load it correctly.
correctly
2 Ink is low When the low-ink warning is on, this alert appears. Press
RESUME to continue. Replace the BJ tank as soon as possible.
Also, at the same time reset the low-ink warning counter.
3 BJ cartridge is being When BJ cartridge is replaced, press the RESUME button to
replaced resume printing.
Battery is low Change the battery pack.
Waste ink absorber is full You may be able to print by pressing the RESUME button but
the waste BJ tank needs to be replaced soon. Call the Canon
Customer Care Center.
= Before You Call For Service
6 Battery is damaged Turn off the printer then turn it on again. After turning the printer
off and on, if the problem persists, remove the battery and
replace it with a new one.
Both 1-7 An error occurred inside the | A serious error may have occurred. Turn off the printer. Wait
CHARGE/ 9-11 printer several minutes, then turn it back on. If the error still persists,
ERROR and call the Canon Customer Care Center.
POWER ® Before You Call For Service
lights flash-
ing 8 Printer is overheated A serious error may have occurred. Turn off the printer for

approximately 15 minutes and then turn it back on. If the error
persists, replace the BJ cartridge. If this does not correct the
problem, call the Canon Customer Care Center.

= Before You Call For Service
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The following messages may also be displayed in the BJ Printer Status Monitor.

Waste ink absorber full! Call for service!
Service error xxx! Call for service!

Make sure that the paper is set correctly

The orange light will flash and the printer will beep to alert you that the paper has not fed
into the printer. If there is no paper in the sheet feeder, then load some paper. If the paper is
not straight in the sheet feeder, then straighten it and try again.

Check to see if the following message is displayed on the screen
Paper Jam!
If paper is jammed inside the printer, the printer will beep twice and the orange CHARGE/

ERROR light will flash. Remove the jammed paper and set a new sheet of paper to resume
printing.

® Loading Paper in the Printer

Check to see if the BJ cartridge has been removed

If the BJ cartridge has been removed during printing, or if the BJ cartridge failed electrically,
the printer will beep three times and the orange CHARGE/ERROR light will flash. Re-install
the BJ cartridge in the cartridge holder if it has been removed, or install a new BJ cartridge
to resume printing.

® Changing or Replacing a BJ Cartridge
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Check to see if you have installed the wrong BJ cartridge for the print job

If the BJ cartridge is not appropriate for the print job, or if you attempt to start a print job with
the optional Scanner Cartridge installed, the printer will beep 4 times and the orange
CHARGE/ERROR light will flash. Install the correct BJ cartridge to resume printing.

Check to see if you have removed the battery pack

If the battery pack is not installed correctly, the orange CHARGE/ERROR light comes on
and the printer beeps 6 times. Make sure the battery pack is installed correctly.

Check the ink level in the BJ tanks

If the low-ink alert has been turned on, the orange CHARGE/ERROR light will flash and the
printer beeps twice. You can continue the print job until the ink runs out by pressing the
RESUME button, but immediate replacement of the BJ tank is recommended. Use the
printer driver or the printer’'s operation panel to reset the low-ink alert after replacing the
BJ tank.

® Using the Low-Ink Alert

Check to see if you have stopped the BJ cartridge replacement

If you discontinue the BJ cartridge replacement, the printer will beep 3 times and the
orange CHARGE/ERROR light will flash. Press the CARTRIDGE button to continue

BJ cartridge replacement. If you intend to use the printer in this situation, then press the
RESUME button.

Check to see if a long print job has been executing on battery power only

When the battery power runs low, the printer emits alternate long and short beeps and the
CHARGE/ERROR light comes on. Turn off the printer. Connect the AC adapter to the
printer then plug it into a power outlet, or remove the battery and install a charged battery.
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B “Error Number: *300” appears on the screen and print job does

not execute Macintosh )

This is a Macintosh error message where the * is replaced with a letter.

Make sure that the printer is turned on
Make sure that the POWER light is green. When the POWER light is flashing green, the

printer is warming up. Wait a few moments for the POWER light to stop flashing. The printer
is ready when the green POWER light remains on.
® Printer does not turn on

Check the printer and the interface cable
Check the printer status and the connection of the printer interface cable connections.

B Check interface cable connections at the printer and computer

Check to see if the background printing is operating properly
Follow this procedure to disable background printing and try to execute the print job again.

1 From the Apple menu, choose Chooser.

2 Click the BJC-55 icon.
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3 Click the Backgrounding button off.

Note P If you cannot execute background printing, correct this problem as soon as
possible.

B Cannot execute background printing
Make sure that the printer driver has been installed correctly

There may be a problem with the printer driver. Uninstall it and install the printer driver
again.

The problem may exist within the printer driver. Uninstall the printer driver and re-install it.
® Printing With Macintosh
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B “Type x Error” appears on the screen ({Macintosh)
This is a Macintosh printer error where “x” is replaced with a number.

Determine if any other software applications are open

If you are running other software applications during a print job, it is possible that the
required amount of memory may not be available for the print job and result in this error.
Close all software applications and start the print job again.

Determine if sufficient memory is available

Refer to the application software manual to verify that you have enough memory to run the
software application. If you do not have sufficient memory, add memory (RAM). Refer to
your computer documentation for details about adding memory.

Check to see if there is sufficient available space on the hard disk of your computer

An error could occur if there is not enough space available on the hard disk of your
computer. Secure enough hard disk space by deleting unnecessary files to create enough
space for the creation of temporary files during printing.

Determine if there is any problem with the document file

If unknown characters and letters are printed only for a specific document file, then the
problem may exist within that file, or the software application that you are using. In this
case, try typing the same text in a newly created file. If the new document prints normally
then the problem exists in the original document file. If the same problem occurs with the
new file, call the Canon Customer Care Center.

® Before You Call For Service

® Getting Help From Canon
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Determine if the printer driver has been installed properly

There may be a problem with the printer driver. Uninstall it and install the printer driver
again.

The problem may exist within the printer driver. Uninstall the printer driver and reinstall it.
® Printing With Macintosh

Determine if any special extension files or control panel options are in use

The printer driver could conflict with a non-Apple generated file extension or a control panel
option. Use the Extensions Manager to change the configuration to eliminate any conflicts.

B Cannot execute background printing

Make sure that background printing has been turned on
If you cannot execute background printing, this feature may have been turned off.

Turning on background printing | Windows )

1 Open the printer driver.
2 Select the Page Layout tab.

3 Click the Background Printing box; make sure a check mark appears.
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Turning on background printing | Macintosh )

1 From the Apple menu, choose the Chooser.
2 Click the BJC-55 icon.
3 Click the Backgrounding button to turn it on.

If background printing has been turned on, there may not be enough :
space on the disk to create temporary files for printing Macintosh )

Check to see if there is sufficient empty space on the hard disk of your computer.

Background printing cannot be executed if there is not enough free space available on the
hard disk of your computer. If there is not enough space available on your hard disk, secure
enough hard disk space by deleting unnecessary files.
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B Cannot select the printer driver in the Chooser {Macintosh)
Check the following items if you cannot select the printer driver in the Chooser.

Make sure the printer is turned on

Make sure the printer is turned on and the POWER light is green. If the green light is
flashing, then the printer is warming up. Wait a few moments for the printer to finish
warming up.

® Printer does not turn on

Check the printer and the interface cable connections
® Check interface cable connections at the printer and computer

Make sure that the printer driver has been installed correctly

There may be a problem with the printer driver. Uninstall it and install the printer driver
again.

The problem may exist in the printer driver. Uninstall the printer driver and reinstall it.
® Printing With Macintosh

Make sure the server is turned on in the networking environment
® Printing With Macintosh

Determine if there is a problem with the networking environment
If necessary, call the system administrator.

® Printing With Macintosh
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Before You Call For Service

Before you call for service, please gather some information that will help the Canon
Customer Care Center find a solution for your problem.

Work through the troubleshooting descriptions of problems and solutions to attempt to solve
the problem. If you cannot solve the problem, follow the steps below and prepare answers
for some basic questions you may be asked by the technician.

B Describing the Problem
* Write a short memo describing the problem.

* Note any error messages that were displayed on the screen.

* Make sure you have all the important information about your system (amount of
memory, free disk space, current version number of the printer driver).

® Describing Your System
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B Describing Your System

Follow the simple procedures below to obtain the important information about your
operating environment and printer driver that you will need before you call for service.

Obtaining the OS version number and amount of memory ( Windows )
1 Right-click the My Computer icon.

2 Select Properties from the pop-up menu.

3 From the General tab read and write down the version number of your
operating system and the amount of memory (RAM) installed.

System Properties HE

{ieneral | Devies Mansger | Herdnare Profles | Performance |

, System: \
Microsoft \windovss 98

410.1938
Redistered to:
Raulie . Schnee

Argot Associates
—_— 79676-025-1872476-08425

Computer.
Genuinelntel
Pentiumir) Processor

Itel MMX[TM) Technlogy
\ 32.0MB R&M /

Cancel
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Obtaining the OS version number and amount of memory ((Macintosh)

1 From the Apple menu, select About This Computer.

2 Write down the version number of your operating system and the amount of
memory (RAM) currently installed.
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Determining the amount of free disk space available ( Windows )
1 Double-click the My Computer icon.

2 Right-click the Hard Disk icon.
3 Select Properties from the pop-up menu.
4

Write down the number for the amount of “Free Space” on the disk.

[C:) Properties HE
Gereral ITDD\S | Sharmgl Eomplessmnl
Label:
=
Type: Lacal Disk

File system:  FAT

. Used space: 1.476,820,992 bytes 1.37G8
|_ Free space: BB9.777.920 bytes E3BME

Capacity: 2.146,598,912 bytes 1.99G8

-

Drive C Disk Cleanup...

ak I Cancel | Spply |
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Determining the amount of free disk space available ((Macintosh)

1 On the desktop, click the Macintosh HD icon.

2 From the File menu, select Get Info., then select General Information.

3 Write down the number for the amount of “Available disk space”

=BIC-55 Info

3h HD: System Folder Extensions:

Created: Wed, June 2, 2000, 0:00

Modified: Tue, June 29, 2000, 16:51

ion: 320801, Copyright CANDN INC. 1996-1399
A1 Rights Reserved
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Obtaining the version number of the printer driver ( Windows )

1
2

Click Start, select Settings, and click Printers.

Right-click the Canon BJC-55 icon and select Properties from the pop-up

menu.

Select the Main tab.

Click the About button.

Write down the version number.

Microsoft Windows 98

Canon Bubble Jet Printer Driver
Wersion 6.40GE
Copyright CANOM INC. 1334-2000
All Rights Reserved.

Before You Call For Service
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Obtaining the version number of the printer driver ((Macintosh)

1 On the desktop, double-click the icon of the startup disk (Macintosh HD for
example).

Double-click the System folder.
Double-click the Extensions folder.
Select the BJC-55 icon.

From the File menu, select Get Info.

S G A QN

Write down the version number of the printer driver.

O=———8IC-55Ino=—"—8H

[Bic=55 |

Canon BJ Printer Driver

Show:| General Information | 3

Kind:Ch

Size: 990 Kendisk (1,008,146 bytes)
Where: Macintosh HD: System Folder: Extensions:

Created: Wed, Apr 12, 2000, 4:05 PM

Modified: Thu, 4pr 13, 2000, 6:33 PH

Yersion: 3.61Ba2, Copyright CANON INC. 1996-2000
Il rved

&l Rights Rese

Label:[Nene | +]
Comments:
[ Locked
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Getting Help From Canon

Canon Computer Systems, Inc. offers a full range of customer technical support* options

including:

Note P

For e-mail technical support, the latest driver downloads and answers to
frequently asked questions (www.ccsi.canon.com)

24-hour, 7-day-a-week, automated support for troubleshooting issues on most
current products (1-800-423-2366)

24-hour, Fax-On-Demand System for product specifications and technical
information (1-800-526-4345)

Free technical support Monday-Saturday (excluding holidays) for products still
under warranty™*

(1-757-413-2848)

Technical support 7 days a week (excluding holidays) for products no longer

under warranty, for $24.99 per call (1-800-423-2366), or for $2.50 per minute, to
a maximum of $25.00 per call (1-900-246-1200)

For information about extending your Canon service and support up to an
additional two years, call 1-800-385-2155, or visit our Web Site at
www.ccsi.canon.com (within 90 days from the date you purchase your Canon
peripheral).

Within Canada, call for technical support 24 hours a day, 7 days a week
(1-800-OK-CANON)

* Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.
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Servicing the Printer

Your Canon printer is designed with the latest technology to provide trouble-free operation.
The warranty card that comes with the printer describes Canon’s limited warranty. Be sure
to read the warranty information to find out about the different service options that are
available to you.

Note Pp Save your sales receipt for proof of purchase. In the event that your
printer needs service, you will need your proof of purchase to obtain
warranty service.

Be sure to complete Electronic Registration or to fill out the Registration Card and send it in.
This will help Canon give you better support service.

If you seem to have a problem, try to solve it by referring to the troubleshooting information.
If you cannot solve the problem, contact the Canon Customer Care Center.

If you feel your printer needs servicing, contact Canon on the World Wide Web to locate the
Canon Authorized Service Facility (ASF) nearest you. If you do not have access to the Web,
you can call Canon.

B Getting Help From Canon
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Printer Specifications
BJ Cartridges
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Printer Specifications

Printing Method Serial Bubble Jet
Resolution (max.) 720 x 360 dpi (horizontal x vertical)
Paper Handling Manual Feed
Auto Feed, with optional ASF-50 Auto Sheet Feeder installed
Print Speed BC-10 Black BJ Cartridge:
Up to 5.5 ppm
BC-11e Color BJ Cartridge:
Up to 2 ppm
Printing Direction Uni-directional (or bi-directional, depending on data format)
Print Width (max.) 8in. (203 mm)
Line Feed Speed Approx. 70 ms/line (4.23 lines) at 1/6 inch line
Line Feed Pitch 1/6, 1/8, n/180, n/360 (where “n” is programmable
and 1in./25.4 mm)
Character Pitch 10 cpi, 12 cpi, 15 cpi, proportional
Cell composition 36 (H) x 48 (V) dots 10 cpi

30 (H) x 48 (V) dots 12 cpi
24 (H) x 32 (V) dots 15 cpi
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Printer Specifications

Characters per Line (max.) 10 cpi 80 chars./line
12 cpi 96 chars./line
15 cpi 120 chars./line

proportional 68 to 160 chars./line

Graphic Image Print Data format 8, 24, 48 dot format (vertical)
Resolution 60, 80, 90, 120, 180, 240, 360 dpi (horizontal)

Buffer Any setting selectable but disabled when using infrared data
transmission
Input buffer  approx. 25 KB, no download buffer
Input buffer  approx. 2 KB, with 23 KB download buffer

Interfaces Universal Serial Bus (USB)
IrDA Ver. 1.1 (4M) Infrared
Acoustic Noise Level Approx. 43 dB (A)
Operating Environment Temperature 41 to 95°F (5 to 35°C)
Humidity 10 to 90% RH (without condensation)
Storage Environment Temperature 32 to 95°F (0 to 35°C)
Humidity 5 to 95% RH (without condensation)
Power Source Universal AC Adapter AD-360U connected to power source
AC 100V 50/60 Hz
Power Consumption Standby 26 W
Printing 23 W (max.)

Charging Approx. 10 W
(Approx. 30 W using Universal AC Adapter)
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Dimensions
(W x D x H)

Weight

B Battery Pack
Type
Voltage level
Size

Weight

Printer Specifications

11.9x 4.4 x 2.0 in.
(302 x 112.5 x 50 mm)

Approx. 2.0 Ib. (0.9 kg) with BJ cartridge and battery pack
installed

Lithium-ion battery

10.8V DC

8.4x 1.1 x0.8in.(213.3 X 28.5 X 20.6 mm)
Approx. 0.35 Ib (160 g)

B Universal AC Adapter AD-360U Specifications

Dimensions
(W x D x H)
Weight
Rated input
Rated output

2.3x4.6x1in.

(58 x 118 X 25 mm)
Approx. 0.45 Ib (205 @)
AC100 to 240V
DC13V 1.8A
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BJ Cartridges

BC-10 Black BJ Cartridge

BC-11e Color BJ Cartridge

BC-12e Photo BJ Cartridge

Cartridge
Ink color
BJ tank
Capacity

Cartridge

Ink color
BJ tanks
Capacity
Black
Color

Cartridge

Ink color

BJ tanks

128 nozzles

Black

BCI-10 Black BJ Tank

3000 pages @ 5% coverage

64 nozzles for black

24 nozzles each for cyan, magenta, yellow

Black, cyan, magenta, yellow

BCI-11 Color and Black BJ Tanks

60 pages @ 3.75% coverage
80 pages @ 3.75% coverage

64 nozzles for photo black

24 nozzles each for photo cyan,

photo magenta, yellow

Photo black, photo cyan, photo magenta,

yellow

BCI-12 Photo Color and BCI-12 Photo Black

BJ Tanks
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Paper Specifications

B Paper Size

Letter

Legal

A4

A5

B5

US Commercial 10 envelope

European DL size envelope

8.5x11in.
8.5x 14 in.
210 X 297 mm
148 X 210 mm
182 X 256 mm
9.5x4.1in.

220 x 110 mm
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Paper Specifications

B Paper Type

Media Name Media Type Setting
Plain paper Plain Paper

Back Print Film Back Print Film
Brilliant White Paper Plain Paper

Bubble Jet Paper Plain Paper

Glossy Photo Cards Glossy Photo Cards
Glossy Photo Paper Glossy Photo Paper
High Gloss Film High Gloss Film

High Resolution Paper High Resolution Paper
Transparency Transparency

B Paper Weight
17 to 28 Ib. (64 to 105 g/m?)

Specifications 347



Printing Area

This section describes the dimensions of the printing areas for print media. The shaded
portions in these illustrations show the recommended printing areas for paper, envelopes,
and special media, determined by how the media is fed to the printer for printing. Print
quality could degrade if you print beyond the recommended margins.

Letter or Legal size A4/A5/B5 size Glossy Photo Card
4.70 in. (119.6 mm)
| 8.5in. | 210/148/182 mm 1 Fossin@mm] [
4
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Printing Area

Custom size

3.94-9.50in. 0.12in. 0.87 in.

(100.0 -241.3mm) | (3mm)* (22 mm)

3.94 - 23.00 in. 0.28in. 4 (gfzni:]')

(100.0 — 584.2 mm) y (7 mm) YT oi3m J

(3.4 mm)
Right Margin for Custom Size

Paper Width > 8.27 in. (210 mm) Paper width - 8.0 in (203.2 mm) - Left margin width
Paper Width < 8.27 in. (210 mm) 0.13in. (3.4 mm)
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U.S. Commercial No. 10

European DL

9.5in
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direction
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Printing Area

Specifications

350



Using the Optional IS-12 Color Image Scanner Cartridge

Using the Scanner

Using the Scanner With Windows
Using the Scanner With Macintosh
Scanner Problems
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Using the Scanner

Scanner Driver Basics
Unpacking the Scanner Cartridge
Installing the IS Scan Software
Installing the Scanner Cartridge
Basic Scanning Procedure

Using the White Calibration Sheet
Scanning Area Guidelines

Loading an Image
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Using the Scanner

B Scanner Driver Basics

Installing the optional 1IS-12 Color Image Scanner Cartridge in the printer makes it possible
to scan and save images such as your favorite photographs and greeting cards.

Photograph

Wealcome! .
P Greeting card

T

P

r=rIrD - Home page
Wallpaper for your computer
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Using the Scanner

Windows )

To use the scanner cartridge, you must install the IS Scan software, which includes the

IS Scan scanner driver and the IS Scan Plus utility program. These two programs provide
many features that allow you to perform simple color adjustments to improve the quality of
the original image or enhance the image for artistic effect.

You can run the IS Scan driver from within a TWAIN-compliant graphics application
program, or you can run the IS Scan Plus utility program directly as a stand-alone
application program. The IS Scan Plus utility program allows you to scan, edit, enhance,
and save the image data.

Macintosh )

To use the scanner cartridge, you must install the IS Scan software. You can run the
IS Scan driver from within a TWAIN-compliant graphics application, or you can run it
directly as a stand-alone program.

Note p TWAIN is an industry interface standard that allows software applications to
communicate with digital imaging devices such as scanners. Applications
that support TWAIN provide a standardized method of acquiring images.
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Using the Scanner

B Unpacking the Scanner Cartridge
Make sure you have the following items.

IS-12 Color Image Scanner Cartridge

A\ Caution

Optical components

Electrical contacts

The scanner cartridge is composed of precision components. To avoid
poor scanning results, do not touch the optical components or electrical
contacts.
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Using the Scanner

White Calibration Sheet
You use this sheet to maintain the correct color balance of scanned images. The first time

you install the scanner cartridge, you need to run the white level calibration. You will also
run calibration when the white level calibration data needs to be updated.

Scanning Holder

You can use this holder to hold a photo or other small image you wish to scan. The holder is
two layers, one being a clear plastic cover to protect photographs.

<7

Scanner Cartridge Container
Use this plastic container to store the 1S-12 Color Image Scanner Cartridge.

Using the Optional IS-12 Color Image Scanner Cartridge
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Using the Scanner

B Installing the IS Scan Software

Make sure the BJC-55 printer driver is installed before you proceed with the following
instructions.

1 Insert the printer driver CD-ROM into your CD-ROM drive.
2 Click Start and then click Run.

3 In the Run dialog box, type:
x:\drivers\ISScan\diskl\setup.exe

where x : is your CD-ROM drive.

Run HE

=== Type the name of a program, folder, or document, and
% whindows will open it for you,

Oper: |d:\drivers\|55:an'\disk1 haetlp exe ﬂ

ok | Cancel | Browse... |

4 Click OK and follow the instructions on the screens.

Using the Optional IS-12 Color Image Scanner Cartridge 357



Using the Scanner

B Installing the Scanner Cartridge

A\ Caution

Optical components

Electrical contacts

* The scanner cartridge is composed of precision components. To avoid
poor scanning results, do not touch the optical components or electrical
contacts.

* To avoid damaging the scanning head of the scanner cartridge, do not
attempt to store the scanner cartridge in an SB-10 Ink Cartridge Storage
Box. There may be ink inside the container that could damage the
scanning head of the scanner cartridge.
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Using the Scanner

Replacing a BJ Cartridge With the Scanner Cartridge

1

Make sure that the printer is plugged in and turned on. Open the cartridge
cover and press the CARTRIDGE button; the cartridge holder moves to the
center of the printer.

Lift up on the green tab to remove the BJ cartridge from the cartridge
holder. Take care that you do not raise any other tab nor remove a BJ tank.

Lift the green tab

Immediately store the BJ cartridge in an Ink Cartridge Storage Box.

Close the container tightly to prevent the print head of the BJ cartridge from
drying out. If the print head dries out, the BJ cartridge will become
unusable.
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Using the Scanner

4 Remove the scanner cartridge from its protective case. With the label on
the scanner cartridge up, set the scanner cartridge in the cartridge holder
at a slight angle. Align the marks (I><]) on the scanner cartridge with the
marks on the holder.

Align these marks

5 Press down on the raised left side of the scanner cartridge until it locks in
place.

Press down here
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Using the Scanner

6 Close the cartridge cover.

7/ Press the CARTRIDGE button. The scanner cartridge moves to the home
position.

Removing the Scanner Cartridge

Follow this procedure to remove the scanner cartridge and install the BJ cartridge when you
are finished scanning.

1 Make sure that the printer is turned on and then press the CARTRIDGE
button to move the cartridge holder to the center of the printer.

PPPPP

2 Open the cartridge cover.

Note Pp To avoid damaging the printer, do not touch the orange film cable under the
cartridge cover.
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Using the Scanner

3 Lift up the tab on the scanner cartridge to remove it from the cartridge
holder.

Lift up the tab

A\ Caution| Always remove the scanner cartridge from the printer and store it in its

protective case when it is not being used. To avoid damaging the scanning

lens on the scanner cartridge, do not attempt to store it in an Ink Cartridge
Storage Box.
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Using the Scanner

Remove the BJ cartridge from its container and install it in the holder.
Close the cartridge cover.

Press the CARTRIDGE button. The cartridge holder returns to the home
position.
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Using the Scanner

B Basic Scanning Procedure
After installing the IS Scan scanner driver, you can use the BJC-55 printer as a scanner.

1 Remove the BJ cartridge installed in the cartridge holder and then install
the 1S-12 Color Image Scanner Cartridge.

2 Start a graphics application program.

Windows ) For Windows Users

* If you use a TWAIN-compliant graphics application program, launch the TWAIN-
compliant application program. IS Scan launches from within the application
program.

e If you use IS Scan Plus, select Programs from the Start menu first. Point to
IS Scan Plus and then select IS Scan Plus.

Macintosh ) For Macintosh Users

* If you use a TWAIN-compliant graphics application program, launch the TWAIN-
compliant application program first. IS Scan launches from within the application
program.

* If you use IS Scan as a stand-alone application program, double-click IS Scan
BJC-55 in the folder you specified during the installation procedure.
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Using the Scanner

The first time you use the scanner, you need to perform the White Level
Calibration.

® Using the White Calibration Sheet

Insert the image you wish to scan into the scanning holder, then load the
scanning holder into the auto sheet feeder.

® Loading an Image

Scan the image.

Windows ) ® Scanning an Image
Macintosh ) ® Scanning an Image

Save the scanned image.

Now you can install the BJ cartridge and print the scanned image.
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Using the Scanner

B Using the White Calibration Sheet

The white calibration sheet provided with the scanner cartridge is used for maintaining the
correct color balance of scanned images. White level calibration is required when the
scanner cartridge is used for the first time and when the white level calibration data needs

to be updated.

When white level calibration is needed, you will see this screen when you click the Prescan
or Scan button.

Windows )

& Load white calibration sheet.
Cancel |

Maclntosh ) A Load white calibration sheet.

Cancel ]” 0K "
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Using the Scanner

1 Load the white calibration sheet with the cropped corner at lower right.
Align the sheet with the tab on the left side of the sheet feeder. Adjust the
paper guide to the right side of the sheet.

2 Follow any instructions on your screen.

3 When the white calibration sheet is ejected from the paper output tray,
White Level Calibration processing is complete.
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Using the Scanner

Do not leave the white calibration sheet in locations that are exposed to
direct sunlight or that are subject to high temperatures or humidity.

Note P

¢ Do not bend or wrinkle the white calibration sheet.

* When cleaning the white calibration sheet, use a soft cloth that is dipped
in a weak, neutral detergent solution, and then wipe its wet surface off
with a dry, soft cloth.

* The white level calibration data is stored into memory and used for
maintaining the correct color balance of scanned images. When a
message appears and prompts you to load the white calibration sheet,
click the OK button and perform white level calibration.

You can also initiate White Level Calibration from the IS Scan driver.

Windows ) ® Other IS Scan Features
Macintosh ) ® Other IS Scan Functions
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Using the Scanner

B Scanning Area Guidelines

Paper size Scanning area
Width Height
A6 105 x 148 mm 98 mm 138 mm
A5 148 x 210 mm 141 mm 200 mm
A4 210 x 297 mm 203 mm 287 mm
B5 182 x 257 mm 175 mm 247 mm
Letter 8.5x11.0in 8.2in 10.6in
Legal 8.5x14.0in 8.21in 13.1in

* The scanning area varies according to conditions such as the scanning resolution and
display resolution.

* If you wish to scan images larger than the size of the scanning holder provided with the
IS-12 Color Image Scanner Cartridge, the SH-101 A4/LTR scanning holder is available
for purchase. Visit the Canon Web site to find out about accessories and supplies
(www.ccsi.canon.com).

* The maximum thickness of the image must be within 0.02 in. (0.45 mm), including the
scanning holder. The scanning holder is 0.01 in. (0.2 mm) thick so the image you wish
to scan must be less than 0.01 in. (0.25 mm) thick.

* To prevent possible damage to the printer or scanner cartridge, do not scan an image
with paper clips or staples.
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Using the Scanner
B Loading an Image
1 Slide the paper guide to the left edge of the auto sheet feeder.

2 Place the image in the scanning holder.

* To prevent paper jams, always insert the image you wish to scan into
the scanning holder.

* Do not leave the scanning holder in locations that are exposed to
direct sunlight or that are subject to high temperatures or humidity.
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Using the Scanner

3 Open the cover and slide the paper guide completely to the right.
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Using the Scanner

Align the scanning holder with the original enclosed with the left side of the
sheet feeder and insert the scanning holder into the printer until it stops.
Continue pressing the scanning holder lightly into the printer; after about 2
seconds, it automatically feeds part way.

* Insert the scanning holder with the closed end and the top of the
original pointing into the printer.
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Using the Scanner

5 Slide the paper guide to the right edge of the scanning holder.
* This completes loading an image for scanning.

A\ Caution| To prevent possible damage to the scanning holder, always insert the

seamed side into the Feed Slot first.
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Using the Scanner With Windows

Using IS Scan

Changing the Scanning Mode
Using the Customized Scanning Mode
Saving the Settings

Using the Saved Settings
Other IS Scan Features

Using IS Scan Plus

Using Copy

Using Capture Image

Using Capture Photo

Editing a Scanned Image
Printing a Scanned Image

Saving a Scanned Image
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Using the Scanner With Windows

B Using IS Scan

This section describes how to scan an image when you launch IS Scan from within a
TWAIN-compatible application program.

Scanning an Image

Note P These basic procedures may vary according to the application program you
are using.
1 Install the IS-12 Color Image Scanner Cartridge in the printer.
B Installing the Scanner Cartridge

2 Make sure Canon IS Scan 2 is set as the Acquire Source and then select
the command used for scanning (such as Acquire or TWAIN) from the
menu of the application program. The main IS Scan dialog box displays:

715 Scan = (3] ]

Seltings Wiew Option Help

iy )

Image
[ETH # [10.60 |Inches -] 9254KE |
/& 79 Default

[ [Color [80dsi
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Using the Scanner With Windows

3 Specify the basic settings.

* Click the down-arrow on the right of the Paper Size box and select the
most appropriate paper size for the image you wish to scan.

* Select the most appropriate scanning mode for the image you wish to
scan in the Scanning Mode box.

B Changing the Scanning Mode

4 Load the image you wish to scan in the auto sheet feeder of the printer and
click the Prescan button.

Note P It's a good idea to use prescanning to determine whether or not an image
can be scanned properly or to test the effects of image adjustments. If the
image is slanted or a portion of the image is cut off in the preview area, click
the Clear button. Load the image correctly and click the Prescan button
again.

5 To scan only a portion of the image, you can drag the mouse to specify the
portion. The specified portion is called a Selection Box and only the area in
the Selection Box will be scanned. To specify the Selection Box:

* Point to a corner of the rectangular area of the image that you want to
select.

* Drag the mouse to the opposite corner of the rectangle.
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Using the Scanner With Windows

* Release the mouse button. The Selection Box appears on the image.

SIS Scan I =]

Settings  Yiew Option Help

Settings File: I
Paper Size: [Letter 8.50 11.00 in =l
— Seanning Mode

8] oP(Calan | &) oTPiEEwW) |

WP | Custom

-~ Image Si

|3.81 “ |4.02 Inches ‘l 1932 KB

& _)\ ?) Default

Secan Prescan |

| Colar |3E0dpi 2

Note p

To move the Selection Box, place the mouse pointer within the Selection
Box and drag the mouse to the desired position.

* To resize the Selection Box, point to a corner of the Selection Box and
then drag the mouse.

* You can confirm the dimensions of the Selection Box in the Image Size
box.

* The minimum size of the Selection Box is 1" x 1" (25.4 mm x 25.4 mm).
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Using the Scanner With Windows

6 Load the image you wish to scan in the auto sheet feeder again.
7 Click the Scan button. Remember, if you specified a Selection Box in
step 5, only that portion of the image is scanned.

1S Scan I =]

Settings  Wiew Dplion Help

Seftings il

Paper Siee: [Letterasascrr.00in =

i~ Scanning Mod

DTF[Eaer | DTFIEE) |
@ Fhoto e
@ L] i

=lmage &

b= I |4.02 Ilnches 'I FATZNE

. _,4\ ?) [Iefault

Transfer Clear |

| Color | 360 dpi 4

8 Atfter scanning is complete, click the Transfer button to transfer the image
data to the TWAIN-compatible graphics application program. Adjust, edit, or
enhance the image in the application program as needed.
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Using the Scanner With Windows

Note Pp * Some TWAIN-compliant graphics application programs do not display
the main IS Scan dialog box but instead display a different screen
characteristic of the application program. If you are using this type of
application program, read the documentation of the application program
carefully and perform prescanning or normal scanning.

* After launching IS Scan from within a TWAIN-compatible application
program, do not close the application program. If you do, the system may
not be able to respond.

* To quit IS Scan, select Exit Driver from the Settings menu.
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Using the Scanner With Windows

B Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings,
such as image type and resolution, are pre-assigned based on the contents of a scanning
job. When you wish to customize the settings for special scanning jobs, click the Custom
button.

Selecting a Default Scanning Mode

Select the most appropriate icon in the Scanning Mode box of the main IS Scan dialog box
according to your scanning purpose.

Scanning Image Type L ek Prescan
Purpose : Character Emphasis
Mode Resolution . Mode
Color Matching
Standard setting for scanninga | Color Off Grayscale
color image 180 dpi Off
On
Standard setting for scanning a | Grayscale Off Grayscale
monochrome image 180 dpi Off
Off
Suitable for scanning a Color Off Grayscale
photographic print such as a 360 dpi Off
shapshot On
Scans by converting a Monochrome Off Monochrome
monochrome image into the 200 dpi On
data suitable for facsimile Off
transmission
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Using the Scanner With Windows

Edge Emphasis

Scanning Image Type . Prescan
Mode Purpose Resolution Character Emp.haS|s Mode
Color Matching
Scans by converting a Monochrome Off Monochrome
monochrome image into the 360 dpi On
data suitable for OCR input Off
Suitable for scanning an image | Monochrome On Monochrome
that consists mostly of text 180 dpi Off
Off
Used for customizing the — — —
Cusztom . . .
¢ settings for special scanning
jobs
» Using the Customized
Scanning Mode
Note P When you select FAX or OCR, the document is scanned and processed as

a grayscale image and converted to monochrome binary image data. This
process eliminates unnecessary image background and increases the

quality of the scanned text and line art. When you select Text, the document
is scanned and processed as a monochrome image.
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B Using the Customized Scanning Mode

When you select Custom in the Scanning Mode box of the main dialog box, the Custom
dialog box opens and allows you to adjust the scanning settings for special scanning
jobs.

1 Open the main IS Scan dialog box.

2 Click the Custom button in the Scanning Mode box. This displays the
Custom dialog box:

Standard Value: I DTP(Color] j
Image Type: [ Colar =l
BReszolution: 180 | dpi
Threshold ' oo Lo 128

™ Edge Emphasis
™ Character Emphasis
¥ Colar Matching

Honitor Tupe:
|BJ Standard =l

Prescan

" Manochiome
& Grayscale
 Color

Cancel Help |

3 Specify these settings in the Custom dialog box:
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Standard Value
You change the standard values for the default settings here.

Image Type
Select a type of image: Color (the default), Grayscale, or Monochrome.

Resolution

Determines the precision of the scanned image. The higher the resolution
setting, the higher the precision and quality of the scanned image.
(However, the higher the resolution setting, the larger the file size.)

* The 90 dpi setting is sufficient for viewing images on a screen.
* The 180 dpi setting is sufficient for printing images.

Threshold

Determines the intensity of halftones for monochrome images. Drag the
slide bar to the left for a lighter image or drag it to the right for a darker
image. The Threshold option is available only when the Image Type is set
for Monochrome and Character Emphasis is off.

Edge Emphasis

Sharpens the edges of a soft image to create a clearer, more accented
appearance in the entire image. This option is available only when the
Image Type is set for Monochrome. Edge Emphasis is not used with
prescanning.
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Character Emphasis

Determines whether or not Image Trust processing is used for scanning
grayscale images. Image Trust processing sharpens the appearance of
characters in monochrome documents. This is especially helpful if you
intend to use the scanned original with an OCR software application. This
option is available only when the Image Type is set for Monochrome.

Color Matching

In some cases, the colors displayed on your monitor may not match the
colors you see in your printout. Color Matching attempts to match the
colors of the scanned image with the selection in the Monitor Type box in
order to attain a better match between the colors you see on the monitor
and the colors you see in your printout. This option is available only when
the Image Type is set for Color.

Monitor Type

Displays the name of the monitor profile currently in use. To select another
monitor type setting, click the down-arrow and select a name from the drop-
down list. This list includes the names of ICC profile formats, standard
profiles for monitors, installed in the system. A monitor profile can be
selected only when Color Matching is selected.

Prescan
Selects the type of image for prescanning. Select Monochrome, Grayscale
(the default), or Color.
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Click the OK button to return to the main dialog box.
Make sure that the image you wish to scan is inserted into the scanning

holder properly and is loaded in the auto sheet feeder of the printer, then
click the Scan or Prescan button.
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B Saving the Settings

You can save the settings in the main IS Scan dialog box to a file. The next time you scan,
you only need to open the file in which the desired settings are stored and start scanning.

Saving the Settings to a File

Save the Page Size, Scanning Mode, and Image Size settings in the main IS Scan dialog
box as a file.

1 Specify the desired settings in the Paper Size, Scanning Mode, and Image
Size boxes.

2 Select Save Settings File from the Settings menu.

Save settings to file [ 2] %]
Saveirs| 315 Scan =lE] & o =
File name: IMyCal Save I
Save a3 type: IIS Scan satting file [* bis] j Cancel

3 Select the folder in which the file is to be saved.
4 Enter a File name.

5 Click the Save button.
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B Using the Saved Settings
Open the file in which the desired settings were saved and use those settings for scanning.

1 Select Open Settings File from the Settings menu.

2 Select the file you wish to use, then click the Open button. The file name
is displayed in the Settings File box, and the settings change in the main
IS Scan dialog box.

Note P * When you open the file while an image is displayed in the preview area,
the prescanned or scanned image is discarded. Prescan or scan the
image again.

* Select Save Settings File from the Settings menu when you have
changed the settings and you wish to overwrite the current file and save
all the current settings to it.

* Select Save Settings File As from the Settings menu when you have
changed the settings and you wish to save all the current settings under
a new file name.
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B Other IS Scan Features

White Level Calibration

Use this feature to maintain the correct color balance of scanned images. You need to
perform White Level Calibration when you use the scanner cartridge for the first time and
when the white level calibration data needs to be updated.

1 Select White Level from the Option menu of the main IS Scan dialog box.

2 Whena message appears, insert the white calibration sheet into the auto
sheet feeder of the printer.

® Using the White Calibration Sheet
3 Click the OK button.

4 When the white calibration sheet is ejected from the paper output tray, the
White Level Calibration process is complete.
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Device Information

When you select Device Information from the Option menu of the main IS Scan dialog box,
you can verify the name of the printer that is currently connected to your system and
information on the communication mode.

* [f the printer is connected using the parallel interface, Device Information displays a
communication mode such as ECP/1 or ECP/2.

* |[f the printer is connected using the USB interface, Device Information displays USB as
the communication mode.

Enlarging the Scanned Image in the Preview Area

To enlarge the scanned image in the preview area, click the Enlarge icon (‘& key) or

select Large from the View menu.

To return to the original size, click the Standard icon (®\ key) or select Normal from the
View menu.

Using Online Help

When you click the (2) symbol in the main IS Scan dialog box, the online Help for IS Scan
opens so you can learn more about IS Scan.
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B Using IS Scan Plus

IS Scan Plus is a utility program that allows you to edit, enhance, print, and save an image
acquired by the IS Scan scanner driver. You can use IS Scan Plus if you do not have a
graphics application program.

Launching IS Scan Plus

1 Select Programs from the Start menu, then click IS Scan Plus.

2 Select IS Scan Plus. The main IS Scan Plus screen appears:

!_,ﬁ' IS Scan Plus

[0

o B A NEA = RR= QeI i

e Bach Edit Eint Save Help Exit

ﬁ l/
i-;:_..._ (S Canon
Copy Capture Image

, RN
/=] &

Capture Photo Dewice Infomation

Wersion 1.4%
Copyright CANON INC. 1938-20x%
Al Rights Reserved

tain menu

3 Select an option:
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Copy
Scan and immediately print an image without editing.

® Using Copy

Capture Image
Scan and edit an image other than a photographic print.

® Using Capture Image

Capture Photo
Scan and edit a photographic print such as a snapshot.

® Using Capture Photo

Device Information
Verify the name of the printer that is currently connected to your system
and information on the communication mode.
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Using Online Help
When you need detailed instructions, click the Help button in the upper right of the main
screen. You can access the online Help from all the screens that IS Scan Plus displays.

Help

Verifying the Device Information
Make sure that the printer is connected properly and is turned on, and click the Device
Information button.

* [f the printer is connected using the parallel interface, Device Information displays a
communication mode such as ECP/1 or ECP/2.

 |[f the printer is connected using the USB interface, Device Information displays USB as
the communication mode.

Closing IS Scan Plus

When you wish to close IS Scan Plus, click the Exit button in the upper right of the main
screen. You can access the Exit button from all the screens that IS Scan Plus displays.

as
[ B ]
Exit
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IS Scan Buttons

4, | Returns to the main IS Scan Plus screen.

Menu

¢= | Moves back to the previous screen.

Back

W Displays the Edit screen.

Edt ® Editing a Scanned Image

B Prints a scanned image.

Print » Printing a Scanned Image

g Saves a scanned image.

Save » sa\[ing a Scanned Image
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B Using Copy

Use the Copy feature when you wish to print an image immediately after scanning. You
cannot edit or enhance the scanned image before printing.

1 Click the Copy button in the main IS Scan Plus screen. The Copy screen
displays:

gq’ IS Scan Plus

r~ Diocument Typ

@ ' Colar |E| " Monochrome

r— Copy Mods

# Fine: _ir Fast
=

Paper Size: I Letter .50 x11.00 in 'I
Loz i sl Print 5 tting |
EEprint | @ [Elear; |
EE R | a
Copy Color 180 dpi 1992 KB
4
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2 Specify any required settings:
* Select Color or Monochrome in the Document Type box.
* Select Fine or Fast in the Copy Mode box.
» Select the paper size in the Paper Size box.
* The Copies box is disabled.

3 Click the Print Setting button. This displays the Print Setup dialog box.
Make sure Canon BJC-55 is displayed as the default printer. Click the
Properties button, if necessary, to display the Printer Properties dialog box
and specify any printer settings.

Canon BJC-55 Properties [2] =]
HMain | Page Layuull Slamp/BackgrUundI Maintenancel
Chaoose Print Made:
Standard Drafl. Photo  SuperPhoto
: 2
EJ Cartridge: ICulur 'I ™ Grayscale Print
Media Type: IPIain Paper j
Page Size: Letter
Origntation: Partrait
Frinting Type: Mormal-size Printing
A Direction:  Partrait
Feed Manual Feed S None
Background: MHone
Advanced | About | Defaults |
ak. I Cancel | AEply | Help |
f
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4  When you click the Copy button, a message box appears. Click OK in the
message box to confirm that the scanner cartridge is installed. Copying
begins.

5 Another dialog box appears to remind you to remove the scanner cartridge,
and install the BJ cartridge according to your print job. Also, make sure
paper is loaded in the auto sheet feeder of the printer.

6 Click the OK button in the dialog box. Printing begins.

Note P * To print the image displayed in the Preview Area again, click the Reprint
button.

* To make a copy of another image using the same settings, click the Copy
button. When a confirmation message appears, click the Yes button and
repeat the procedure described above.

* To make a copy using different settings, click the Clear button to clear
the copied image from the preview area. Repeat the procedure
described above.
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B Using Capture Image

Use the Capture Image feature to scan an image other than a photographic print. You can
also edit, enhance, save, and print the scanned image.

1 Click the Capture Image button in the main IS Scan Plus screen. This
displays the Capture Image screen.

S =Clx
& @
L]
tenu Back. Help Exit
Scanning Mode:
@3] prR(Colon &5 prepa
g Phato A Test
ﬁ Cusztom
Paper Size: Letter 850 11.00 in E

Scan ':,e‘\) Prescan

Capture Image Color 180 dpi 8204 KB

[515 % [1080 | [inches =
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2 Select the most appropriate icon in the Scanning Mode box of the Capture
Image screen according to your scanning purpose.

Standard setting for scanning a color image.

Standard setting for scanning a monochrome image.

Suitable for scanning a photographic print such as a
snapshot.

Suitable for scanning an image that consists mostly of text.

st Used for customizing the settings for special scanning jobs.

® Using the Customized Scanning Mode

3 Select the paper size in the Paper Size box.

4 Insert the image you wish to scan in the scanning holder, and then load it in
the auto sheet feeder of the printer.

5  Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image
using IS Scan.

® Scanning an Image

Using the Optional IS-12 Color Image Scanner Cartridge 398



Using the Scanner With Windows

B Using Capture Photo
Use the Capture Photo feature to scan a photographic print such as a snapshot. You can

also edit, enhance, save, and print the scanned image.

1 Click the Capture Photo button in the main IS Scan Plus screen. The
Capture Photo screen displays:

i~ Phato Typs
& Color " Black & whits
% - Photo 5;
-~ el
& Regular " Panorama

5.50 (x[5.80 Inches -

Capture Phata

[Color [180 dpi [2873KB i

By default, a Selection Box displays in the Preview Area. To delete the
Selection Box, point to any location in the Preview Area and right-click your

mouse.
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Specify these settings:
* Select Color or Black & White in the Photo Type box.
 Select Regular or Panorama in the Photo Size box.
Insert the image you wish to scan into the scanning holder, and then load it
in the auto sheet feeder of the printer.
Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image.
® Scanning an Image
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B Editing a Scanned Image

You can edit or enhance a scanned image acquired using the Capture Photo or Capture
Image feature. The editing features you can use vary according to the settings you used for
scanning and whether you used the Capture Photo or Capture Image feature for scanning.

You can edit or enhance the image displayed in the Preview Area.

1 Click the Edit button in the main IS Scan Plus screen. The Edit screen

displays:

5/
A R RRugNEnl = Bkl
bdenu Back. Edit Print Save Help Exit

Q| @ | Cu

Contrast Image Edges Lines
Brightness Compensation

5 M| 0| M

Pinelise Posterise Low Felief

® | 7

Crop Photo Frame

[550 w[550 [inches x| ‘

Capture Photo Color 180 dpi 2873KB
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2 You can select these editing options. For details on each feature, use the
online Help for IS Scan Plus.

Contrast / Brightness
Adjusts the brightness and contrast of an image.

Image Compensation

Softens edges in the image by reducing the contrast between pixels, or
sharpens hazy or blurred images. You can also smooth the appearance of
the image and invert the image.

Edges
Enhances the edges in an image by increasing the contrast of the pixels
between areas of different colors.

Lines
Emphasizes selected edges and de-emphasizes all other edges of an
image.

Pixelize
Squares off all the pixels in an image to lower resolution and makes the
pixels appear larger to create a mosaic tile effect.

Posterize
Reduces the number of colors in an image.

Low Relief
Applies special options to create a three-dimensional effect in the image.
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Background
Allows you to add a background to a monochrome image.

Crop Photo
Crops a scanned photograph in the Preview Area.

Frame
Allows you to add a frame border around the image.

* Depending on the settings you use for scanning, some editing features
are not available. For details, see the online Help for IS Scan Plus.

* You cannot use Crop Photo and Frame in the Capture Image screen.
You can select Background when a monochrome image is captured.

Edit or enhance the image as required.

Click the Apply button to apply the effect to the image in the Preview Area.
To undo the settings, click one of the undo buttons:

Undo All
Click once to undo all editing effects and restore the original in the

Preview Area.

Undo Previous
Click once to undo the previous editing effect; click repeatedly to undo
each previous editing effect one by one.
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B Printing a Scanned Image

You can print a scanned image acquired using the Capture Image or Capture Photo feature.
Remove the scanner cartridge, and install the BJ cartridge according to your print job.

Click the Print button on the IS Scan Plus screen. If you are using Capture Image, the Print
dialog box appears:

Print HE
 Prinker
Mame: Canon BJC-55 Properties |

Stabus: Default printer; Ready
Type: Canon BJC-55
Where:  USBOO1

Comment; ™ Print to file
— Print range Copies
& Al Number of copies: I'I 3:
€ Pages fram: |1 bio:
LT T
' Selection
Ok, I Cancel |

Using the Optional IS-12 Color Image Scanner Cartridge 404



Using the Scanner With Windows

If you are using Capture Photo, the Photo Print Options dialog box appears.

Photo Print Dptions

Printing Method

@) ¢ Print image ta fit paper size.

Print Setting... | Erirt LCatcel

Click Print Setting to change the printer settings or click Print to print the image.
B Printing With Windows 98 or Windows CE

B Printing With Windows 2000

Using the Optional IS-12 Color Image Scanner Cartridge 405



Using the Scanner With Windows

B Saving a Scanned Image

IS Scan Plus allows you to save a scanned image to a file under a new name. You can use
the saved image for pasting into another document or for attaching to your e-mail or a home
page on the Internet.

You can save the image displayed in the Preview Area.

1 Click the Save button. This displays the Save As dialog box.

Save As H E3
Savejn:l@'My Docurnents j gl IE 5

File name:  [photo_01 Save I
Save a5 ype: [BMP Filesl"bmp) =l Cancel |

2 Select the folder in which you wish to save the image.

3 Enter a File name.
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4 Click the down-arrow for “Save as type” and select a format for the file.
You can select one of the following file formats.

e Bitmap .BMP
* JPEG JPG
* TIFF TIF

5 Click the Save button.
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Scanning Images With Application Software
Using the Main IS Scan Dialog Box
Scanning an Image

Scanning Images With IS Scan

Changing the Scanning Mode
Customizing the Scanning Settings
Copying a Scanned Image to the Clipboard
Adjusting an Image

Modifying an Image

Applying Special Effects to an Image
Other IS Scan Functions

Using the Copy Utility
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B Scanning Images With Application Software

This section explains how to start IS Scan from a TWAIN image editing application software
so that you can scan images.

Selecting a TWAIN-compatible Device

Before you scan images with application software, you must first select a TWAIN-
compatible device using the BJC-55 driver. The basic procedure is described below (steps
may vary based on your application software).

1 Startthe application software and then select New... from the File menu.
Then, open the menu you use to scan images. Install the scanner cartridge
in the printer.

2 To open the dialog box for selecting a TWAIN-compatible input device, you
normally select Import and then select TWAIN Select... from the File menu.
The “Select a source” dialog box is displayed.

Select a source. 3 Click the IS Scan BJC-55 icon
B and then click the OK button.

BJC-55 is now selected as the
input device. Once you have

(o< performed these steps, the setting
| [Ccancer remains in effect until you change

to another input device.
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B Using the Main IS Scan Dialog Box

Menu Button

O

1§ Scan BJC-55 =

Canon

Scan Button

Save Button

Halt Button

Information Box

Help Button

Image Type:
Color

Fesolution:
180dpi

Size:
1986k

@

Color Matching:
oM

Inches ) Ll Image Control
Panel

bl Brightness
' || and Contrast

4 Preview Area

Menu button
Selects the IS Scan functions. Click this button to change the settings for a scanned

image or to edit a scanned image.
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Scan, Prescan, or Clear button
Click this button to start scanning. This button switches to Prescan or Clear,
depending on the setting or situation.

Transfer or Save button
Click this button to transfer a scanned image to an application. When using IS Scan
only without an application software, this button says Save.

Halt button
Click this button to cancel scanning.

Information box
Displays the settings related to image scanning. To perform scanning using other
settings, click the Menu button and then select Settings.

Help button
Click this button to display helpful explanations about the IS Scan functions.

Brightness and Contrast
Click this button to adjust the degree of brightness of an image.

Image Control Panel
Displays the size of the image to be scanned. For units, you can select inches, mm,
or pixels.

Preview area
Displays a scanned image.
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B Scanning an Image

1 Click the Menu button and then select Settings. The Settings dialog box

displays:
Settings
Paper Size: (Letter 85in x 11.01n =]
Scanning Mode: [DTP(COlOr) =]
Image Type: [Colur ¥ ]
Resolution: [180dpi 2]
Threshold: oL ' A N
T
[ Prescan Black & White 5
[# Color Matching
[ Edge Emphasis
[ Help | [ Default | [ cancel | | 0K 1l

2 Make the necessary settings for the image to be scanned.

* Click on Paper Size to select a size that approximates the image to be
scanned.

* Click on Scanning Mode to select the item that best approximates the
image to be scanned.

B Changing the Scanning Mode
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* Place a check mark in the Prescan check box.
Prescan performs a quick scan so you can check the image. You can
disable this function.

Click the OK button and then close the Settings dialog box.

Place the object to be scanned in the printer and then click the Prescan
button. You see the image displayed in the Preview Area.

0= IsscanBlt-o5 ——— H

Canon feo0 (400 [Wienes KB

(& 1

. Halt

If you only want to scan part of the object, drag the mouse within the
Preview Area to select the part to be scanned. The Selection Box indicates
the area that will be scanned.
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To create a Selection Box, position the cursor over one corner of the
area to be selected, press and hold down the mouse button, and then
drag the mouse diagonally to the opposite corner of the area you want to
select. Release the mouse button.

* |f you position the cursor over a point within the selected area, you can
move the area by dragging. If you position the cursor over one of the
lines indicating the selected area, you can change the size of the
selected area by dragging that line in or out.

* The minimum size of the selected area is 1" x 1" (25.4 mm by 25.4 mm).
* The size of the selected range is displayed in the Image Control Panel.

Place the image to be scanned in the printer and click the Scan button.
Remember, only the range indicated by the Selection Box is scanned.

O=———————— I5ScanBIt-55 =——————H

o Phcor Ponces )

Using the Optional IS-12 Color Image Scanner Cartridge 414



Note P

7

Using the Scanner With Macintosh

If the image displayed in the Preview Area is not what you expect, click the
Clear button and start over.

If you like the image, click the Transfer button. The scanned image is
transferred to the application software. Edit the image data as required
prior to printing or saving it.

* Some application programs do not display the main IS Scan dialog box,
but display their own scanning screen. In this case, refer to the
documentation supplied with the scanning software.

* Do not close an application program that started IS Scan while
IS Scan is still running. This may cause the system to lock up.
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B Scanning Images With IS Scan
You can use IS Scan as a stand-alone program to scan and edit images.

Starting IS Scan
1 Turn on the printer and install the scanner cartridge.

2 Double-click the IS Scan BJC-55 folder.
O

= HD B
26 items, 1.4 GE available

15 Scan BJC-55 Folder )

3 Double-click the IS Scan BJC-55 icon.

MIE

~ )

4 [

B3
S

O0=—"nux= (15 Scan BJC-55 =——HH
3 items, 1.4GE available

k. L,

"lm
C-—] =

15 Secan BJC-55 155canGuide ReadMe

il
=
[ 4]
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IS Scan starts and the main dialog box displays.

O IS Scan BIC-55 B

f Halt

The contents of the main dialog box and the method you use to scan
images are basically the same as when using TWAIN application software.
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Saving Scanned Images

1 Click the Save button.

O0=——————————————— ISStanBIt-5 =———————H

Image Type:
Color

Resalution:
360dpi
| Size:
148K
Color Matching:
z OH

.
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2 Make the necessary settings.

[[EIS Scan BJC-55 Folder 3|  =HD
=W ]
[ Trash
Name:
scan! e
Format PICT ¥

* Select the location to which you want to save your image.
* Enter a name for the image data in Name.
e Click the up- or down-arrow in Format to select PICT or TIFF.

3 Click the Save button. The image data is saved into a file.
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B Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings,
such as image type and resolution, are pre-assigned based on the contents of a scanning
job. When you wish to customize the settings for special scanning jobs, click the Custom
button.

Selecting a Default Scanning Mode
Select a setting that best approximates the image to be scanned.

Scanning Use Image Type Edge Emphasis | Prescan

Mode Resolution Color Matching | Mode*

DTP (Color) | Standard setting used when a color Color Off Grayscale
draft is to be scanned 180 dpi On (Execute)

Photo Recommended when scanning a Color Off Color
photograph 360 dpi On (Execute)

DTP (B&W) | Standard setting used when ablack & | Grayscale Off Grayscale
white draft is to be scanned 180 dpi Off

Text Recommended when scanning a Black & On (Execute) Black &
document consisting entirely of text, White Off White
such as a document created with a 180 dpi
typewriter or word processor

* By default, Prescan is disabled. Once enabled, Black & White is the default Prescan
Mode. You can select a Prescan Mode of Color, Grayscale, or Black & White.
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Scanning Use Image Type Edge Emphasis | Prescan
Mode Resolution Color Matching | Mode*
FAX Scans by converting a monochrome | Black & Off Black &
image into the data suitable for fac- White Off White
simile transmission (Text
Enhanced)
200 dpi
OCR Scans by converting a monochrome Black & Off Black &
image into the data suitable for OCR | White Off White
input (Text
Enhanced)
360 dpi
Custom Selected when a specific range of _ _ _

settings are to be made
Customizing the
Scanning Settings

* By default, Prescan is disabled. Once enabled, Black & White is the default Prescan
Mode. You can select a Prescan Mode of Color, Grayscale, or Black & White.
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Note Pp * The Settings dialog box displays when you select Settings after you click
the Menu button in the main dialog box.

* When you select FAX or OCR, the document is scanned and processed
as a grayscale image and converted to monochrome binary image data.
This process eliminates unnecessary image background and increases
the quality of the scanned text and line art. When you select Text, the
document is scanned and processed as a monochrome image.
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When you select Custom for Scanning Mode in the Settings dialog box, you can specify the

scanning settings.

1 Click the Menu button in the main dialog box and then select Settings.

2 Click the up- or down-arrow in Scanning Mode and then select Custom.
Settings

Paper Size: [ Letter 8.5in x 11.0in =)

Scanning Mode: ‘ Custom > I >
Image Type: [Culur i]
Resolution: [1Bl]dpi i]
Threshold: D ,I : : .I. I. D

[ Prescan Black & White ]

B Color Matching

[] Edge Emphasis

[ Help | [ Defaurt | [ cancel | | 0K |

Using the Optional IS-12 Color Image Scanner Cartridge

423



Using the Scanner With Macintosh

3 Make the appropriate settings for the image to be scanned.

Image Type
Select a mode according to the image to be scanned. You can select
Color, Grayscale, Black & White, or Black & White (Text Enhanced).

Resolution

Select a resolution according to the image to be scanned. The higher the
resolution, the finer the image you can get, although the amount of data
will be large. In general, 90 dpi is sufficient for home pages, while 180 dpi
is good for output to a printer. Settings are 90, 180, 200, 300, 360.

Threshold

This function is valid only when Image Type is set to Black & White. The
lightness/darkness of monochrome images can be adjusted by moving the
slide bar. If the slide bar is moved to the left, the scanned image will be
lighter, while if the slide bar is moved to the right, the image will be darker.

Prescan
Place a check mark in the Prescan check box to perform the prescan. The
scanning mode can be set to Black & White, Grayscale, or Color.

Color Matching

This function is effective only when Image Type is set to Color. When this
function is enabled, the colors are adjusted according to the monitor when
the image is scanned. The monitor itself is set with the system feature of
ColorSync® in the Apple menu control panel.
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Edge Emphasis

This function is valid only when Image Type is set to Black & White. If this
function is selected, only the edge of the image is emphasized when the
image is scanned. This is disabled for prescan.

4 Click the OK button. The main dialog box displays.

5 Place the image to be scanned in the printer, then click the Prescan button
or Scan button to start scanning.
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B Copying a Scanned Image to the Clipboard

If you copy a scanned image to the clipboard, you can use the image easily with other
application software. This is particularly useful when you want to paste an image into
documents created with application software that is not TWAIN-compatible.

Copying an Image

1 Click the Menu button in the main dialog box. Select Edit and then select
Copy.

The image data is copied to the clipboard.

Note P To use an image copied to the clipboard, start your application software
and then select Paste from the Edit menu.
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B Adjusting an Image

If you are not satisfied with a scanned image, you can perform fine adjustment using a
range of functions. Image data can be processed so that the brightness of the image
changes or so that the image appears sharper or softer.

Adjusting the Brightness and Contrast

1 Click the Brightness and Contrast button in the main dialog box. The
Brightness and Contrast dialog box displays.

=——— Brightness and Contrast

Brightness: "
ci-peeesss [ |

Contrast:
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Move each slide bar to the right or left to adjust the image.

Brightness
Moving the Brightness slide bar to the left makes the entire image darker,
while moving it to the right makes the image brighter.

Contrast
Moving the slide bar to the left reduces the contrast of the entire image,
while moving it to the right increases the contrast.

After making the adjustment, click the Apply button to change brightness
and contrast of the image displayed within the preview area.

Once you are satisfied with the adjustment, click the OK button.
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B Modifying an Image

You can modify a scanned image so that it looks sharper or softer. Also, a Despeckle
function allows you to remove speckling and make a scanned image appear cleaner. A
function for inverting colors to produce a negative film is also available.

1 Click the Menu button in the main dialog box, select Image, and then select
the desired function from the submenu.

Sharpen Sharpens an image to make it clearer.
Soften Softens the edges of an image.

Despeckle  Removes speckling from an image, making any such areas
less noticeable.

Invert Inverts the colors of an image to produce a negative of the
original.

You can check the effect of the adjustment in the Preview Area.
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B Applying Special Effects to an Image

Special effects such as edge emphasis, line emphasis, pixelization, posterization, and low
relief can be applied to a scanned image, creating an image with a feeling different from
that of the original.

1 Click the Menu button in the main dialog box, select Enhance, and then
select the desired function from the submenu.

Edges... Emphasizes the edges of a photograph or line drawing.
Lines... Emphasizes only lines in a specific direction.

Pixelize... Applies a mosaic effect to an image.

Posterize... Reduces the number of colors and simplifies the image.

Low Relief...  Creates a low relief version of the image.

When you select one of these functions, the corresponding dialog box
displays.
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2 Select a desired function from the list.

The following is an example of the screen displayed when you select
Edges. The operation is the same when any other function is selected. You
can check the approximate result of the selection in the Preview Area.

For details of each function, refer to the explanation displayed when you
click the Help button.

O0=——————— ISScanBI(-55 =———————H

" Menu ¥ J
(d Clear )

' Halt ]

Image Type:
Color

Resalution:
180dpi

Size:
240K

Color Matching:
OH

?

Q @@ G
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3 Once you are satisfied with the adjustment, click the OK button.

Note P To cancel an adjustment you have made, click the Menu button and then
select Undo. Then, select either of the following:

Last  Only the function applied immediately before is cancelled. If you
perform editing two or more times, only the function that you
selected most recently is cancelled.

All All the applied functions are cleared and the original image is
restored.
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B Other IS Scan Functions

White Level Calibration

To achieve the correct color balance for an object to be scanned, an operation called White
Level Calibration is required. When an image is scanned for the first time, or when the
temperature of the scanner cartridge rises to a certain level, a message displays prompting
you to place the white calibration sheet in the printer.

Place the white calibration sheet in the printer and then click the OK button. The calibration
sheet is scanned and the calibration is performed.

You can also initiate this operation whenever necessary.

1 Click the Menu button in the main dialog box and then select Settings.
2 Click the White Level button.

3 When the message appears, place the white calibration sheet in the printer.
® Using the White Calibration Sheet

4 Click the OK button.
When the white calibration sheet is ejected, white leveling is complete.
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Using the Online Help

Clicking the Help button on the main dialog box displays helpful explanations of the
functions of IS Scan. You can also display the Help by clicking the Menu button, then
Help, and Help again.

O=———————— IsStanBli-'s =————H

Click 2 phrase, then click OK:

— Welcometo15San
Wielcome to 15 Scan
15 Scan and Macintosh
. Wihere to Find More Help
19d| [= Installation
Wihat you need b 15 Scan
Installation and uninstallation of |5 Scan
~ Scanning
The IS Scan

T »

operation modes
duction

Seanning a d :Intro

= The |5 Scan Main Dialog
The |5 5can hain Dialog
The Freview Ares

4]
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B Using the Copy Utility

Use this utility to scan an object and then print the result immediately. Although the scanned
image cannot be edited or saved, the process from scanning to printing is completed
quickly and easily.

Installing the Copy Utility
To use the Copy Utility, you must first copy the folder including the necessary files to any
location.

1 Load the printer driver CD-ROM into the CD-ROM driver on your
Macintosh.

2 Double-click on the Copy Utility folder.

O="—"—7r=(9)BJC-55 =—————FHH
5} S items, B8 K available
Q 3 ( Q )
Printer Driver 15 Scan Copy Utility
User's Guide pdf Acrobat® Reader Inztall
[~
1] [+ ]z

Using the Optional IS-12 Color Image Scanner Cartridge 435



Using the Scanner With Macintosh

3 Drag the Copy Utility for BJC-55 folder and copy it to any location.

O [E] Scanner Ltility =—HH

g 2 items, 1 MB available

— = e
E=E
Copy Utility for BJC-55 Read Me

4] [»

SN

Now you can start the Copy Utility at any time.

Note P To use the Copy Utility, the printer driver and IS Scan scanner driver must
also be installed.

Starting the Copy Utility

1 Plug in the printer and install the scanner cartridge.

2 Click the Copy Utility for BJC-55 folder.

O =—] Scanner Ltility =——=0H
a8 2 itemns, 1 MB available
||
E=E
Copy Utility for BJC-55 Read Me
=1
4] [ [z
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Click the Copy Utility icon.

Using the Scanner With Macintosh

[0 == copy Utility for BIC-55 =

=) =]

&

2 items, 1 MB available

Copy Utility Capy Utility Guide
 —

The Copy Utility starts and the main dialog box displays:

O

]

Color B

& | Black &White

Paper 5ize:
[Letter85inx 11.0 inch ¢ |

Copies: EEI

Media Type:
2 Plain Paper
i High Resolution Paper
0 Transparency

Brightness: Eg I

Darker Brighter
D com
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Copying the Image

1 Click the Color or Black & White button according to the image to be
scanned.

2 Select the paper size you are using in Paper Size.

3 Select the number of copies to be output in Copies.

4 Select the type of paper you are using: Plain Paper, High Resolution Paper,
or Transparency.

5 Set Brightness, as necessary. Move the slide bar to the right and left to set
the brightness.

6 Place the image to be copied in the printer, then click the Copy button.
Scanning starts.

7/ When the message appears, remove the scanner cartridge and replace it
with a BJ cartridge according to the printing settings.

8 Place a blank sheet of paper in the printer and click the OK button.

Printing starts.
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Note P * To print the same image again, click the Reprint button.

 To copy another document with the same settings, click the Copy button
and follow the instructions on the screen.

» To perform copying with different settings, click the Reset button and
follow the instructions on the screen.

Ending the Copy Utility
To close the Copy utility, click the close box or the Quit button.
Close box
=|
g] Color & | Black &White
Paper 5ize: Media Type:
[Letter 8.5in x 11.0in | © Plain Paper
] i High Resolution Paper
Copies: EEI {3 Transparency
Brightness: E I i I i | i | ﬁ
Darker o ' Brighter
D com
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Scanner Problems

Scanning Result Is Unsatisfactory
Scanner Cannot Be Used With a TWAIN-compatible Application Program

Other Scanner Problems
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B Scanning Result Is Unsatisfactory

Scanned Image Blurred or Distorted

Quality of Scanned Image Is Uneven

White Portion Becomes Grayish

Parts of an Image Missing or Not Aligned Properly

Image Contains Unexpected Colors, or Is Too Light or Too Dark
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Scanned Image Blurred or Distorted

Note Pp

Blurry images are not suited for scanning. For best scanning results,
always use a clear, sharp image. (The scanned image cannot be better
than the original image.)

The scanning holder is bound to get dirty. Clean the scanning holder using
a soft cloth that is dipped in a weak, neutral detergent solution, and then
wipe its wet surface off with a dry, soft cloth.

If the scanning holder is scratched or damaged, replace it.

You can purchase a scanning holder for A4/LTR-size images. Visit the
Canon Web site to find out about accessories and supplies
(www.ccsi.canon.com).

The image being scanned must be thinner than 0.01 in. (0.25 mm). The
thickness including the scanning holder must be thinner than 0.02 in.
(0.45 mm).
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Quality of Scanned Image Is Uneven
The scanned image is coarse and/or blurry.

Windows )
Macintosh )

Resolution determines the precision of the scanned image.

The greater the number of dots used to draw an image, the higher the
precision and the quality of the scanned image becomes. For a better
quality image, select a greater number.

The scanning speed becomes slower and the file size of the scanned
image becomes larger when you use a higher resolution.

® Changing the Scanning Mode

# Changing the Scanning Mode
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White Portion Becomes Grayish

Note Pp

Use White Level Calibration to maintain the correct color balance of
scanned images.

®) Using the White Calibration Sheet

Depending on the image you scan, a white portion is not recognized as
white because the scanner detects and scans even the small differences of
the density between white and other colors.

Adjust the brightness and contrast.

* When you are using IS Scan Plus, use the online Help.

* When you are using a TWAIN-compatible graphics application program,
see the User's Manual for the application program.
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If the Scanning Mode is set to Color or Grayscale, the scanner detects and
scans even the grades of the density, and white may not be recognized as
white.

When you scan a monochrome image, always set Black & White in the
Scanning Mode so the scanner can scan using only two values between
white and black.

For details on how to set Black & White in the Scanning Mode, use the

online Help.
Windows ) ® Changing the Scanning Mode
Macintosh ) ® Changing the Scanning Mode
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Parts of an Image Missing or Not Aligned Properly

Check that the image you wish to scan is placed in the proper scanning
area.

If the Paper Size setting is smaller than the size of the image you scan,
parts of the image will be missing.

If you place the image outside the scanning area, parts of the image may
not be aligned properly. Always check that the image is set within the
proper scanning area.
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Image Contains Unexpected Colors, or Is Too Light or Too Dark

The appearance of the scanned image is not what you expected, or the image is too light or
too dark.

Windows ) Check the number of display colors as follows.

1 From the Start menu, select Settings, and then select Control Panel.
2 Double-click the Display icon, then click the Settings tab.

3 Check that Colors is set to High Color or True Color in the Colors box.

Macintosh ) Check the Color Depth setting as follows.
1 From the Apple menu, select Control Panels.
2 Select Monitors & Sound.

3 Check that Thousands or Millions are set for Color Depth.
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Windows )
1
2

Macintosh )
1

2

Scanner Problems

The colors displayed on your display may not match the actual scanned
colors.

Color Matching attains the best match between the colors displayed on
your display and the actual colors in the scanned image.

You can enable Color Matching when the Scanning Mode is set for Color.

Check that Color Matching is enabled.

Click the Custom Setting button.

Make sure that Color Matching is enabled in the Custom Setting dialog box.

Select Settings from the Menu screen.

Make sure that Color Matching is enabled.
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B Scanner Cannot Be Used With a TWAIN-compatible Application Program

Cannot Launch IS Scan From Within the TWAIN-compatible Graphics
Application Program

Cannot Transfer to TWAIN-compatible Graphics Application Program
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Cannot Launch IS Scan From Within the TWAIN-compatible Graphics
Application Program

Windows ) when IS Scan is used as a TWAIN interface, you must use the latest 32-bit
TWAIN-compatible graphics application program. See the User's Manual
for your application program.

Macintosh ) When IS Scan is used as a TWAIN interface, you must use the graphics
application program that supports the TWAIN Source Manager (Version
1.5 or later). See the User's Manual for your application program.
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Cannot Transfer to TWAIN-compatible Graphics Application Program

Some TWAIN-compatible graphics application programs support specific
file format types and resolution settings only. For example, the resolution
settings of some OCR (optical character reader) application programs are
limited to 300 or 400 dpi.

Check the file format types and resolution settings of the TWAIN-
compatible graphics application program first, and then scan and transfer
the image again.
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B Other Scanner Problems

Cannot Install Scanner Driver

Does Not Launch With Default Settings Windows )
Improper Colors Displayed in the Dialog Box
Scanning Too Slow

Communication Error Occurs

Error Message Appears
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Cannot Install Scanner Driver

B Installing the IS Scan Software

Windows ) o ,
If an error occurred during installation and you had to shut down the
installation procedure, you may not be able to install the scanner driver
because Windows is no longer stable. Restart Windows and then re-install
the scanner software.

The scanner driver installation program may not execute successfully if it is
run with other applications running in the background.

Before you run the installation program again, shut down all other
application programs.

Windows )

Double-click the My Computer icon, then double-click the CD-ROM icon on
the Windows desktop.

B Installing the IS Scan Software

Note P * The drive name (E: for example) varies according to how your system is
set up.
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Windows )

The printer driver CD-ROM may be damaged. On the Windows desktop,
double-click the My Computer icon then double-click the CD-ROM icon. If

Windows cannot read the CD-ROM, call the Canon Customer Care Center
for help.

® Getting Help From Canon

Using the Optional IS-12 Color Image Scanner Cartridge 454



Scanner Problems

Does Not Launch With Default Settings _Windows )

This problem occurs when IS Scan is launched from a TWAIN-compatible
graphics application program.

Depending on the TWAIN-compatible graphics application program,
Previous Settings selected in the Standard Value box under the Custom
Settings dialog box may be cleared, and standard settings characteristic of
the TWAIN-compatible program you are using may be used when
launching IS Scan.

To use the settings selected in the Custom Settings dialog box when
launching IS Scan, follow these steps:

1 Select Save Settings File from the Settings menu.

2 The next time you launch IS Scan, select Open Settings File from the
Settings menu.
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Improper Colors Displayed in the Dialog Box

Windows )

Macintosh )

This problem occurs when IS Scan is launched from a TWAIN-compatible
application program.

If the problem is not solved, change the number of display colors of your
computer.

From the Start menu, select Settings, and then select Control Panel.
Double-click the Display icon, then click the Settings tab.

Check that the Colors setting is High Color or True Color in the Colors box.

Or, you may be able to solve the problem by minimizing the IS Scan
window and then return to the original size.

Check the Color Depth setting.
From the Apple menu, select Control Panels.
Select Monitors & Sound.

Check that Thousands or Millions are set for Color Depth.
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Scanning Too Slow
Scanning is requiring an unusually long time.

In order to scan an image, your computer must be able to receive a large
amount of data. Therefore, the scanning speed varies according to the
performance of the computer.

To shorten the time required for scanning:
* Use the appropriate resolution setting. Make sure that the resolution is
not set higher than you require.

* Use the prescanning capability.
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Communication Error Occurs

Do not attempt to launch IS Scan or IS Scan Plus again immediately after it
is closed. Wait for a few seconds and then launch again.

Check that the printer is plugged in and ready.

Windows )

When using the USB interface running under Windows 98, a
communication error may occur if the Hardware acceleration setting is Full.
To solve the problem, follow these steps:

1 Double-click the System icon in the Control Panel for Windows.

2 When the System Properties window is displayed, click the Performance
tab.

3 Click the Graphics button.

4 1f Hardware acceleration is set to Full in the Advanced Graphics Settings
dialog box, set to None.
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Error Message Appears

Windows ) From the main IS Scan screen, select Contents from the Help menu, or
press F1.

Macintosh ) Open the online Help.
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Glossary

AC
Alternating current. The type of electrical current available from a wall outlet.

ASCII

Acronym for American Standard Code for Information Interchange. A set of definitions for
the bit composition of characters and symbols. ASCII defines 128 symbols using 7 binary
bits and 1 parity bit.

Auto Power Off

A power save feature that turns off the printer automatically if the printer does not receive a
print job within 30 minutes. The Auto Power Off feature is turned off and on with the printer
driver.

battery pack
The Canon Li-lon Battery LB-50 is a rechargeable battery installed inside the printer.

BJ cartridge
The BJ cartridge is composed of the print head unit and BJ tank. This removable cartridge
makes maintenance of the printer very simple.

Bubble Jet printer
An ink jet type printer that heats the ink to a boiling point in a nozzle to form a bubble. When
the bubble expands, there is no room left in the nozzle for the ink which is ejected onto the

paper.
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buffer
A temporary storage area in computer or printer memory in which data for input or output is
stored until it can be processed.

cartridge holder
The unit that holds the BJ cartridge and its BJ tanks. The cartridge holder remains at rest in
the home position on the left side of the printer when the printer is not in use.

CMYK
An acronym for Cyan, Magenta, Yellow and black, the four colors used in the standard color
model of the printing industry.

Commercial 10 (US Commercial)
A common size of envelope: 9.5 x 4.1 inches or 241 x 105 mm.

composite black
The composite black color formed by mixing cyan, yellow, and magenta ink so that they
appear almost black on a printout.

configuration
The defining of certain printer settings to allow the printer to communicate properly with
your computer.

cpi

Characters per inch. A unit of measurement relevant to a fixed-space font. Because all
characters have the same width, you can calculate the number of characters printed per
inch.
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cpl
Characters per line. A unit of measurement that indicates the number of characters printed
per line.

cps
Characters per second. A unit of measurement that indicates the printer’'s speed.

dB
Stands for decibel level (a decibel being a unit of measurement for the intensity of the
sound), adjusted for background noise.

default setting

A printer setting selected at the factory and permanently registered in the printer's ROM. It
is a setting that the printer assumes unless you provide other instruction. Also called factory
default.

dithering
A method by which color dots are combined on a page to produce a wide spectrum of
colors.

dpi (dots per inch)

A unit of measurement for indicating printer resolution. The standard resolution for this
printer is 360 dpi in the HQ mode. In the smoothing mode, resolution up to 720 x 360 dpi
can be achieved.

fixed pitch spacing
Equal spacing for each characters of the same character set. In printing a fixed pitch font,
each character, whether narrow or wide, takes up the same amount of space. For example,

[ 3

an “i” takes as much space as a “w”.
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font
A complete set of characters of the same size and style; a particular implementation of a
typeface. For example, 12 point, Courier bold.

font characteristics
Font characteristics determine the appearance of a printed font. These characteristics
include orientation, character height, style, stroke weight, and typeface.

grayscale
The variation of color between black and white as a result of different intensities of black
ink.

halftone

Shades of gray or shades of colors produced by mapping dots to be printed. For color
printing, different colored dots of ink are placed closely together to create illusions of other
colors.

High Quality (HQ) mode
One of the print modes available on this printer. Print speed is 346 cps at 10 cpi.

High Speed (HS) mode
One of the print modes available on this printer. Print speed is 434 cps at 10 cpi.

home position

This term refers to the position of the cartridge holder when it is at rest on the far left side of
the platen. In this position, the print head is always capped to keep it from drying out. The
cartridge holder moves out of the home position when the printer starts printing or after you
press the CARTRIDGE button to move it out so you can remove the BJ cartridge.
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host computer
The computer that is connected to a printer and can be used to drive the printer when the
printer is online.

hue
A color in the color spectrum. Examples are red, green, and violet.

input buffer
An area of the printer's memory containing the data that has been sent to the printer.

interface

The connection between two devices that makes it possible for them to communicate with
each other. This printer features a USB interface, which makes it compatible with both PC
and Macintosh personal computers. In order to connect the printer and computer via the
USB interface, you must use a USB interface cable.

interface port
The printer is provided with a USB and an IrDA port on the left side of the printer.

internal fonts
Internal fonts are fonts permanently stored in the printer.

IrDA
Infrared Data Association. The standard for the infrared wireless communication. This
printer has IrDA1.1 which allows a maximum data transfer of 4Mbps.

IS scanner driver
The software required to scan originals with the Canon 1S-12 Color Image Scanner
Cartridge.
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landscape orientation
Landscape orientation refers to printing across the length of the page, as opposed to
portrait orientation, which is printing across the width of the page.

line feed
A printer function that advances the paper one line.

Ipi
Lines per inch. The measurement used in describing the number of lines that will print
within one vertical inch. Most printing is done in 6 or 8 Ipi.

page orientation

Orientation refers to the direction of print on the page. Printing across the width of a page is
called portrait orientation printing. Printing across the length of a page is called landscape
orientation printing.

paper feed
Refers to guiding a sheet of paper into the printer’'s paper path.

paper jam
Paper is caught along the paper path. You must remove jammed paper before you can
continue printing.

pitch
Refers to the number of characters per inch that can be printed using a fixed-space font.

platen
Printer component that holds the paper near the print head during ink transfer.
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point size
Character height is defined in points; one point is 1/72 inch.

printer cable
The cable used to connect your printer and a computer.

printing area
The area of a sheet of paper on which a printer can reproduce text or graphics. The printing
area is smaller than the paper.

print head capping
An automatic protection function that prevents the print head unit and BJ tanks from drying
out or becoming clogged with dust.

Print mode

The print mode setting determines how the printer operates. Set the print mode according
to the type of printing you want to do and the type of media you are using. The default are
Standard, Draft, DTP, Photo, and SuperPhoto.

printer driver
Software that sends printing instructions to a printer. The printer driver keeps track of the
attributes of a printer and the codes the program must send to access those attributes.

proportional spacing

The spacing of characters according to the width of each character. This variable spacing
between each character closes up awkward-looking gaps and makes the text easier to
read. For example, less space for an “i” and more for a “w”.
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RAM
Random Access Memory. Printer memory that is used for temporary storage of information
you want to print and for downloaded fonts.

resident font
A font that is built into the printer, as opposed to one that must be downloaded from your
computer. Resident fonts are stored in ROM.

resolution

The density of dots for any given output device. Expressed in terms of dots per inch (dpi).
Low resolution causes font characters and graphics to have a jagged appearance. Higher
resolution means smoother curves and angles as well as a better match to traditional
typeface designs. When you see a value given for resolution, the resolution for the
horizontal direction is given first and the vertical direction second. For example, 720 x 360
dpi means 720 dots horizontally and 360 dots vertically.

ROM

Read Only Memory. You cannot modify this type of memory. When the printer is turned off,
ROM memory remains intact. In this printer, the default settings and the resident fonts are
stored in ROM.

saturation
The amount of hue of a color. The further the particular hue moves away from the center of
the color wheel, the more saturated it is.

top-of-form (TOF)
The printing position at the start of a new page.
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true black

Contrary to “composite black”, true black color on a printout is obtained with the use of black
ink.

typeface
The design of characters. For instance, Courier, Roman, Gothic, Prestige, and Draft
typefaces all print characters of different designs.

typestyle
Refers to how the type face appears: slanted (italic) or upright.

USB
Denotes Universal Serial Bus, a new, high-speed serial interface for transferring data
between the computer and an external device.
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Free Manuals Download Website
http://myh66.com
http://usermanuals.us

http://www.somanuals.com

http://www.4manuals.cc

http://www.manual-lib.com

http://www.404manual.com

http://www.luxmanual.com

http://aubethermostatmanual.com

Golf course search by state

http://golfingnear.com

Email search by domain

http://emailbydomain.com

Auto manuals search

http://auto.somanuals.com

TV manuals search

http://tv.somanuals.com
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